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About this Guide

This guide describes how to set up and administer the SyteLine portals. 

Intended Audience

The intended audience is a system administrator with knowledge of SyteLine and SharePoint.

Organization

This table describes the chapters of this guide:

Chapter Content Includes...

System Requirements and 
Prerequisites

Portal requirements for SyteLine, SharePoint, and Portal Manager; browser 
information; and prerequisite knowledge.

Installing and Configuring the 
Portal(s)

SharePoint and SyteLine administration account setup, installing the portals and 
Portal Manager, installing and binding digital certificates, portal content activation, 
portal data source setup, and portal configuration.

Setting Up SyteLine for the 
Customer Portal

How to set up SyteLine to support Customer Portal activity. This includes setting 
up the site group, items and categories, consigned inventory, documents, 
interactions, customer records, your company contact information, currency 
codes, unit of measure codes, workflow event handlers and event triggers.

Setting Up SyteLine for Online 
Ordering

How to set up SyteLine to support online ordering. This includes setting up 
shipping charges, item pricing, currencies, tax codes, country codes, and credit 
card processing.

Setting Up SyteLine for the 
Reseller Portal

How to set up SyteLine to support Reseller Portal activity. This includes setting up 
reseller account records, resellers’ customer records, and SyteLine Service 
parameters.

Setting Up SyteLine for the 
Vendor Portal

How to set up SyteLine to support Vendor Portal activity. This includes setting up 
the site group, consigned inventory, item price requests, planned orders, 
documents, interactions, vendor records, unit of measure codes, and workflow 
event handlers.

Setting Up and Managing 
SyteLine User Accounts for 
the Portal(s)

How to add users accounts in SyteLine for portal users. Manual steps are 
provided as well as information about working with the User Account Management 
Utility.

Managing Portal Content Importing, exporting, and transferring portal content.

Personalizing the Portal(s) Personalizing the portals to use your own company logo, pictures, text, and 
preferred styles and menu options.
Infor SyteLine Portals Setup and Administration Guide 
Copyright © 2014 Infor 



14  About this Guide 
Related Documents

You can find the following related documents in the product documentation section of the Infor Xtreme 
Support portal, as described in “Contacting Infor” on page 14.

 Infor Portals Customization Guide

 Infor SyteLine Multi-Site Planning Guide

 Infor SyteLine Multi-Site Implementation Guide

 Infor SyteLine Guide to Technology

 Infor SyteLine Licensing Guide

 SyteLine Vendor Portal online help

 SyteLine Customer Portal online help

 SyteLine Reseller Portal online help

Contacting Infor

If you have questions about Infor products, log in to the Infor Xtreme Support portal at http://
www.inforxtreme.com. If we update this document after the product release, we will post the new 
version on this Web site. We recommend that you check this Web site periodically for updated 
documentation. If you have comments about Infor documentation, contact documentation@infor.com.

Administration Tasks Adding or updating portal content in SharePoint, clearing the portal cache, and 
working with publications and subscribers. 

Customer Portal Users and 
Pages Overview

Descriptions of the different types of Customer Portal users. Also, descriptions 
and pictures of Customer Portal pages after all setup is complete.

Reseller Portal Pages 
Overview

Descriptions and pictures of Reseller Portal pages after all setup is complete.

Vendor Portal Pages Overview Descriptions and pictures of Vendor Portal pages after all setup is complete.

Using Portal Diagnostics How to use portal diagnostic services and the Diagnostic Viewer. 

Troubleshooting What to do if you experience certain issues with the portals.

Portals: Behind the Scenes How the parts of the portal interact with SyteLine.

Customer Portal Page 
Architecture and Mapping to 
SyteLine

Where information shown in the Customer Portal comes from in SyteLine.

Reseller Portal Page 
Architecture and Mapping to 
SyteLine

Where information shown in the Reseller Portal comes from in SyteLine.

Vendor Portal Page 
Architecture and Mapping to 
SyteLine

Where information shown in the Vendor Portal comes from in SyteLine.

Uninstalling the Portal(s) Steps for uninstalling the portal(s).

Chapter Content Includes...
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About the Portals

The SyteLine portals are separate products you can use with your SyteLine application. The portals 
run on Microsoft SharePoint 2010 and 2013 as Web sites that are publicly available to your 
customers, vendors, and resellers to provide browser-based access to relevant SyteLine data and 
functionality. Online ordering functionality also is provided. This section describes major features of 
the SyteLine 9.0 portals.

Terms to Know

Primary Site: In this document, primary site is referenced in two ways: Primary Site and PrimarySite 
(no space). 

Primary Site is the SyteLine site where you set up and maintain data such as items, categories, and 
customer contracts. 

PrimarySite is a data source that you will set up during data source configuration in Portal Manager 
and that points to your Primary Site in SyteLine.  In a multi-site implementation, your master site must 
be used for the PrimarySite data source.  

Portal Site Group: In this document, the portal site group is referenced in two ways: portal site group 
and PortalSiteGroup (no spaces).  

Portal site group means the group of all sites in your implementation that will provide data for a portal. 
You may need to create a separate record for this site group on the SyteLine Site Groups form, and 
you will specify this as the Site Group on the SyteLine Portal Parameters form. 

PortalSiteGroup is a multiplexed data source you will set up during data source configuration in Portal 
Manager and which points to the portal site group in SyteLine. The PortalSiteGroup data source must 
be identified as the Default data source during configuration. Even if you have a single-site 
implementation, you must configure the PortalSiteGroup to contain that site. 
Infor SyteLine Portals Setup and Administration Guide 
Copyright © 2014 Infor 
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Licensing and Log In

You can license one, two, or all three portals. The login to the Customer, Vendor, and Reseller portals 
is used to authorize access to SyteLine, so only one user login is required. A portal-specific SyteLine 
license is required for each user who accesses the portals, including those Customer Portal users 
who register their own accounts or who are registered by their reseller. Portal users will receive an 
“Access Denied” error if you do not have enough licenses. You can check license usage counts on 
the SyteLine License Management form. Refer to the Infor SyteLine Licensing Guide for more 
information.

Data Restriction

Information shown on the portals is limited to the customer’s, vendor’s, or reseller’s own data where 
appropriate. For example, a customer who works for Company A cannot see Company B’s orders. 
This restriction is created during user account setup in SyteLine. See “Setting Up and Managing 
SyteLine User Accounts for the Portal(s)” on page 97.

Multi-Site Implementation

The SyteLine portals  include multi-site functionality, so your portal pages can display and update 
data from multiple sites. You will specify portal site group data sources when configuring each portal, 
and the data sources must include all sites whose information should be exposed on that portal. You 
may need to create a Customer Portal and/or Vendor Portal site group on the SyteLine Site Groups 
form, if a site group containing all the necessary data sources does not already exist. Detailed 
information is provided in the setup chapters in this guide. You should also refer to the SyteLine Multi-
Site Planning Guide and SyteLine Multi-Site Implementation Guide for general information about 
multi-site implementations. 

Online Ordering

With online ordering functionality, customers can browse your product catalog, add items to an order, 
submit orders online, check order status, track shipments, and more. See Chapter 4, “Setting Up 
SyteLine for Online Ordering”.

Translation and Localization

The portals support translation and localization. Most of the text used on the portals is taken from 
SyteLine translatable strings. For more information, see “Internationalization” on page 190.
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About the Portals 17
Installation

The portal installation package includes the Customer Portal, Vendor Portal, and Reseller Portal Web 
applications. The installation also includes portal diagnostics and the Portal Manager, where you 
configure and manage the portals. For step-by-step installation instructions, see Chapter 2, “Installing 
and Configuring the Portal(s)”.

Configuration and Diagnostics

Portal configuration tasks, including data source setup, pre-login and locale settings, content 
activation and management, and page set style selection, are all handled in the Portal Manager 
application. Also, portal diagnostics is accessed via Portal Manager. The Diagnostic Viewer allows 
you to see real-time trace log and event activity on selected servers, so you can troubleshoot issues 
more quickly and effectively. More information is provided in these sections:

 “Portal Manager” on page 18

 “Configuring the Portal(s)” on page 40

 “Managing Portal Content” on page 105

 “Using Portal Diagnostics” on page 165

Personalization and Customization

Some of the information on the portal pages must be personalized for your company; for example, 
logos, text, and images on the Home page and appropriate menu options. See Chapter 9, 
“Personalizing the Portal(s)”.

Many more customizations are also possible. For example, you can create new portal pages or 
modify existing pages by adding, removing, or rearranging Web Parts. Also, custom layouts and 
scripting can be added to the portals using the Portal Manager’s built-in Layout Editor. These 
customizations are described in the Infor Portals Customization Guide.

If you remove and reinstall the portals, you do not lose anything except your configuration information 
and any personalizations or customizations. You can back up customized files and overwrite or 
merge them with the base version. See “Exporting Modified Portal Content” on page 105.
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Portal Manager 

As described in the preceding sections, the Infor Portal Manager is used for a variety of tasks, some 
of which are for portal administration  and some of which are for portal content development. Tasks 
that can be performed by both administrators and developers are described in this portal Setup and 
Administration Guide. Tasks that are for only developers are described in the Infor Portals 
Customization Guide.

The Portal Manager application is divided into four tabbed areas: Content Management, Content 
Development, Diagnostics, and Configuration. This table describes each functional area and for what, 
when, and by whom it is meant to be used:

Function Used For Used By/When Documentation

Content 
Management

Exporting, importing, and 
transferring portal content. 
This is how content is 
backed up and reused.

Used by portal administrators and 
developers any time portal content is 
modified or created, whether for portal 
personalization or customization.

Setup and 
Administration Guide

Content 
Development

Modifying, creating, 
copying, locking, or 
deleting portal content. 
Content includes:

Field Display Formats

Layouts

Styles

Page Sets

Feature Dependencies

Collection Definitions

Components

Used by portal developers when 
customizations are needed.

Customization Guide

Diagnostics Troubleshooting portal 
issues by collecting and 
reviewing diagnostic log 
data from the SharePoint 
server(s).

Used by portal administrators when 
diagnosing portal issues.

Setup and 
Administration Guide

Configuration Configuring the portal(s) 
and applying various 
system settings. 

Used by portal administrators after 
installing the portal and periodically for 
setup changes. Some features are also 
used by portal developers, such as 
enabling the portal for development and 
activating new features.

Setup and 
Administration Guide 

(Information about 
MSSQL and Oracle 
data source 
configuration is 
provided in the  
Customization Guide.)
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1System Requirements and Prerequisites

This chapter describes the installation prerequisites for the SyteLine portals. It does not 
include information about the number or configuration of SyteLine and/or SharePoint 
servers to use. For that information, see the Infor SyteLine Guide to Technology.

SyteLine

These are the portal prerequisites on the SyteLine side:

 SyteLine 9.00.00 or later must be installed and the IDO Web service must be installed. 

 Download and install the complete list of SyteLine patches, which is provided in 
SyteLine Solution KB 1503413 found on the Infor Xtreme Support portal at 
http://www.inforxtreme.com.

 For Customer Portal to calculate expected ship dates for items ordered, SyteLine APS 
must be installed and active.

 For Customer Portal to allow credit card orders, the Credit Card Interface (CCI) add-on 
product must be installed along with CCI Gateway software.

 To use SyteLine Service portions of the Customer and Reseller portals, a 
SyteLineService license is required.

 Single-site SyteLine customers must purchase a SyteLinePortals license for each of 
their customer, vendor, and reseller users. Multi-site customers may also be required to 
purchase SyteLinePortals_MS licenses, depending on how SyteLine is configured. 
Refer to the Infor SyteLine Licensing Guide for more information.

SharePoint 

These are the portal prerequisites on the SharePoint side:

NOTE: Contact your Microsoft provider for information about the licensing requirements for 
your Microsoft products.

 SharePoint Foundation 2010 SP2 or 2013 SP1 must be installed, and SharePoint must 
be installed in farm mode. Also download and install the most current hotfix.

 SharePoint must be able to access the SyteLine IDO Web service URL.

 A service account must be set up for the SharePoint Web application service(s). See 
“Set Up User Accounts for SharePoint” on page 25.
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20  System Requirements and Prerequisites 
 We recommend that you use a secured connection (SSL/HTTPS) between the users’ 
browsers and the server, at least for the external portal sites. In order to use SSL, you 
must obtain digital certificates that will be used for both of the portal Web applications 
(admin and external). These certificates will be installed into Internet Information 
Services (IIS). You must request these certificates from your internet service provider. 

You can use the same digital certificate for each IIS instance. However, if you are using 
certificates for both the external portals and the administration portal, those require 
different certificates. See “Determining the Public URL and Other Portal Settings” on 
page 30.

NOTE: Throughout this document, when we refer to SharePoint, we are referring to 2010 
and 2013 versions unless specified otherwise.

Data Sources

SyteLine data sources for the portal are configured in Portal Manager, as described in 
“Configuring the Portal(s)” on page 40. Requirements for using Oracle and Microsoft SQL 
Server data sources are provided in the Infor Portals Customization Guide. 

Portal Manager

Portal Manager can be installed and run with any 64-bit version of Windows 7 or later or 
Windows Server 2008R2 or later. It can be installed on a SharePoint Foundation server or 
a local machine.

To personalize display layout scripts from Portal Manager, you must have one of the 
following:

 Microsoft Visual Studio 2012 

 Microsoft Visual Studio 2013

 Microsoft Visual Studio Express 2012 for Web 

 Microsoft Visual Studio Express 2013 for Web 

Visual Studio Express for Web can be downloaded free from the Microsoft Web site.

User Rights

The administrator who installs the portals and its prerequisites must be logged in to the 
Web server computer as a user with the following access rights:

 Administrator rights on the server: You must be a member of the Administrators group 
on the Web server where each portal is being installed. 

 Administrator rights for Windows SharePoint Services: You must be the administrator of 
the site collection where each portal is being installed.
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 Administrator rights for SQL Server: If you are using Windows Trusted Authentication for 
portal installation, you must have administrator rights to the SQL Server where SyteLine 
data is stored.

Browsers

The portals have been tested on these browsers and versions: 

 Chrome 

 Firefox 

 Internet Explorer 9 and 10

 Safari for OS X

The portals may work, but are not supported, on other browsers and versions.

Prerequisite Knowledge

We assume that the person installing and administering the portals has the appropriate 
permissions and knows how to do these tasks:

 Perform some administrative tasks in a Microsoft SharePoint farm, such as creating and 
managing Web applications.

 Perform SyteLine system administration tasks such as adding users.

 Use IIS to administer digital certificates.
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2Installing and Configuring the Portal(s)

This chapter describes how to install and configure the portal(s). Information about using 
Microsoft SharePoint with the portals is included. 

NOTE: Unless noted otherwise, the tasks in this chapter assume you are using a 
SharePoint Farm installation. See the note in “Set Up User Accounts for SharePoint” 
on page 25 for information about SharePoint Standalone installations.

Before You Start

Before completing the tasks in this chapter: 

 Verify whether or not you have logins already set up for your external customers and/or 
vendors to an existing SharePoint site. If you do have existing customer and/or vendor 
logins to a SharePoint site, you may be able to reuse them. Contact Infor Consulting 
Services (ICS) for help with portal login setup.

 Be familiar with the languages and localizations that are set up in your SyteLine system, 
for example, which cultures and regions have translated text strings available in 
SyteLine. This determines which cultures and regions your portal can support. There is 
no relationship to the language packs set up in SharePoint. See “Internationalization” on 
page 190 for additional information about internationalization of the portal.

 Understand what a public URL is. The public URL is the domain name for all sites that 
users access in this SharePoint Web application. This URL domain is used in all links 
shown on pages within the Web application. The public URL can be the current 
servername and port for the Web application. In a production deployment, the URL is 
likely a publicly available domain name so that external customers, vendors, and/or 
resellers can use the name to access the portals. For more information, see 
“Determining the Public URL and Other Portal Settings” on page 30.

To find out more about the use of public URLs, go to the Microsoft Technet Web site and 
search for Plan alternate access mappings (Windows SharePoint).

 Know how to import and bind internet server certificates in Microsoft Internet Information 
Services (IIS) Manager. For information, see the IIS Manager online help.
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 If you plan to set up the portal(s) in a test environment, make sure you have two 
available Web site ports for each portal you will install. One port number will be assigned 
to the administration site and one will be assigned to the Internet site for each installed 
portal. We highly recommend that you use a test environment.

 If this is not the first time you have installed the portal, and you want to have a “clean” 
installation — that is, nothing preserved from the previous installation — the portal must 
be completely uninstalled, as described in Appendix E, “Uninstalling the Portal(s)”.

Installation and Configuration Checklist

Use this checklist to keep track of the tasks required for portal installation and 
configuration:

Task

 1. Check the Infor Xtreme Support portal for the most current version of this document: 
http://www.inforxtreme.com.

 2. Verify that you have the appropriate user rights and that you have set up all of the prerequisite 
software. See Chapter 1, “System Requirements and Prerequisites”.

 3. For SharePoint, add the necessary user accounts, install the application, and perform required 
setup. See “SharePoint Setup” on page 25.

 4. Set up the needed SyteLine user accounts. See “Setting Up Accounts for Portal 
Administration” on page 28.

 5. Install your first portal and the Portal Manager. See “Installing the Portal(s) and Portal 
Manager” on page 35.

 6. Bind digital certificates to the new Web applications, if applicable. See “Binding Digital 
Certificates to the Web Applications” on page 39.

 7. Configure the portal. See “Configuring the Portal(s)” on page 40.

 8. Repeat tasks 5 through 7 for each additional portal you need.

 9. Download and install any necessary portal patches, which are provided in SyteLine Solution 
KB 1459104 found on the Infor Xtreme Support portal at http://www.inforxtreme.com.
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SharePoint Setup

These are the tasks involved in SharePoint setup:

1. Set up the necessary SharePoint user accounts 

2. Install SharePoint

3. Create SharePoint account profiles on the portal server

4. Set the SharePoint managed account user

5. Configure service accounts

6. Install digital certificates in IIS on the SharePoint server 

Set Up User Accounts for SharePoint

In Active Directory, you must set up separate domain accounts to install and run the 
services associated with SharePoint. The table on the next page shows the required 
accounts and their privilege requirements. Refer to Microsoft documentation for more 
information about Active Directory.

IMPORTANT: The accounts shown in the table are needed for a SharePoint Farm 
installation. If you plan to use a SharePoint Standalone installation for portal 
development, you do not need the separate domain accounts. Instead, you must make 
your administrator account a Managed Account in SharePoint, as described in “Make 
Portal Application Pool Account a Managed Account” on page 27, and then use that 
account throughout the development portal installation and configuration process. For 
example, you will:

 Use that account to log in to the machine to install the portal(s).

 Specify that account in the portal installation wizard when prompted for the Application 
Pool Logon Information.

 Use that account to log in to the Portal Manager for the first time.

 Use that account if you need to log in to the SharePoint server to Push to STS.

You should use Standalone mode only for portal development. Your production 
environment must use Farm mode.
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Required Accounts for SharePoint Farm Installation

Install SharePoint

Using the appropriate user account — the administrator account for a Standalone 
installation or SPInstall for a Farm installation — install SharePoint. Refer to SharePoint 
documentation for installation instructions.

NOTE: If you install SharePoint on the SyteLine utility server, both applications will have a 
binding on port 80. To resolve this conflict, you must delete the default SharePoint Web 
application. Follow these steps:

1.Log in to the SharePoint server using the account you used for installing SharePoint. 

Account
Suggested 
Name Purpose Requirements

Setup User 
Account

SPInstall This account is used for all 
administrative tasks, including but 
not limited to:

 Run SharePoint installation.

 Run SharePoint Products 
Configuration Wizard.

 Server farm configuration and 
management from SharePoint 
Central Administration.

 Run feature activation.

 Log on to the server from a 
remote desktop, if applicable.

 Install the SyteLine portals and 
Portal Manager.

 Domain account.

 Must be assigned a SQL Server login with these 
security roles: sysadmin or securityadmin and 
dbcreator.

 Must be a member of the Administrators group of 
the local machine and on SharePoint, SQL, 
Reporting Service, and Analysis servers.

 As part of the SharePoint Products Configuration 
Wizard, this user is automatically made a farm 
administrator in SharePoint Central 
Administration. By default, all local 
administrators on the SharePoint server are also 
farm administrators.

 During the portal installation, this user is also 
granted Site Collection Administrator privileges 
for the site that is installed.

Server Farm 
Account

SPFarm Used to:

 Act as the application pool 
identity for the SharePoint 
Central Administration Web 
site.

 Run Microsoft SharePoint 
Foundation Workflow Timer 
Service jobs under this user 
context.

 Domain account.

 This user is automatically assigned the 
appropriate permissions by the SharePoint 
Products Configuration Wizard.

SharePoint 
Services 
Account

SPServices Used to:

 Act as the application pool 
identity for the SyteLine portal 
Web site(s).

 Log in to Portal Manager for 
the first time, to activate 
content and configure portals.

 Run Web applications.

 Domain account.
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2.In SharePoint Central Administration, select Application Management > Manage 
web applications. 

3.In the list of Web applications, select SharePoint - 80 and then click Delete.

Create Account Profiles

On the machine you will use to install the SyteLine portals, you must log in to the machine 
using each of the SharePoint user accounts at least once, so the account profiles can be 
created.

Make Portal Application Pool Account a Managed Account

For a SharePoint Farm installation, you must make SPServices a managed account user. 
This account should not be a machine administrator of the SharePoint machine. 

For a SharePoint Standalone installation, you must make the SharePoint machine 
administrator a managed account user, as explained in the note before the table.

1. Log in to the SharePoint server using the account you used when you installed 
SharePoint. 

2. In SharePoint Central Administration, select Security > Configure managed accounts 
> Register Managed Account. 

3. Specify the service account credentials. For User name, use this format: 
domain\SPServices.

4. Click OK.

Configure Service Accounts

When you install SharePoint with local accounts, the Farm Account privileges might not be 
set to an account that has administration privileges. To verify and change this:

1. In SharePoint Central Administration, select Security > Configure service accounts.

2. Select Farm Account from the drop-down list.

If the Farm Account is not an account with administrator privileges, change it to an account 
with administrator privileges. This could require that you register a new managed account. 

Install Digital Certificates in IIS

If you want the portal to use a secured connection (SSL) between the users’ browsers and 
the server, you must import and configure digital certificates in Microsoft Internet 
Information Services (IIS) on the SharePoint server. These digital certificates were 
mentioned in Chapter 1, “System Requirements and Prerequisites”.

In IIS Manager, on the Server Certificates page, make a note of the Issue To name 
associated with your server certificate. (This might be referred to as the Common Name 
during the process used to create the digital certificate.) You will need this name during the 
portal installation.
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Setting Up Accounts for Portal Administration

This section describes setup of the user accounts needed in SyteLine for portal 
configuration, testing, and user account management. 

Set Up the Configuration Accounts

Two SyteLine user accounts are needed to configure the portals. One is an account that 
briefly logs in to SyteLine to validate other user accounts when portal users log in. We 
recommend using the SL_Internal account for this purpose, so multiple simultaneous 
logins do not become a problem. The second is a pre-login account used to auto-log in to 
the portal, so our custom login page can be displayed for portal users. To set up these 
accounts, complete the following tasks:

Update the SL_Internal User Account

The SL_Internal account already exists in SyteLine. You must update its settings in one 
SyteLine site for a single-site implementation or in each of your SyteLine sites that will be 
used with the portal(s) in a multi-site implementation. 

On the Users form in each site used by the portal(s):

1. Ensure that the SL_Internal user has a password. The password does not have to be 
the same in each site. 

You will provide this user ID and password when you configure SyteLine data sources 
in Portal Manager, as described in “Configure Data Sources” on page 42. 

NOTE: If for any reason the SyteLine database has to be re-licensed, the password for 
the SL_Internal user has to be reset in SyteLine.

2. Select Super User. 

You do not have to assign groups or user modules to the account.

3. Save the record.

Create the Pre-Login User Account

On the Users form in each site used by the portal(s):

1. Create a new user record; for example, IPF_Prelogin. 

2. Specify a password. This password must be the same in all sites.

You will provide this user ID and password when you configure general settings in Portal 
Manager, as described in “Set General Configuration Options” on page 45.

3. This account should not be set to Super User. 

4. No groups should be assigned to this user.

5. Click User Modules and select the appropriate license module(s), either 
SyteLinePortals or SyteLinePortals_MS. Refer to the Infor SyteLine Licensing Guide for 
important details.

6. Save the record. 
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Set Up the Portal Administrator User Account

All of your customers, vendors, and resellers who will access your portals must be set up 
as portal users in SyteLine. The User Account Management Utility is provided to help 
streamline the process of portal user account creation. In order to work with the utility, you 
must first be set up as a portal administrator user in SyteLine. This user account must be 
created in each site used by the portal(s).

You can set up more than one portal administrator user, but only one administrator at a 
time should work with this utility.

To set up a portal administrator user in SyteLine:

1. On the Users form in each site used by the portal(s), create a new user account record.

2. Specify a user ID and password for this user. 

3. This account should not be set to Super User.

4. Click User Modules and select the appropriate license module, either SyteLinePortals 
or SyteLinePortals_MS. Refer to the Infor SyteLine Licensing Guide for important 
details.

5. Click the Groups tab and select the Admin Portal group from the drop-down list.

6. Save the record. 

Do not associate the portal administrator user account with any customer or vendor record 
in SyteLine.

When a portal administrator user logs in to any one of the portals, the User Account 
Management Utility page is automatically displayed. This is the only page the administrator 
can access in the portals. To access other pages, this user would need to have an 
additional user account set up in SyteLine for the applicable portal, just like any customer, 
vendor, or reseller user. This is described in the next topic.

Set Up the Testing User Account(s)

In order to test your portal(s) after installation and configuration, you need to have a user 
account set up in SyteLine for the applicable portal — Customer, Vendor, or Reseller — just 
like the accounts you will set up for your end users. This user account must be created in 
each site used by the portal(s). Account setup can be performed manually or using the 
User Account Management Utility page in each portal. 

You can set up user accounts for testing now or after you have installed and configured the 
portals.

Refer to the instructions in Chapter 7, “Setting Up and Managing SyteLine User Accounts 
for the Portal(s)” for creating your testing user account(s).
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Determining the Public URL and Other Portal Settings

This section provides information to help you determine settings needed when you run the 
portal installation wizard. Review this section before using the wizard. Step-by-step 
instructions for using the wizard are provided in “Run the Installation Wizard” on page 36.

When you run the portal installation wizard, you will need to specify public URLs to be used 
for accessing your portal(s). For each portal you install, two different sites are created: one 
for internal access and one for external (Internet) access. Generally the internal site is used 
for portal administration tasks, and the external site is used on the Internet by your 
customers, vendors, and/or resellers. However, external sites can also be used by 
administrators, so account configuration and permissions must be set up correctly.

This section describes two scenarios to help you determine how to format the public URLs: 
one scenario for an internal test environment and one for a production environment. The 
scenarios are for the installation of one portal. Spaces are provided for you to jot down the 
public URLs and other settings for your implementation, so you can refer to this information 
when you run the installation wizard. Print the following pages — one set for each portal 
you will install — to fill in your information.

NOTE: We recommend that you install portals in both a test environment and production 
environment, so you can experiment with settings and personalizations on the test 
sites and then transfer those modified features to the production portal.

Internal Test Environment for a Single-Server Farm

Use the following guidelines to complete the specified wizard screens if you are installing 
the portal(s) for an internal test environment on a single-server farm. Although this example 
is for an internal test environment, a site is created for external (Internet) access.

New Web Application Screen 

The settings on this screen apply to the internal portal site (typically, the portal 
administration site).

Public URL: In the simplest scenario, administrators navigate their browsers directly to the 
server, therefore, the specified URL should look like this: <SharePoint Server Name>.

Use Secure Sockets Layer (SSL): SSL protects you from certain kinds of sophisticated 
security attacks and generally is not necessary for internal portal sites. For the internal site, 
you can leave the check box cleared.

Your Public URL:

Your Setting:
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Web Application Advanced Information Screen

The settings on this screen also apply to the internal portal site.

Internal Host Header: For this scenario, again specify the SharePoint server name used in 
Public URL on the previous screen: <SharePoint Server Name>. 

NOTE: If you chose to use SSL (digital certificates) for secure connections, this host 
header name must match the “Issued To” or “Common Name” on the digital certificate. 

Internal IIS Web Site Port: In this scenario, each Web application must be configured to 
use a separate port. Generally, you can allocate a range of “high” port numbers to use for 
your various portal Web applications. (Many port numbers that are less that 1024 are pre-
allocated by convention and may cause problems if they are used in an unexpected way.) 
For example, you could use port 8080.

Use Port Number on Public URL: Select this check box. In this scenario, you will be using 
the SharePoint server name for the Public URL on both the administration site and the 
Internet site, so you have to use the port number on the public URL. Otherwise, both public 
URLs will be the same, and IIS will not know to which portal to route a user’s browser.

Extended Web Application Screen

The settings on this screen apply to the external portal site (Internet), except for Site 
Name, which applies to both the administration and external sites.

Site Name: This is used as the name of the Web application when it is created in 
SharePoint. It is visible in SharePoint Central Administration, the IIS Manager, and in 
shortcuts created for opening the portal internal and external sites. For the administration 
site, the word “Administration” is automatically added to the name. You can use any 
descriptive name that helps you clarify the purpose of your various portals, and it must be 
unique from all existing Web application names. For example, if you install all three portals, 
your site names might be Customer Portal, Vendor Portal, and Reseller Portal. The 
administration site names then becomes Customer Portal Administration, Vendor Portal 
Administration, and Reseller Portal Administration.

Public URL: In this scenario, portal users will also navigate their browsers directly to the 
server, therefore, the specified URL should look like this: <SharePoint Server Name>.

Use Secure Sockets Layer (SSL): Typically, this option should be selected for the external 
portal site, unless you are not using SSL. However, because this scenario is for an internal 
test environment, it probably is not needed. 

Your Internal Host Header:

Your Internal IIS Web Site Port:

Your Setting:

Your Site Name:

Your Public URL:

Your Setting:
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Extended Web Application Advanced Information Screen

The settings on this screen also apply to the external portal site.

Internal Host Header: Specify the SharePoint server name used in Public URL on the 
previous screen: <SharePoint Server Name>. 

NOTE: If you chose to use SSL (digital certificates) for secure connections, this host 
header name must match the “Issued To” or “Common Name” on the digital certificate.

Internal IIS Web Site Port: In this scenario, each Web application must be configured to 
use a separate port. For the external portal site, you could use port 8081. 

Use Port Number on Public URL: Select this check box. 

In this scenario, if you install all three portals, you would end up with these test Web 
applications:

External Production Environment for a Multi-Server Farm

Use the following guidelines to complete the specified wizard screens if you are installing 
the portal(s) for an external production environment on a multi-server farm.

NOTE: Implementation of a multi-server farm requires the use of a load balancer. There 
are many options to achieve load balancing. One option is the Network Load Balancing 
feature available as part of Windows Server. You can read more about it here: 
http://technet.microsoft.com/en-us/library/cc770558.aspx.

The Infor Portal Framework requires client affinity to a single cluster host. If you are 
using the Windows Network Load Balancing feature, the Affinity setting would therefore 
be “Single”. This is the default setting.

Your Internal Host Header:

Your Internal IIS Web Site Port:

Your Setting:

Portal URL User Login Method

Customer Portal <SharePoint Server 
Name>:8080

Portal Administrators Windows or forms 
authentication

<SharePoint Server 
Name>:8081

(Test) Customers Portal pre-login site page

Reseller Portal <SharePoint Server 
Name>:8082

Portal Administrators Windows or forms 
authentication

<SharePoint Server 
Name>:8083

(Test) Resellers Portal pre-login site page

Vendor Portal <SharePoint Server 
Name>:8084

Portal Administrators Windows or forms 
authentication

<SharePoint Server 
Name>:8085

(Test) Vendors Portal pre-login site page
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New Web Application Screen 

The settings on this screen apply to the internal portal site (typically, the portal 
administration site).

Public URL: Administrators navigate their browsers to the farm. Because of load 
balancing, they may be serviced by any machine in that farm. Set up a DNS record for your 
administration site, such as CustPortalAdmin, as part of your internal DNS domain. It 
should point to the farm’s load balancer. The specified public URL should then look like 
this: CustPortalAdmin or CustPortalAdmin.<internal domain>. 

Generally, you don’t expect administrators to access the administration site from outside 
the firewall. However, if you do want to support this case, the DNS record also must be set 
up in your external DNS. In this case, the public URL entry would look like this: 
CustPortalAdmin.<yourcompany>.com.

Use Secure Sockets Layer (SSL): If you are making the administration site visible from 
the Internet and you are using SSL, you should select the check box.

Web Application Advanced Information Screen

The settings on this screen also apply to the internal portal site.

Internal Host Header: Generally, this will be the same as the Public URL setting. 
Therefore, keeping with our example, it would look like this: CustPortalAdmin or 
CustPortalAdmin.<internal domain> or CustPortalAdmin.<yourcompany>.com. 
The Internal Host Header setting would be different from the public URL only when you 
use more sophisticated routing techniques, such as a Reverse Proxy or URL rewrite rules. 
Also, if you chose to use SSL (digital certificates) for secure connections, this host header 
name must match the “Issued To” or “Common Name” on the digital certificate.

Internal IIS Web Site Port: Generally, you should use the standard http port 80, or, if you 
are using SSL, the standard https port 443. You can have multiple Web applications on the 
same port number. IIS keeps them separate based on the unique internal host header. It is 
best to use the standard port numbers.

Use Port Number on Public URL: In this scenario, you should leave this check box 
cleared. By not specifying the port number on the public URL, the Web browsers 
automatically route traffic to your site using the standard port numbers. This results in the 
best user experience. IIS then routes requests to the correct Web application or extended 
Web application by using the internal host header that you configured for it.

Your Public URL:

Your Setting:

Your Internal Host Header:

Your Internal IIS Web Site Port:

Your Setting:
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Extended Web Application Screen

The settings on this screen apply to the external portal site (Internet), except for Site 
Name, which applies to both the administration and external sites.

Site Name: This is used as the name of the Web application when it is created in 
SharePoint. It is visible in SharePoint Central Administration, the IIS Manager, and in 
shortcuts created for opening the portal internal and external sites. For the administration 
site, the word “Administration” is automatically added to the name. You can use any 
descriptive name that helps you clarify the purpose of your various portals, and it must be 
unique from all existing Web application names. For example, if you install all three portals, 
your site names might be Customer Portal, Vendor Portal, and Reseller Portal. The 
administration site names then become Customer Portal Administration, Vendor Portal 
Administration, and Reseller Portal Administration.

Public URL: Portal users also navigate their browsers to the farm. Because of load 
balancing, they may be serviced by any machine in that farm. Set up a DNS record for your 
portal site, such as CustomerPortal, as part of your external DNS domain. It should point to 
the farm's load balancer.The entry may look like this: CustomerPortal.<your 
company>.com.

Use Secure Sockets Layer (SSL): In this case, you should use SSL and the check box 
should be selected.

Extended Web Application Advanced Information Screen 

The settings on this screen also apply to the external portal site.

Internal Host Header: Generally, this will be the same as the Public URL setting. 
Therefore, keeping with our example, it would look like this: CustomerPortal.<your 
company>.com. The Internal Host Header setting would be different from the public URL 
only when you use more sophisticated routing techniques, such as a Reverse Proxy or 
URL rewrite rules. Also, because you should use SSL (digital certificates) for secure 
connections, this host header name must match the “Issued To” or “Common Name” on 
the digital certificate.

Internal IIS Web Site Port: Generally, you should use the standard https port 443 if you 
are using SSL.

Use Port Number on Public URL: In this case, you should again leave this check box 
cleared.

Your Site Name:

Your Public URL:

Your Setting:

Your Internal Host Header:

Your Internal IIS Web Site Port:

Your Setting:
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In this scenario, if you install all three portals, you would end up with these Web 
applications:

Installing the Portal(s) and Portal Manager

This section provides information about the installation wizard and steps for completing a 
portal installation. After installing a portal, we recommend that you configure it before 
installing another portal, if applicable. Configuration information is provided after this 
section.

IMPORTANT: Before installing the portals, you must check to make sure that the Internet 
Information Services (IIS) options for enabling 32-bit applications are set to False. Follow 
these steps:

1. On the machine where you will install the portal(s), open IIS Manager.

2. In the Connections pane, expand the machine node and select Application Pools.

3. In the Actions pane, click Set Application Pool Defaults.

4. In the General section, make sure Enable 32-Bit Applications is set to False. 

5. Click OK.

6. In the list of Application Pools, select SecurityTokenServiceApplicationPool.

7. In the Actions pane, under Edit Application Pool, click Advanced Settings.

8. Again, in the General section, make sure Enable 32-Bit Applications is set to False.

Portal URL
Port 
Number User Login

Customer 
Portal

CustPortalAdmin 

or 

CustPortalAdmin.<internal domain> 

or

CustPortalAdmin.<yourcompany>.com

80 or 443 Portal 
Administrators

Windows or forms 
authentication

CustomerPortal.<yourcompany>.com 443 Customers Portal pre-login site 
page

Reseller 
Portal

ResellerPortalAdmin 

or 

ResellerPortalAdmin.<internal domain> 

or 
ResellerPortalAdmin.<yourcompany>.com

80 or 443 Portal 
Administrators

Windows or forms 
authentication

ResellerPortal.<yourcompany>.com 443 Resellers Portal pre-login site 
page

Vendor 
Portal

VendorPortalAdmin 

or 

VendorPortalAdmin.<internal domain> 

or 

VendorPortalAdmin.<yourcompany>.com

80 or 443 Portal 
Administrators

Windows or forms 
authentication

VendorPortal.<yourcompany>.com 443 Vendors Portal pre-login site 
page
Infor SyteLine Portals Setup and Administration Guide 
Copyright © 2014 Infor 



36  Installing and Configuring the Portal(s) 
9. Click OK.

10. Close IIS Manager.

About the Wizard

You must run the installation wizard one time for each portal you wish to install. Portal 
content is added each time, and individual installations are required to create the Web 
applications necessary for each portal. You will indicate which Web applications to create 
(Customer, Vendor, or Reseller) when you specify an applicable Site Name in the wizard. 

The wizard makes these changes to your SharePoint installation:

 Creates a Web application with Claims Based Authentication, enabling both Windows 
and forms-based authentication. The installer sets the Membership provider name to 
SyteLineMembershipProvider v3.0.0.0 and the Role manager name to 
SyteLineRoleProvider v3.0.0.0. This is used as the administration site for the portal.

 Extends the new Web application to:

 Enable Claims Based Authentication using only Forms Based Authentication (FBA). 
The installer sets the Membership provider name to SyteLineMembershipProvider 
v3.0.0.0 and the Role manager name to SyteLineRoleProvider v3.0.0.0. This is used 
as the external portal site on the Internet.

 Enable a custom login page. This is the initial page for the external portal. 

 Sets the service account for the Web application and the Primary Site collection 
administrator to the SharePoint user name specified in the wizard.

 Sets the URLs, ports, and SSL options as specified in the wizard.

 Deploys the portal solutions to the Web application and to SharePoint Central 
Administration.

 Deploys portal content.

The wizard also installs Portal Manager and Portal Diagnostics.

Run the Installation Wizard

Log in to the machine in your SharePoint farm that you will use to install the portals. Log in 
as an administrator on the machine. We recommend using the SPInstall account 
described in “SharePoint Setup” on page 25. Also see that topic for recommendations 
regarding a SharePoint Standalone installation.

NOTE: If you are using Terminal Services to access the machine where you are installing 
the portals, you should open your local group policy editor on the server (or an Active 
Directory GPO) and enable the setting to turn off Windows Installer RDS Compatibility. 
It can be found here: Computer Configuration\Administrative 
Templates\Windows Components\Remote Desktop Services\Remote Desktop 
Session Host\Application Compatibility. 

For more information, see http://www.gearbytes.com/2010/11/looping-windows-
installer-coordinator/.
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Download the Infor SyteLine Portals installation wizard file (SL 9.00 Portal Install 
IPF 3.1 Build 70.exe) from the Infor Xtreme Support portal. You can request the 
location of the file from your SyteLine customer service representative. Follow these steps:

1. Double-click the .exe file.

2. On the Welcome screen, click Next.

3. For the first installation, review the Pre-Requirements screen and when ready, click 
Next.

4. Do one of the following: 

 If this is the first or only portal to be installed, on the Select Features screen, specify 
the features to install:

 Portal Architecture: This installs the portal architecture. When you select this 
option, Portal Manager is also selected by default.

 Portal Manager: The Portal Manager is required for content activation, 
management, and backup, and for portal diagnostics. Administrators can use 
Portal Manager from machines other than where SharePoint and portal content 
are located, so you can install the Portal Manager by itself on other machines.

 Portal Content: This option installs our portal content. 

After making your selection(s), click Next.

 If this is the second or third portal to be installed, on the Program Maintenance 
screen, make sure Add or Remove Features is selected, click Next, and then on 
the Select Features screen make sure Portal Architecture is selected. (If you clear 
it, the architecture from the previous installation will be removed.) Click Next.

5. On the Destination Folder screen, do one of the following: 

 If this the first or only portal to be installed, specify the folder where the files should 
be installed on the machine. We recommend that you use the default path. This 
folder is where the Portal Manager, content files, and .wsp files (solutions) that 
create the SharePoint applications are stored. Click Next.

 If this is the second or third portal to be installed, this screen is skipped, because 
additional portals are installed to the same location. Go to the next step.

 If you are installing only the Portal Manager, we recommend that you use the default 
path. Click Next and skip to step 12.

6. On the Web Applications screen, specify whether to create a new Web application or 
use an existing one:

 If this is a new installation of this portal, select Create a new Web Application. Click 
Next.

 If this is a reinstallation of an existing portal Web application, select Use existing 
Web Application and then on the Select Web Applications screen select the Web 
application to use. Previously created, empty portal Web applications for Infor Portal 
Foundation (IPF) 3.0 are shown in the box on the left. Select the one to use and then 
click the arrow to move it to the box on the right. Click Next and skip to step 12.

NOTE: If you move a Web application from the box on the right to the box on the 
left, it will be uninstalled. 
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7. On the Application Pool Logon Information screen, specify the SPServices 
SharePoint account as described in the table on page 27. This is the security account 
for the application pools that are created. It must be a Managed Account in SharePoint. 
(If you are installing in a SharePoint Standalone environment, see the note in “Set Up 
User Accounts for SharePoint” on page 25.)

 User name: Specify the name in the format domain\user name.

 Password: Specify the password for the above user name.

Click Next.

8. On the New Web Application screen, specify this information to create the Web 
application, site, and security zones. Refer to the notes you kept in “Determining the 
Public URL and Other Portal Settings starting on page 30.

 Public URL: Specify the URL for the administration portal. In our test environment 
example, it is the SharePoint server name. 

 Use Secure Sockets Layer (SSL): By default this check box is not selected. If the 
administrator should have Internet access to the site and you are using SSL, select 
the check box.

Click Advanced.

9. On the Web Application Advanced Information screen, specify these values:

 Internal Host Header: Specify the host header for the administration portal. In our 
test environment example, it is the SharePoint server name. For a production 
environment, it can vary. See “Determining the Public URL and Other Portal 
Settings” on page 30.

 Internal IIS Web Site Port: Specify the port number. In our test environment 
example, port numbers must be different for each Web application. For a production 
environment, they can be the same. 

 Use Port Number on Public URL: Select this check box only if you want to use the 
above port number on the public URL. In a test environment, you should select this 
option. In most production environments, you will not select this option.

Click OK to close this screen and then on the New Web Application screen, click Next.

10. On the Extended Web Application screen, specify this information to create the 
external portal Web application, site, and security zones:

 Site Name: Specify the Web site name; for example, Customer Portal.

 Public URL: Specify the URL for the external portal. In our test environment 
example, it is the SharePoint server name.

 Use Secure Sockets Layer (SSL): Typically, you should select this option for the 
external portal site, unless it is in the test environment. 

Click Advanced.
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11. On the Extended Web Application Advanced Information screen, specify these 
values:

 Internal Host Header: Specify the host header for the external portal. In our test 
environment example, it is the SharePoint server name. For a production 
environment, it can vary. See “Determining the Public URL and Other Portal 
Settings” on page 30.

 Internal IIS Web Site Port: Specify the port number. In our test environment 
example, port numbers must be different for each Web application. For a production 
environment, they can be the same.

 Use Port Number on Public URL: Select this check box only if you want to use the 
above port number on the public URL. In a test environment, you should select this 
option. In most production environments, you will not select this option.

Click OK to close this screen and then on the Extended Web Application screen, click 
Next.

12. Click Install to start the installation.

13. Click Finish to complete the installation. After installation is complete, shortcuts for the 
installed portal and Portal Manager are displayed on your desktop. 

The Web site shortcuts should not be used until after the portal is configured. Portal 
Manager can be used immediately.

 <Site Name> Administration: This opens a login page for the administration portal. 

 <Site Name>: This opens the login page for the external portal site.

 Infor Portal Manager 3.1: This opens the Portal Manager.

NOTE: If the installer fails to complete successfully and there is no entry for a SyteLine 
portal in the Control Panel Programs and Features area, see “Cleaning Up After Portal 
Installation Failure” on page 180. 

As stated before, you must run the installation wizard for each portal you plan to set up; 
however, before installing the next portal, we recommend that you configure the one you 
have just installed. 

Binding Digital Certificates to the Web Applications

If your portal will use SSL/HTTPS, you must bind your digital certificates to each of the IIS 
instances that support the Web application(s) that have been configured for SSL in the 
SharePoint server farm. See the IIS Manager online help for the steps to take. During the 
binding process:

 On the Site Bindings page in IIS Manager, select the entry for the port that you specified 
when creating the Web application 

 When you edit the binding for that entry, select the appropriate SSL certificate for the 
SharePoint server from the names in the list. 

NOTE: If you have to change protocol, host name, or port settings specified during portal 
installation, see “Changing IIS Site Bindings” on page 128.
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Configuring the Portal(s)

Portal configuration includes activating portal content, configuring data sources, and 
specifying general configuration settings. All of these tasks are performed using the Portal 
Manager. This section provides instructions for connecting to a portal site and completing 
portal configuration.

After you complete these tasks for each installed portal, you will set up SyteLine for use 
with the portal(s). Separate chapters are provided with setup procedures. 

Connect to the Portal Site in Portal Manager

Each time you open Portal Manager, you must connect to the portal site to work with. To 
connect:

1. Double-click the Portal Manager shortcut on your desktop. 

2. In the form that opens, specify the portal URL. This is the URL you specified in Public 
URL during installation. 

For example, http://<SharePoint Server Name>:8080 or 
http://CustomerPortalAdmin.<internal domain>.

3. Do one of the following:

 For initial use of Portal Manager, we recommend that you specify the SPServices 
application pool user name and password you used in the wizard during portal 
installation, because this user has the required permissions in SharePoint. (If you 
are using a SharePoint Standalone environment, see the note in “Set Up User 
Accounts for SharePoint” on page 25.) In the Credentials field, select Windows 
Authentication and then click Connect.

 For later use of Portal Manager, after you have configured and tested the portal(s), 
you have these options:

 To use your current Windows session credentials, and if you have specified the 
Workstation Domain/ID on the SyteLine Users form and set the Use 
Workstation Logon option in preferences, you can select Use Windows logon 
credentials and then click Connect. 

 You can specify your portal user account user ID and password and then 
indicate in the Credentials field whether it is a Windows account or a Forms 
account. Forms Authentication means that the account is stored in the 
authentication data source. (This option can be used only after the 
authentication data source is configured and functioning and your user account 
has been created in SyteLine. Both are explained later in this document.) 

Activate Portal Content

When you install a SyteLine portal, the standard portal content — including site pages, 
layouts, page sets, style families, and help topics — is loaded but not yet activated for use. 
To activate content for the portal you have just installed:

1. Open the Portal Manager and connect to the portal administration site of the new 
installed portal. The Configuration > Content Activation tab is displayed.
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2. Depending on which portal you have installed, click in the grid to update Priority and 
Active settings as needed. The required settings are specified here:

Customer Portal

Vendor Portal

Reseller Portal

3. Click Apply. The content for your installed portal is activated. 

Information about activating custom content is provided in “Enabling a Portal for 
Development” on page 110.

Originator Priority Feature Name Active

SL 9.00 20

Default Yes

Customer Portal Yes

Reseller Portal Additions

Vendor Portal

IPF 3.1 10

Demo

Default Yes

Originator Priority Feature Name Active

SL 9.00 20

Default Yes

Customer Portal

Reseller Portal Additions

Vendor Portal Yes

IPF 3.1 10

Demo

Default Yes

Originator Priority Feature Name Active

SL 9.00 20

Default Yes

Customer Portal Yes

Reseller Portal Additions Yes

Vendor Portal

IPF 3.1 10

Demo

Default Yes
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Configure Data Sources

Data sources must be defined using the Portal Manager, so each portal knows where to get 
data from. If you have a multi-site implementation, the SyteLine data source configurations 
must include data sources for each SyteLine site the portals will access. These should be 
the same sites specified in an existing site group or in a new site group you will create for 
the portal. See “Creating the Customer Portal Site Group (Optional)” on page 52. Also refer 
to the SyteLine Multi-Site Planning Guide and SyteLine Multi-Site Implementation Guide for 
important details. 

Before you configure data sources, make sure the database servers to which you will 
connect are up and running.

To configure data sources for a selected portal:

1. In Portal Manager, select Configuration > Data Sources. 

2. Click the New (+) icon next to the Data Sources grid to create a data source for each of 
your SyteLine sites. For example, if you have sites in Ohio, Indiana, and Michigan, you 
would make these entries:

IMPORTANT: For multi-site, we recommend that you add your authentication data 
source first, because the first data source entered is set to Default, Translator, and 
Authenticator by default. When you apply the SyteLine data source(s), you are 
prompted to push the authentication data source to SharePoint. Any time you change 
this setting and click Apply, you are prompted to push again. So it is most efficient to 
enter the authenticator data source first, so you don’t have to change it. The Default and 
Translator settings can be changed as needed. All settings are described further near 
the end of this step.

If you have only one site, you would make one entry:

After you add a new data source and click OK, you must specify this information for the 
data source: 

 Config Server URL: Specify the URL that points to the SyteLine utility/Web server. 
This URL is added by default: http://{server 
name}/IDORequestService/ConfigServer.aspx. Generally, you need to 
replace {server name} with your utility server name. Tab to the next field.

NOTE: If the following error is displayed when you exit this field, you specified an 
https secure protocol, but you do not have a valid digital certificate installed and 
bound, so you cannot save the configuration. 

Name Type

Infor ERP SyteLine 9.0 Ohio SyteLine

Infor ERP SyteLine 9.0 Indiana SyteLine

Infor ERP SyteLine 9.0 Michigan SyteLine

Name Type

Infor ERP SyteLine 9.0 Ohio SyteLine
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Configuration Error: Error processing an IDO request. 
(Status:TrustFailure The remote certificate is invalid according 
to the validation procedure.)

See the information below for the Ignore Invalid Security Certificate field.

 Config Name: Select a SyteLine configuration from the drop-down list. This is the 
configuration that the portal will access.

 User ID and Password: Specify a SyteLine user ID that is defined as a superuser 
in the SyteLine configuration named above. This administrative user briefly logs into 
SyteLine to validate user accounts when portal users sign in. We recommend that 
you specify the SL_Internal multi-session user and password.

NOTE: When there are multiple portal applications installed on a SharePoint 
system using the same SyteLine utility server and configuration (as specified in the 
Config Server URL and Config Name fields), the same administrator account 
settings must be used here for all of the portals.

 Ignore Invalid Security Certificate: In a test environment, you can use an SSL 
certificate that is self-signed or that is signed using the internal or private key. Select 
this check box if you want the system to ignore the lack of a valid certificate and trust 
relationship for the SSL/TLS secure channel.

Selecting this check box is not recommended for a live environment. If you select 
this check box now, but later you install a valid digital certificate, at that time you 
must clear this check box and save the configuration again. You must also refresh 
the IIS server pool.

 Paired MSSQL Data Source: For MSSQL data sources only, this setting is provided 
for customers who experience performance issues when accessing BLOB data. By 
selecting this check box, you can bypass the utility server when fetching images and 
documents. This allows you to stream images and attached binary documents 
separate from the SyteLine data source. A typical SyteLine implementation does not 
require this setting.

Click Apply.

You can click Test Connection to test each SyteLine data source you have added. You 
may have to click the refresh icon above the New (+) icon to enable the Test 
Connection button.

If you receive errors and would like to review the log file, you can right-click in the log 
display at the bottom of the screen and select Locate Log File.

Additional settings for the data sources are Default, Translator, and Authenticator. 
You can apply these settings as you add each data source or after adding all data 
sources. 

 Default: Select this check box if the data source should be used by default when the 
system does not find a collection in IPF Collection Definitions. The Infor portals 
require that PortalSiteGroup (created in step 4 below) is set as the default.

 Translator: Select this check box for the SyteLine data source that should be used 
by the system to find string IDs. One data source must be set as the Translator.
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 Authenticator: Select this check box for the SyteLine data source should be used 
for portal user password validation. One data source must be set as the 
Authenticator. 

When you apply the authenticator setting, a message to push the entry to STS is 
displayed. Click the link to open SharePoint Central Administration, click Push 
Config to STS, click OK, and then close the browser window. Back in Portal 
Manager, click OK to close the message box.

If you happen to close the pop-up window before clicking the link, see “Pushing 
Portal Configuration Changes for a New Server in the Farm” on page 127 for 
instructions to display the page where you can push STS changes.

Also, if you need to change the authentication data source, refer to “Changing the 
Authentication Data Source” on page 127 for more information.

NOTE: For the next three data sources you add, the names must be specified exactly as 
shown in the examples, with regard to capitalization and spacing.

3. Add the PrimarySite data source, which is an alias data source. This points to the 
SyteLine site from which it gets portal-enabled items and item category information. If 
you have only one SyteLine site, that is your Primary Site. If you have multiple sites, your 
master site must be used for the PrimarySite data source.

Click Apply.

4. Add the PortalSiteGroup data source, which is a multiplexed data source. In the List of 
Data Source Names grid, add all SyteLine sites from which data should be exposed on 
the portals. If you have only one site, then the PortalSiteGroup data source will use only 
that site. At least one alias must be assigned to each data source in PortalSiteGroup. 

To add sites, click the New (+) icon next to the lower grid. On the form that opens, select 
a data source to add and then click the New icon on that form. Specify the alias and then 
click OK. The alias must be the site code as shown in the Site field on the General 
Parameters form in each SyteLine site. 

The PortalSiteGroup must be set as the Default data source, so the results from one or 
more sites can be multiplexed together to view in the portal

Name Type

PrimarySite (no space) Alias

Name Type

PortalSiteGroup (no spaces) Multiplexed
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Sample list of Data Source Names

Click Apply.

5. Add a data source for SharePoint:

Click Apply.

If you need to delete a data source record you have added, select the row, click the 
Delete icon, and then click Apply.

When complete, your data source configuration may look similar to this:

Set General Configuration Options

To set general configuration options:

1. In Portal Manager, select Configuration > General. 

2. Specify this information:

 Pre-Login Account user ID and password: For each portal, specify the SyteLine 
user ID and password you created for the pre-login user account. See “Create the 
Pre-Login User Account” on page 28. 

After applying this setting, you can click Test to verify the ID and password that you 
have entered. 

 Viewable Page Set: Specify the page set that should be viewable by users of this 
portal. The provided page sets are Default, PreloginPages, and ModalPages. For 
Customer Portal, you should select PreloginPages if you want to provide pre-login 
browsing of your portal pages. Otherwise, leave the field blank. For Vendor Portal 

Name Alias*

Infor ERP SyteLine 9.0 Ohio OH1

Infor ERP SyteLine 9.0 Indiana IN1

Infor ERP SyteLine 9.0 Michigan MI1

* These are sample aliases. Your alias for each SyteLine data source must be the site code from 
the Site field on the General Parameters form.

Name Type

Local SharePoint Portal (with spaces) SharePoint

Data Source Name Type Default Translator Authenticator

Infor ERP SyteLine 9.0 Ohio SyteLine X X

Infor ERP SyteLine 9.0 Indiana SyteLine

Infor ERP SyteLine 9.0 Michigan SyteLine

PrimarySite Alias

PortalSiteGroup Multiplexed X

Local SharePoint Portal SharePoint
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and Reseller portals, you should leave this field blank, unless you have created your 
own page set to use. Refer to the Infor Portals Customization Guide for more 
information.

 Locale Settings: For each portal, select the default locale appropriate for your 
portal(s). This usually is the domestic language used in the SyteLine configuration 
accessed by the portal. If you do not select a locale, it defaults to en-US. 

Also select any locales that should be supported in your portal. Ensure that the 
SyteLine configuration includes the appropriate text strings, category descriptions, 
overviews, etc. for each locale you select here. Also make sure that in SyteLine 
there is only one LocaleID for each language that you select here. You can also 
provide translated online help for this locale, as described in “Adding a Help 
Collection for a Different Locale” on page 119.

For more information about how the portal chooses a locale, see 
“Internationalization” on page 258.

 User Authenticated Event Handler: For Customer Portal, select 
SessionStartCustomer. For Vendor Portal, select SessionStartVendor. And for 
Reseller Portal, select SessionStartReseller. If you create a custom script to add 
logic for a user-authenticated event in your portal, you will use this field to apply your 
custom file. Refer to the Infor Portals Customization Guide for more information.

 Default Style Family: Select a style family for your portal. The style families 
included with your installation are named according to color scheme. The only 
difference among these style families is color.

3. Click Apply. 

NOTE: The Enable Portal for Development settings are used for personalizing and 
customizing the portals. See “Enabling a Portal for Development” on page 110 for more 
information.

The Reset Pre-Login Permissions button is used when changes are made to an 
authentication data source or to user or group permissions in SharePoint. See 
“Resetting Pre-Login Permissions” on page 127.

Specify Selected Page Set Styles (Optional)

To configure certain pages in your portal to use a different style family than the default set 
on the General tab, you can use the Page Sets tab to do so. You can associate existing or 
custom style families with existing or custom page sets. To associate custom style families 
and page sets, they must be created by a portal content developer prior to using this tab.

To configure page sets:

1. In Portal Manager, select Configuration > Page Sets.

2. Click the New (+) icon.

3. Select a page set and a style family and then click OK.
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Save the Portal Configuration (Optional)

In the event that you need to restore or replicate a portal configuration, you can save a 
completed configuration and later load that configuration using Portal Manager. 

When you save a configuration, all settings needed to restore a portal can be saved, 
including:

 Content activations

 Data sources

 General properties

 Page set and style family associations

To save a completed portal configuration:

1. In Portal Manager, select Configuration > Save.

2. On the form that opens, select the options to save. 

 To save the entire configuration, select all four options: Content Activations, Data 
Sources, General, and Page Sets.

 To save selected options, expand each node and choose the options to save.

3. Click Save.

4. Specify a name and location for your configuration file and then click Save.

To load a saved portal configuration:

1. In Portal Manager, select Configuration > Load.

2. On the form that opens, locate the configuration file and then click Open.

3. On the form that opens, you have these options: 

 To load a complete configuration into an empty portal, click Select Options and 
then select all four options: Content Activations, Data Sources, General, and Page 
Sets. These settings from the specified configuration file will be loaded, and the 
portal will be ready to use.

 To load selected options into the portal, click Select Options and then select the 
options you need from the specified configuration file.

 To load a complete configuration into a portal for which some configuration settings 
already exist, click Clear and Reload. This option clears any existing settings so you 
can load all settings from the specified configuration file.

4. Click Load.
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Set User Group Permissions in SharePoint

After adding data sources, set permissions for the portal so all SyteLine users who are 
members of the Customer Portal group (for a Customer Portal or Reseller Portal 
installation) or Vendor Portal group (for a Vendor Portal installation) have read-only access. 
Also set permissions for users in the Admin Portal group, so they can access the User 
Account Management Utility.

To set group permissions:

1. Using the shortcut on your desktop, open the portal administration site and sign in using 
Windows authentication. The portal’s Default.aspx page is opened in SharePoint.

2. Select Site Actions > Site Permissions. 

3. Select Grant Permissions.

4. On the Grant Permissions screen, under the Users/Groups box, click the browse 
(book) icon.

5. On the Select People and Groups screen, select Forms Auth, specify Customer 
Portal in the Find box for a Customer or Reseller Portal installation or Vendor Portal for 
a Vendor Portal installation and then click the search icon. The search should find the 
Customer Portal or Vendor Portal group.

NOTE: The portal has a custom membership provider and a custom role manager 
defined that hook SharePoint to the user names and groups defined in SyteLine.

6. Select the group and then click Add.

7. In the Find box, specify Admin Portal and then click the search icon. The search should 
find the Admin Portal group.

8. Select the group, click Add, and then click OK.

9. Select Grant users permission directly, click Read, and then click OK. This setting 
ensures that SyteLine user accounts that have been assigned to the Customer Portal or 
Vendor Portal group will have only read permission when they log in to the portal. It also 
allows portal administrators to use the User Account Management Utility.

10. Close the portal administration site.

IMPORTANT: Never give full control to any group in All Users. This creates a security hole 
in your implementation.

Applying Portal Patches

After you’ve installed and configured all portals that you need, download and install any 
necessary portal patches, which are provided in SyteLine Solution KB 1459104 found on 
the Infor Xtreme Support portal at http://www.inforxtreme.com.
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Testing the Portal(s)

This section explains how to test the administration site and external site for the portal you 
have just installed and configured.

Portal Administration Site

To test the portal administration site:

1. Using the shortcut on your desktop, open the portal administration site and sign in using 
Windows authentication. The portal’s Default.aspx page is opened in SharePoint.

2. Select Site Actions > View All Site Content. You should see the following libraries and 
lists on the page:

External Portal Site

With the necessary user account set up in SyteLine, as explained in “Set Up the Testing 
User Account(s)” on page 29, you can click the external portal site shortcut on the desktop 
to test your portal and see what your end users will see. 

Libraries Lists

IPF Help Assets Announcements

IPF Site Assets FAQs

IPF Site Pages IPF Collection Definitions

PressReleases IPF Data Sources

Product Videos IPF Feature Dependencies

Site Collection Help IPF Field Display Formats

Style Library IPF Installed Help Assets

Videos IPF Installed Originators

White Papers IPF Installed Site Assets

IPF Installed Site Pages

IPF Layouts

IPF Menu Instances

IPF Page Sets

IPF Page Sets Style Families

IPF Style Families
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For Customer portal, the shortcut opens a pre-login Home page that allows you to browse 
the portal without logging in. Notice that there is no Activity menu at the top of the page:

You can sign in using the credentials for your test Customer Portal user account. After you 
sign in, a Home page that includes the Activity menu is displayed.

For the Vendor or Reseller portals, the shortcut opens a login page. You must sign in using 
the credentials for the test Vendor or Reseller Portal user account created in SyteLine.

Demo data is provided with the portals, so you can click on the various pages to see how 
they look. However, to test for specific data from your own database, you must set up 
SyteLine for each portal according to the information provided next in this guide.

If the portal shortcuts do not open the appropriate portal page, review the information in 
Chapter 15, “Troubleshooting”.
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Portal

This chapter provides steps for setting up SyteLine for use with the Customer Portal. 

NOTE: For multi-site implementations, the table shows whether to perform each step in the 
Primary Site, all sites, or only desired sites. If your implementation has only one site, 
then that is the Primary Site.

Step Description SyteLine Forms
For Multi-Site, 
Perform In...

1 Create a site group for the Customer Portal 
(optional).

Site Groups Primary Site

2 Set up items and categories for your product 
catalog.

Items

Item Categories

Item Category Workbench

Portal Parameters

Related Item Reason Codes

Multi-Lingual Items

Primary Site

3 Set up SyteLine to manage consigned 
inventory (optional).

Warehouses

Item/Warehouse

All sites from which 
consigned inventory is 
provided.

4 Set up documents. Groups

Document Types

Attached Documents

All sites

5 Add interaction topics in SyteLine. Interaction Topics All sites

6 Set up information about the customer’s 
company.

Customers

Customer Ship-Tos

Customer Contracts

All sites, except for 
contracts and contract 
prices. See“Set Up 
Customer-Specific 
Items and Pricing 
(Optional)” on page 61 
for more information.

7 Set up contact information for your company. General Parameters

Salespersons

Employees or Vendors

Customer Ship-Tos

All sites

8 Add portal-enabled user accounts. See Chapter 7, “Setting Up and 
Managing SyteLine User 
Accounts for the Portal(s)”

All sites
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Creating the Customer Portal Site Group (Optional)

If you have an existing site group on the Site Groups form in SyteLine, which contains all 
sites specified for your PortalSiteGroup during data source configuration, then you do not 
need to create a Customer Portal site group. You will simply select the existing site group 
when defining portal parameters. See “Specifying Portal Parameters” on page 73. 

If your PortalSiteGroup data source contains sites other than those in an existing site 
group, you must create a new site group for the Customer Portal. 

If you have only one site that is exposed to the Customer Portal and for which a site group 
does not exist, you still must create the Customer Portal site group and assign that site.

NOTE: If the Customer Portal site group contains different sites than your Accounts 
Receivable site group (as specified on the Accounts Receivable Parameters form), 
data on the portal Account Balance page will not equal that shown in SyteLine and may 
not represent accurate customer aging information. In this case, you may choose to 
hide the Account Balance page.

9 Define replication rules.

Required for multi-site implementations.

Replication Rules All sites

10 Specify country codes for the Vertex tax 
system (optional).

Tax Interface Parameters All sites

11 Allow portal users to reprint invoices. Accounts Receivable 
Parameters

Intranets

Report Options

All sites

12 Set up language-independent aging bucket 
labels.

Accounts Receivable 
Parameters

All sites

13 Set up a default bank code. Accounts Receivable 
Parameters

All sites

14 Set up ISO-based currency codes. Currency Codes All sites

15 Maintain ISO unit of measure codes. Unit of Measure Codes All sites

16 Set up event notifications. Workflow Event Handler 
Activation

Publication Subscribers

All sites

17 Configure order shipping alerts. Event Triggers All sites

18 Assign users to portal-related event global 
constants.

Event Global Constants All sites

19 Enable viewing of service knowledge base 
entries.

Knowledge Base All sites

20 Set up online ordering. See Chapter 4, “Setting Up 
SyteLine for Online Ordering”

Step Description SyteLine Forms
For Multi-Site, 
Perform In...
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Setting Up Items and Categories

The following item and category information must be defined in SyteLine in order for the 
portal to work as expected. 

NOTE: For multi-site implementations, items and categories must be specified in the 
Primary Site of the Customer Portal site group, even when an item is not manufactured 
in, shipped from, or priced at that site. 

Standards for Pictures Used on the Portal

We recommend that you use image files of type PNG or JPG. PNG files are best for icons 
and simple vector-type images, which are typically stored in the Site Assets folder in 
SharePoint, while JPG files are best for photo images that are stored in SyteLine. Also, for 
best presentation and ease of adaptability to a change in theme background colors, we 
recommend that you use a transparent background for your icon image files.

Item Pictures

Ideally the item pictures you upload in SyteLine should be at least as large as the largest 
picture size displayed on the portal Product Details page, which is 800x600 pixels. For best 
viewing of this page, the picture should be at least this big; otherwise extra white space will 
surround the image, because the picture is not enlarged from what is stored in SyteLine, 
unless a specific style is used on the cell to zoom in on the image. 

Also note that on devices that are retina-ready, the pixel ratio use is doubled, so for 
instance an 80x80 image is shown in a 40x40 space. The sharpness of the retina-ready 
image is achieved by doubling the amount of pixels used within the available image space. 
The portal is capable of intelligently determining if it is being displayed on a retina-ready 
device and will make the appropriate adjustment when necessary. Therefore, if you want 
your portal's images to look sharp when displayed on a retina-ready device, you should 
load pictures that are double the size that you need for the image when shown on a typical 
monitor, and then limit the display size by the height and width parameters on the image 
field display format.

On some pages, portal users can click a picture to display a pop-up window with a larger 
version of the selected item.

Category Pictures

Recommendations for category pictures are the same as for item pictures.

Banner Pictures

We recommend that banner pictures are 728X90 pixels, or 1456X180 pixels to support 
retina-ready devices.

NOTE: If a picture stored in SyteLine has a different aspect ratio than what is required by 
the field display format on the layout, the picture is scaled to fit inside the cell according 
to the height and width parameters of the field display format on that cell. Larger picture 
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sizes are supported, but the user may have to scroll to see the whole picture, 
depending on the size of their browser window.

If no picture is stored with an item in SyteLine, then no picture can be displayed by the 
Image Field Display Format for that item. White space appears where the picture would 
normally display. However, the portal default is to put the style 'ItemImage' on all cells 
that should contain a SyteLine image, and the 'ItemImage' style has a background 
placeholder image to indicate when no image is returned from SyteLine. 

Set Up Items and Pictures

On the Items form, you must enter all the required fields to describe an item in SyteLine. In 
addition, follow these steps to further define an item that is displayed on the portal:

1. On the Overview tab, specify a description of the item to be used as the default Item 
Overview text on the portal. (You will be able to enter the text in alternate languages 
later.)

2. Right-click in the Item Picture field to load a primary picture of the item into the 
database. This picture is displayed with the item on the Customer Portal.

The primary picture is optional; however, if no picture is loaded, then the portal displays 
white space where that picture would normally display. See “Standards for Pictures 
Used on the Portal” on page 53 for information about standards to use when creating 
and loading pictures for use on the portal.

3. On the Pictures tab, load alternate views of the item. These views are displayed below 
the primary picture on the Customer Portal Product Details page, in the order used on 
the Pictures tab, Sequence grid. These pictures also are optional.

4. On the Overview tab, select Active For Customer Portal to display the item on the 
portal.

NOTE: Items that are marked Active For Customer Portal are available through the Item 
search lists on the portal. However, if the item is not also assigned to an item category, 
as described in “Create the Item Category Hierarchy” on page 55, then it does not 
display in any category on the portal. Users can still find the item through the drop-
down filters on the portal.

5. To include the item in the Featured Products section of the portal and on the Featured 
Products page, select Featured Item.

6. To include the item in the Top Sellers section of the portal and on the Top Sellers page, 
select Top Seller.

NOTE: To add items to categories for display on Customer Portal, we recommend that you 
use the Item Category Workbench form. The Item Categories tab on the Items form 
is intended for item category setup for the Vendor Portal.

Define Categories of Items

The portal can display items by category, so to use this feature you must define categories 
for your portal items using the Item Categories form. For example, if you are a bicycle 
parts manufacturer, you might have categories such as Headlights, Seats, Tires, etc.
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After categories are defined, you can create an item category hierarchy, or category tree, to 
organize items for display on the portal.

NOTE: Categories are optional. If you do not set up any categories, then category search 
and browse features of the portal cannot be used. Customers can search only by item. 

To define categories of items:

1. Open the Item Categories form.

2. Specify the category name and description.

3. Right-click in the Category Banner field to load a picture that applies to the category 
and should be displayed across the top of the Customer Portal Products page. The 
picture is shown when the You Searched For box on that page contains only one object: 
either a category or a category that includes a category set to Is Category Heading. 
The picture is not shown if there is nothing in the You Searched For box or if more than 
one category object is in the box. This picture is needed for only top-level categories in 
the category hierarchy.

4. Right-click in the Category Picture field to load a picture that applies to the category 
and is displayed on the Products page when multiple categories are shown. 

Category pictures are optional. If no picture is loaded, then the portal displays white 
space above the category title. See “Standards for Pictures Used on the Portal” on page 
53 for information about standards to use when creating and loading pictures for use on 
the portal.

5. If the category is to be displayed on the portal, select Active.

6. If the category is to be a “container” for other categories, not items, in the item category 
hierarchy, select Is Category Heading. Category headings are displayed in larger and 
bold type on the portal.

7. Use the Translations tab to create category descriptions in different languages, to be 
displayed on the portal according to the user’s browser language setting.

NOTE: To add items to categories for display on Customer Portal, we recommend that you 
use the Item Category Workbench form. The Items tab on the Item Categories form 
is intended for item category setup for the Vendor Portal.

Create the Item Category Hierarchy

Using the Item Category Workbench form, you can add unlimited categories and 
subcategories to set up your item category hierarchy, and then associate items with the 
appropriate categories and subcategories. You also can remove categories and items as 
needed.

To create the item category hierarchy:

1. Open the Item Category Workbench form.

2. In the hierarchy tree on the left side of the form, select the category to which to add 
subcategories. 

3. Make sure the Display Current Search field is cleared. All categories active for the 
portal and all items in the items table are displayed on the Categories and Items tabs. 
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4. On the Categories tab, select subcategories to add to this category and then select 
Actions > Save. 

5. Repeat steps 2 - 4 for as many categories and subcategories as needed for your 
structure. 

6. In the hierarchy tree, select a category or subcategory to which to add items. 

7. On the Items tab, select items to add and then select Actions > Save. The same item 
can be added to multiple categories.

8. Repeat steps 6 and 7 for as many categories and subcategories as needed. You can 
see how your item category hierarchy will appear to portal users by logging in to the 
Customer Portal and using the Products page to find items.

Enable Simplified Category Browsing (Optional)

You can choose whether to provide simple category browsing in addition to complex 
search functionality on your Customer Portal. 

Complex searching is provided by default. Your customers can enter search criteria into 
Category and Item fields to find specific items in the catalog. Their search is tracked in a 
You Searched For box and an item category tree. 

Simple browsing displays only a category menu with a slide-out subcategory menu. Two 
levels of categories can be displayed. Customers browse through the categories to find 
items.

To enable simplified category searching, select Enable Category Browsing on the 
SyteLine Portal Parameters form. 

Add Reason Codes and Related Items (Optional)

You can link related items as “recommended items” that display when a user is looking at a 
particular item on the portal. To do this, you must first set up reason codes that indicate 
how the items are related.

On the Related Item Reason Codes form, specify a reason code and a description (for 
example, “Recommended Item”) for each relationship. The reason code and description 
are not displayed on the portal and are used only for reference. However, the reason code 
is required on the Items form if you add related items.

To add related items, on the Items form, Related Items tab, specify any items that should 
appear as “Recommended Items” when the selected item is displayed on the portal. Also 
select a reason code for the related items.

Add Language-Specific Information about Items (Optional)

In addition to the language-specific category descriptions you added with categories, you 
can specify language-specific item descriptions and item overviews.
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1. On the Multi-Lingual Items form, select an item that is to be displayed on the portal and 
review the current overview text, as created and stored on the Items form in your 
domestic language.

2. Select a different language code.

3. Enter the Item Description and the Overview for the item in that language.

4. Repeat steps 2 and 3 for the item, for all languages in which the portal may be viewed.

5. Repeat all steps for all other items for the portal.

Setting Up Consigned Inventory (Optional)

SyteLine can track and process inventory that is consigned to a customer, and the 
customer can use the portal to review consigned inventory levels and submit used 
quantities. 

If you provide consigned inventory to customers, you should set up the consignment 
warehouse, customer ship-to, and upper and lower boundaries for managing inventory 
replenishment in the consignment warehouse for all sites in the Customer Portal site group.

1. On the Warehouses form, select the warehouse to be used for inventory consigned to 
the customer, and set the Consignment Type to Customer. Also, in the Customer 
fields, select a customer and specific ship-to for the warehouse.

2. On the Item/Warehouse form, set the minimum and maximum consignment quantity for 
items in the consignment warehouse. These values are displayed on the portal’s 
Consigned Inventory page. Alerts can be sent to portal subscribers when consignment 
quantity goes below the minimum or above the maximum requirement.

Setting Up Documents

The portal Documents function is used to provide controlled access to documents that are 
attached to specific records in SyteLine. Documents can be attached to item, order, 
estimate, incident, inventory, or service knowledge base records and viewed on the portal 
by users associated with those records. Documents can be added for the portal by a 
SyteLine user or they can be uploaded by a registered B2B portal user and then approved 
in SyteLine.

In order for portal users to access documents using the Customer Portal, you must perform 
the tasks in this section in all applicable sites in SyteLine.
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Verify Group Requirements

These requirements can be verified using the SyteLine Groups form:

 SyteLine users who will work with documents must belong to the Standard Forms group, 
which gives them access to these forms:

 Attached Documents

 Documents

 Document Objects Query

 SyteLine users must belong to groups that give them access to appropriate forms 
related to the documents used on the portal. For example, if SyteLine users are in a 
group that allows them to access the Purchase Orders form, then they will be able to 
add order documents in SyteLine and view and approve documents uploaded via the 
portal Order Status page.

 Customer Portal users must belong to the Customer Portal group, which is assigned 
during user account creation.

Create Document Categories

Use the Document Types form to create categories for the documents that can be 
attached to records, and also to assign groups to each document type, based on who 
should be able to access documents in the category. 

The name you give a document type should be meaningful to B2B portal users, because 
they must select the type when uploading a document. For example, you might want to 
have Word documents (*.doc) attached to contracted inventory items. You can use the 
Document Types form to create a document type called "Item Docs" and associate the 
File Extension "doc" and Media Type "application/msword" with that type. This document 
type would then be used when attaching files to items in SyteLine or on the portal.

NOTE: You must provide a default extension for each document type, but documents with 
other extensions can be uploaded and downloaded for the category. For example, if 
you specify "txt" as the default extension, portal users can still upload a .pdf or .doc file 
for the category.

When you assign the Customer Portal group to this document type, you make documents 
in this category available to Customer Portal users. If you also assign the Inventory group 
to this document type, you make documents in this category available to users in the 
SyteLine Inventory group. See “Additional Portal Document Guidelines” on page 59.

Add Documents for Downloading

To add documents in SyteLine that can be downloaded on the portal:

1. Open a form that contains a collection for which to attach a document for downloading, 
such as Items or Estimates. 
Infor SyteLine Portals Setup and Administration Guide 
Copyright © 2014 Infor 



Setting Up SyteLine for the Customer Portal         59
2. Select the record to which to attach a document and then select Actions > Documents 
for Current. This opens the Attached Documents form so you can attach the 
document. 

Specify the required information and then import the document. Do not select Internal, 
because then the document cannot be shared on the portal. Make sure to specify the 
Document Type. When you specify the Document Type, the groups assigned to this 
category are displayed in Shared Groups.

3. Save the record.

NOTE: Portal users must be subscribed to the CustomerDocumentUploadAlert publication 
to receive notifications when documents are added for them in SyteLine. They can 
subscribe themselves using a setting on the portal Account Management page, or you 
can subscribe them in SyteLine. See “Setting Up Customer Event Notifications” on 
page 64.

Approve Uploaded Documents

When a document is uploaded on the portal, its status must be changed from Pending to 
Approved in SyteLine, so it is accessible on the portal. This is an ongoing administrative 
task. See “Approving Uploaded Documents” on page 125.

Additional Portal Document Guidelines

Following are additional notes about documents and document types:

 Any document that is to be viewable on the Customer Portal must be associated with 
the Customer Portal group. As described above, this is accomplished by assigning the 
Customer Portal group to the document type and then assigning the document type to 
the document.

 At least one document type must be associated with the Customer Portal group, or no 
documents will be visible and no document can be uploaded via the portal. 

 Document types must allow for shared groups to be included in the collection of groups. 
For example, an item document that is to be shared across the Customer Portal requires 
that, in addition to the Customer Portal group, the group maintaining the item in SyteLine 
is assigned to the document type. The Customer Portal group permissions would not 
allow a customer to update or delete the document, but due to its document type 
(category), the customer would be able to view the document.

 When adding a document, users cannot use a document type for which they are 
excluded from the group collection. The user must have insert permissions on a shared 
group.

 You can use the Document Group Management form to see documents associated by 
group and document type. This form displays only documents associated with the 
Customer Portal group or the Vendor Portal group, and it shows all the documents that 
customers or vendors can view on the portals.

 For multi-site implementations, on the Document Upload form that B2B customers use 
to upload a document from the portal, the Upload Site field displays the site to which 
the document will be uploaded. The site is based on the document object, which is 
determined by the page from which the user uploads a document:
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 From the Customers page, the document is uploaded to the Primary Site.

 From the Order Status page header, the document is uploaded to the site where the 
order was created.

 From the Order Status page line item, the document is uploaded to the site from 
which the item was shipped.

 From the Estimates page header or line item, the document is uploaded to the site 
where the estimate was created.

 From the Product Details page, the document is uploaded to the Primary Site.

Viewing Documents on the Portal

The portal Documents page displays documents associated with customer records. Only 
documents for the logged-in customer are visible. 

To view documents about other types of records, such as incidents or orders, portal users 
must click the Documents icon displayed with an individual record on the related portal 
pages.

Adding Interaction Topics

Portal users can create interactions to send you about various records on the portal, and to 
do so, they must select a predefined topic description. You must add these topic 
descriptions using the SyteLine Interaction Topics form.

When defining interaction topics for a multi-site implementation, the same topics should be 
defined in each site of the Customer Portal site group. Also, the topics should be translated 
to the same languages in each site. For more information, see “Creating the Customer 
Portal Site Group (Optional)” on page 52 and refer to the Multi-Site Planning Guide.

Setting Up Information about the Customer’s Company

For Customer Portal users who are employees of your customer’s company, you must 
have some basic information about the customer’s company set up in SyteLine before the 
customer user logs into your portal for the first time. This information is displayed in various 
sections of the Account Management page. Portal users can submit updates to some, but 
not all, of this information.

The following records for the customer should be created in all sites of the Customer Portal 
site group.

Set Up a Customer Record

On the Customers form, make sure this information is set up:

 Company Name

 Address (including County and Country)

 Language
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 Currency

 Credit Limit

 Internet URL

 Order Contact Name, Phone, Fax, External E-mail and Internal E-mail

 Billing Contact Name and Phone

Set Up Ship To Addresses for the Customer

Set up at least one Ship To address for the customer on the Customer Ship-Tos form. 
Make sure this information is set up:

 Ship To Name (Customer Portal users can select different addresses by name)

 Ship To Address (including County and Country)

 Ship To Contact Name, Phone, Fax, and E-mail

Set Up Customer-Specific Items and Pricing (Optional)

If your customer refers to your items with a different item number, you can cross-reference 
their item numbers to your items on the Customer Contracts form. Then, when users from 
that customer company log into the portal, they can view or look up their item numbers. 

Any special or contract pricing related to the customer for specific items, as specified on 
the Customer Contracts form, is displayed on the portal instead of the standard pricing for 
that item.

For a multi-site implementation, all customer contracts must be maintained in the Primary 
Site and in the item’s portal pricing site. Customer contract prices must be maintained in 
the item’s portal pricing site and, optionally, can also be maintained in the Primary Site. 

Setting Up Contact Information for Your Company

In order to support the portal Contact Us page, you must set up these areas in SyteLine:

Specify Company Address, Phone and E-Mail

On the General Parameters form, specify company contact information on the Address 
tab. All of this information except the site and the e-mail address is displayed on the 
Contact Us page of the portal.

The e-mail address you specify on the General Parameters form is used when customers 
submit a question or comment from the Contact Us page. If no e-mail address is specified 
on the General Parameters form, then the Send Questions or Comments button is not 
displayed on the portal.

Specify Salesperson Name, Phone, and E-mail for Customer Ship-To Addresses

When customers log into the portal, the Contact Us page lists contact information for the 
salesperson who is assigned to each of that customer’s Ship-To addresses. 
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You must specify the following information in every site of the Customer Portal site group:

1. On the Salespersons form, make sure each salesperson has a Reference Number 
(either an employee number or a vendor number) assigned. The salesperson’s phone 
and e-mail address on the Contact Us page is taken from the appropriate Employee 
record for inside salespeople or Vendor record for outside salespeople.

2. On the Employees or Vendors form, as appropriate for the salesperson in the previous 
step, make sure that the Business Phone and E-Mail Address fields (on Employees) 
or Contact Phone and External E-Mail fields (on Vendors) are completed.

3. On the Customer Ship-Tos form, select a Salesperson code for each Ship To address 
for each portal customer. This is the salesperson whose information will appear on the 
Contact Us page. If you do not specify a Salesperson code, the “Salesperson: 
Contacts” information on the Contact Us page will be blank.

NOTE: For Customer Portal users who are assigned to a reseller, the Salesperson field is 
populated automatically with the reseller’s salesperson ID when the customer is 
registered online. For more information, see “Adding Customers for a Reseller” on 
page 82 and “Creating Portal User Accounts with the User Account Management 
Utility” on page 102.

Adding Customer Portal User Accounts

Although portal users never see SyteLine forms, they do access SyteLine data through 
IDOs and so they must have a user account in SyteLine, with the appropriate licensing and 
permissions. The portal user logs in through SharePoint using this SyteLine user name and 
password.

Tasks for adding user accounts are provided in Chapter 7, “Setting Up and Managing 
SyteLine User Accounts for the Portal(s)”. 

After adding user accounts, you can complete the remaining tasks in this chapter.

Defining Replication Rules for the Customer Portal Category

This requirement is for only multi-site implementations.

In each site used by the portal, use the Replication Rules form to define replication rules 
for all sites that belong to the Customer Portal site group. Refer to SyteLine online help 
topics for more information about replication.

Specifying Country Codes for the Vertex Tax System (Optional)

If your Customer/Vendor Tax Code on the Tax Systems form is set to EXTRNL and your 
Tax System on the Tax Interface Parameters form is set to Vertex, then you must specify 
default country codes in the US Country and Canada Country fields on the Vertex 
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Parameters tab of the Tax Interface Parameters form. If these fields are not specified, an 
error is displayed on the portal when a user tries to register a new customer.

Allowing Customer Portal Users to Reprint Invoices

On the portal Invoices page, users may be able to request that a reprinted copy of an 
invoice be e-mailed to them. To set this up:

 On the Accounts Receivable Parameters form, Use Preprinted Forms must not be 
selected. If using preprinted forms is a requirement for your company, then you must 
hide the Invoices page, and all links to it, on your portal. See “Hiding Menu Options 
(Optional)” on page 116 for information about how to do this.

 Specify SMTP settings and select Send Email Notification on the SyteLine Intranets 
form for the intranet associated with the SyteLine site linked to the portal.

 The portal user must have an e-mail address associated with their SyteLine user 
account.

Also in SyteLine, a record for the portal user must be added to the Report Options form, 
with these fields specified and all other fields blank:

 User: The SyteLine user ID assigned to the portal user.

 Output Format: Acrobat Format

 E-mail Notification: Yes

 Attach Report: Yes

 Auto-View: No

You can add these records manually in SyteLine, or a record will be added automatically 
the first time a portal user requests an invoice.

Setting Up Language-Independent Aging Bucket Labels

On the Account Balance page of the portal, the aging buckets you define on the SyteLine 
Accounts Receivable Parameters form are displayed. The titles for these buckets cannot 
be modified to accommodate different languages, so you must use language-independent 
titles.

On the Accounts Receivable Parameters form, Aging Report tab, set each of the titles to 
a language-independent label. For example, the title for the <= 30 Days bucket could be 
set to <= 30 rather than Current.

You must set up aging buckets the same way in all sites associated with the Customer 
Portal site group. 
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Setting Up a Default Bank Code

New customers records added to SyteLine from the Customer Portal use the bank code 
specified on the SyteLine Accounts Receivable Parameters form, so you must ensure 
that a default bank code is set on that form.

Setting Up ISO-Based Currency Codes

In order for currency translations to work properly on the portal, you must use ISO currency 
codes, or map your non-ISO currency codes to ISO currency codes on the SyteLine 
Currency Codes form. See the SyteLine online help about “Currency Codes”.

Setting Up ISO Unit of Measure Codes

In order for item units of measure to be displayed on portal pages, you must maintain ISO 
unit of measure codes on the SyteLine Unit of Measure Codes form. See the SyteLine 
online help about “Unit of Measure Codes”.

Setting Up Customer Event Notifications

Most of the notifications, confirmations, and requests sent back and forth between the 
Customer Portal and SyteLine are handled by the SyteLine Application Event System. 
Some events use workflow event handlers and require subscription to a publication. Other 
events fire automatically based on a trigger in the system. In order to fully use the event 
system, you must activate the necessary workflow event handlers and subscribe users to 
appropriate publications, as described in the following topics.

Activate Workflow Event Handlers

Default versions of the event handlers, with predefined subject lines and messages, are 
already set up and can be used as-is. You must activate the appropriate handlers in all 
sites. 

1. On the Workflow Event Handler Activation form, filter the form to show only event 
handlers where the Application field is set to SyteLine Customer Portal. Currently, 
these event handlers are available:

 Alert Customer Portal Users of New Interaction

 Alert on Order Shipping

 Alert SyteLine Users of Customer Interaction

 Alert Users of a New Customer Portal Document

 Alert Users of a New Customer Document

 Notify Portal Incident Created
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 Notify Portal RMA Approved

 Notify Portal RMA Rejected

 Notify Portal RMA Request Created

 Notify Portal Unit Registration Approval

 Notify Portal Unit Registration Created

 Notify Portal Unit Registration Rejected

 Send Portal Question/Comment E-mail

2. For each of these event handlers, select the Active for This Site check box.

3. Optionally, you can also choose to customize the information that is sent in the 
notifications. Refer to the SyteLine online help about workflow event handlers.

Subscribe Users to Portal-Related Publications

In order for users to receive notifications for various portal events, they must be subscribed 
to the appropriate publications in all sites. These predefined Customer Portal publications 
can send notifications to subscribed users:

 CPConsignedInvLevelAlert

 CPVendorInteractionAlert

 CustomerDocumentUploadAlert

 OrderShippingAlert

 PortalIncidentAlert

 PortalOrderReceivedAlert

 PortalOrderRequestDateBeforeDueDateAlert

 PortalUnitRegistrationAlert

 SLCustomerInteractionAlert

 SpecialPromotionsAnnouncements 

 TaxCodeEvaluationAlert

Use the Publication Subscribers form to subscribe appropriate Infor Service 
Management or portal users to publications. Refer to the summary on the next page for 
more information.

NOTE: On the portal Account Management page, all portal users can select check boxes 
to subscribe to the CPConsignedInvLevelAlert, CPVendorInteractionAlert, 
CustomerDocumentUploadAlert, OrderShippingAlert, and/or 
SpecialPromotionsAnnouncements publications. When a portal user selects a check 
box on the Account Management page, that user is automatically added to the 
Publication Subscribers form as a subscriber to the publication in all relevant sites. 
No setup is needed on your part. If a portal user clears a check box on the Account 
Management page, that user is removed from the Publication Subscribers form. 
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Summary of Event Setup

For user to get notification of:
Activate this workflow 
event handler in all sites:

Subscribe user to this 
publication in all sites:

Subscription can be 
set for:

Orders placed on the portal N/A†† PortalOrderReceivedAlert SyteLine users 

Portal orders placed with request 
date before due date

N/A†† PortalOrderRequestDateBeforeDue
DateAlert

SyteLine users

Interactions from the vendor Alert Customer Portal 
Users of New Interaction

CPVendorInteractionAlert Portal users*

Interactions from portal users Alert SyteLine Users of 
Customer Interaction

SLCustomerInteractionAlert SyteLine users

Shipped orders Alert on Order Shipping OrderShippingAlert Portal users*

New customer documents added in 
SyteLine

Alert Users of a New 
Customer Document

CustomerDocumentUploadAlert SyteLine and portal 
users*

New customer documents added 
on the portal

Alert Users of a New 
Customer Portal Document

CustomerDocumentUploadAlert SyteLine users

Incidents entered on the portal Notify Portal Incident 
Created

PortalIncidentAlert SyteLine users**

RMA requests entered on the portal Notify Portal RMA Request 
Created

N/A*** N/A

Portal RMA requests approved in 
SyteLine 

Notify Portal RMA 
Approved

N/A*** N/A

Portal RMA requests rejected in 
SyteLine 

Notify Portal RMA 
Rejected

N/A*** N/A

Units registered on the portal Notify Portal Unit 
Registration Created

PortalUnitRegistrationAlert SyteLine users†

Unit registrations approved in 
SyteLine

Notify Portal Unit 
Registration Approval

N/A*** N/A†

Unit registrations rejected in 
SyteLine

Notify Portal Unit 
Registration Reject

N/A*** N/A†

User submitted a comment or 
question from the portal

Send Portal 
Question/Comment E-mail

N/A*** N/A

The quantity of consigned inventory 
has gone above or below set limits

N/A†† CPConsignedInvLevelAlert Portal users*

Announcements or promotions 
received

N/A†† SpecialPromotionsAnnouncements Portal users*

A new customer has been created 
on the portal, and tax code 
defaulting is enabled, but there is 
no default tax code record 
associated with the new customer’s 
ship-to address

N/A†† TaxCodeEvaluationAlert SyteLine users

* Portal users can subscribe or unsubscribe using a check box on the portal Account Management page.
** Portal users do not have to be subscribed to alerts for this event. They receive e-mail confirmation if Send External 
Notifications is set for them and an e-mail address is provided on the Users form.
*** No publication is associated with these event handlers. Stored procedures and/or global constants are used to send messages 
for some event handlers.
† Portal users do not have to be subscribed to alerts for these events. They receive e-mail confirmation based on the e-mail 
address specified when registering a unit from the portal.
†† No event handler is associated with these publications. Stored procedures and/or global constants are used to send messages 
for some publications.
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Configuring Order Shipping Alerts

The Alert on Order Shipping workflow event handler is set by default to check for new order 
shipments every day at 3:00 p.m. You can change this default value by updating the event 
trigger values:

1. Select the Alert on Order Shipping event handler on the Workflow Event Handler 
Activation form.

2. Click Event Triggers.

3. Change the Condition, Condition Retest Interval, and Trigger Reset Interval values. By 
default, the trigger fires daily at 3 p.m., sleeps for 23 3/4 hours and then awakens and 
checks each minute until 3 p.m. arrives again.

Assigning Users to Event Global Constants

When a Customer Portal user creates an order using the Consigned Inventory page, the 
notification sent from Customer Portal to SyteLine is handled by a SyteLine event global 
constant. You must add user IDs to this global constant for the users in SyteLine who 
should receive notification from the portal.

1. On the Event Global Constants form, filter the form to show only portal-related global 
constants. For example, specify portal* in the Name field and then click the filter icon.

2. Select the PortalCoCreatedManagerID global constant, and in the Value field, specify 
one or more user IDs for each SyteLine user who should receive notification from the 
portal. Separate user IDs with semi-colons (;) and no spaces.

Enable Viewing of Service Knowledge Base Entries

In order for a service knowledge base entry to be viewed by portal users, it must be set to 
Available to Customers in SyteLine.

1. Open the SyteLine Knowledge Base form.

2. Select the entry to enable for viewing on the portal, or create a new entry.

3. Select Available to Customers.

4. Save the record.
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4Setting Up SyteLine for Online Ordering

This chapter provides steps for setting up online ordering functionality for your customers. 
After this setup is complete, your registered customers will be able to browse your catalog, 
add items to an order, submit orders online, check order status, track shipments, and more.

NOTE: If you have installed the Customer and Reseller portals, these topics apply to both, 
because Reseller Portal includes Customer Portal functionality.

NOTE: For multi-site implementations, the table shows whether to perform each step in the 
Primary Site, all sites, or only desired sites. If your implementation has only one site, 
then that is the Primary Site.

Step Description SyteLine Forms
For Multi-Site, 
Perform In...

1 Set up shipping charges. Freight Charge Methods 

Ship Methods 

Ship Via Codes 

Multi-Lingual Ship Methods 

Ship Method Groups 

Customers 

Multi-Site Customers 

Items 

Multi-Site Items 

All sites

2 Specify portal parameters. Portal Parameters Primary Site

3 Specify items, item categories, and the item 
category hierarchy, if not already completed.

Item Category Workbench Primary Site

4 Specify portal pricing sites for items. Items 

APS Sites and Alternative 
Management

Set the default 
pricing site for items 
in the Primary Site. 
Set pricing options 
in individual sites.

5 Activate prices for portal orders. Portal Pricing Pre-Activation 

Portal Pricing Review 

Portal Pricing Activation 

Perform pre-
activation and 
review from 
individual sites. 
Perform activation 
from the Primary 
Site.

6 Activate currencies for the portals. Currency Codes All sites

7 Define all tax codes in every site of the Customer 
Portal site group. 

Tax Codes All sites
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Before You Start

Before you begin setting up online ordering, read the following overview topics about how it 
works.

Pre-Login Functionality

Visitors to your portal can access some pages without being registered or logged in. They 
can browse your catalog and add items to the cart. Items not yet purchased can remain in 
the cart from prior visits in pre-login mode. The cart is identified by use of a cookie placed 
on the user’s computer. Users can update this cart as needed. At this point, the cart is an 
estimate in SyteLine. 

If the user logs in, the user login ID and the customer number associated with the user is 
updated on the pre-login cart, the cookie is cleared, and the cart is considered a post-login 
cart. If the user returns to the portal in pre-login mode, the cart will be empty. But if they log 
in, the un-placed post-login estimate, identified by their user ID and customer number, will 
be displayed in the cart.

If the user’s browser is not set to accept cookies, any items added to the cart in pre-login 
mode are visible only during the current session, unless the user logs in. Upon login, the 
pre-login cart becomes a post-login cart. 

It is possible for a user to have both a pre-login and a post-login cart. In this case, when the 
user logs in, the pre-login cart is copied to the post-login cart leaving only the post-login 
cart. The user can see their un-placed post-login cart on return visits after logging in.

Estimation of shipping charges is available in pre-login mode, however estimation of taxes 
cannot occur until a user has logged in.

NOTE: SyteLine users can purge older un-placed orders by removing order line items from 
an order one at a time.

Item Pricing

After you set up and activate prices in each site for the portal, each item’s default price is 
displayed on the Products, Product Details, Featured Products, Top Sellers, Contract 
Order, and Place Order pages. 

8 Add customer tax codes, by location, for all sites 
in the Customer Portal site group.

Address Tax Code Defaults All sites

9 Add country codes to province and state records 
(optional).

Prov/States Primary Site

10 Set up credit card processing (optional). See the Infor SyteLine – 
Credit Card Interface 
Implementation Guide

Step Description SyteLine Forms
For Multi-Site, 
Perform In...
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If pricing options exist for an item, that item’s price has an asterisk next to it and a link to 
open the Pricing Options form. Pricing options from the item’s default pricing site and 
based on the quantity ordered are available to all B2C users whether or not they are signed 
in to the portal. These pricing options are also available to B2B users when they are not 
signed in. Once a B2B user logs in to the portal, their pricing options are based instead on 
a customer contract or on an item that is priced out of multiple sites, if applicable. Other 
pricing site rules for B2C and B2B users are described here:

User Registration and Login

B2C users who have not yet registered are required to do so on the Place Order page prior 
to submitting an order. The user is prompted to enter a user name, password, e-mail 
address, shipping information, and billing information. A customer record, customer 
address record, and customer user name record are added in SyteLine. The records are 
created in every site in the Customer Portal site group. Tax codes are added by default, if 
configured. The customer number is added to the order.

B2B users will already have been registered by a SyteLine user.

Both B2C and B2B users must log in prior to submitting an order.

Submitting Orders

Once all desired items are added to an order, users go to the Place Order page to verify 
and edit order details (and register and/or log in, if they haven’t already). B2B users must 
select a payment method. B2C users can pay only by credit card, so they are not prompted 
for a payment method. If you do not provide the credit card interface for your portal, B2C 
users must call you to complete their order.

After all required data has been entered, the estimate order is copied to a customer order in 
SyteLine with a status of “Planned”. This allows taxes to be added. Tax, shipping, and order 
totals are calculated and displayed to the user. The order estimate status is changed to 
“History”.

After the user clicks Submit, the order status is changed to “Ordered”. An order 
confirmation page is displayed and an order verification report is e-mailed to the user.

Order Status and Shipping Confirmation

All users have access to the Order Status page after they are signed in to the portal. On 
this page, they can verify the status of their orders and view order tracking information. 

B2C B2B Rule

X X Sees pricing from item’s default pricing site

X X The order line ship site is set to the default pricing site

X X Can see quantity-on-hand totals for the default pricing site

X Can see quantity-on-hand totals per pricing site

X Can see per site pricing

X Can select item prices from different pricing sites
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Portal users who sign up to receive order shipping alerts (on the Account Management 
page, Profile Information section) are notified by e-mail when all or part of their orders have 
shipped.

Shipping, Invoicing, and Payment Application

Standard SyteLine processing is used for shipping, invoicing, and payment application. For 
credit card payments, the Credit Card Interface is used to apply the payment to related 
invoices.

Setting Up Shipping Charges for Portal Orders

When orders are placed using Customer or Reseller Portal, shipping charges must be 
calculated before the order is submitted, so shoppers know how much they will be charged. 

To set up shipping charges for portal orders, follow these steps in all sites in the Customer 
Portal site group:

1. On the Freight Charge Methods form, create freight charge methods to be associated 
with portal ship methods.

2. On the Ship Methods form, create ship methods for business-to-consumer (B2C) users 
and for business-to-business (B2B) users whose method of payment is Credit Card. Be 
sure to select Active For Customer Portal for each method. Also select International 
if the method can be used for international shipments.

3. On the Ship Via Codes form, select Active For Customer Portal to activate ship via 
codes for B2B users whose method of payment is On Account. Also select International 
if the code(s) can be used for international shipments.

4. Optionally, on the Multi-Lingual Ship Methods form, create multi-lingual ship method 
descriptions. 

5. On the Ship Method Groups form, create ship method groups. 

6. On the Customers or Multi-Site Customers forms, specify a ship method group.

7. Optionally, on the Items or Multi-Site Items form, specify a freight amount that is to be 
charged for portal-enabled items that require special freight charges. This amount 
overrides the default Charge Per Item set on the Freight Charge Methods form. 

For more information about using each of the forms in this task, review the form and field 
online help in SyteLine.
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Specifying Portal Parameters 

In the Primary Site, open the SyteLine Portal Parameters form and specify this 
information:

 Site Group: In the Customer and Reseller Portals section, select the site group 
containing sites that should provided data on the portal.

As noted in “Creating the Customer Portal Site Group (Optional)” on page 52, in order 
for data on the portal Account Balance page to be accurate, this site group must be the 
same as the multi-site group used on the SyteLine Accounts Receivable Parameters 
form. It should be a group in which the customer table is replicated to all sites in the 
group.

 Default Ship Method Group: Specify the default ship method group to be used for new 
Customer Portal users who register online and for all existing Customer or Reseller 
Portal users whose payment method is credit card but who may not yet have a ship 
method group assigned.

 Customer Prefix: In the Primary Site only, specify a default prefix to be used for 
customers added from the Customer Portal, so you can distinguish these customers 
from customers added using SyteLine. If you leave this field blank, the SyteLine 
customer number prefix is used by default. 

 Order Prefix: In the Primary Site only, specify a default prefix to be used for orders 
entered in Customer Portal, so you can distinguish them from orders added in SyteLine. 
If you leave this field blank, the SyteLine order number prefix is used by default.

 Phone: If B2C users log in to the Customer Portal to place orders, but the Credit Card 
Interface is not installed or is not active, a message is displayed instructing them to 
contact the vendor. In this field, specify the phone number to be included in that 
message. If this field is left blank, the phone number specified on the General 
Parameters form for the portal Primary Site is used in the message. 

 Validate Portal Address: Select this check box to require that portal users’ state and 
country entries for shipping information are validated against the state/country 
combinations specified on the SyteLine Prov/State form. 

When this check box is selected, a user must specify a state and country that are 
included in the drop-down lists presented to them. If the check box is cleared, a 
customer can specify any state and country name, whether or not they are in the lists. 

 Enable Category Browsing: When this check box is selected, a category menu with a 
slide-out subcategory menu is included on the Products page for simplified catalog 
browsing. Two levels of subcategories can be displayed in the slide-out menu. When 
cleared, the categories menu is not displayed, and portal users must enter search 
criteria to find specific items in the catalog. 
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Specifying Items, Item Categories, and the Item Category 
Hierarchy

All portal-enabled items (items that are set to Active For Customer Portal), item 
categories, and the item category hierarchy must be entered in the Primary Site, even if the 
item is not manufactured in, shipped from, or priced from that site. Steps for adding item 
and category information are provided in “Setting Up Items and Categories” on page 53.

Specifying Portal Pricing Sites

A new field in the item table, Portal Pricing Site, is used to indicate the site from which 
each item’s pricing and customer contract pricing is to be retrieved by default. This field 
must be maintained in the Primary Site item table for all portal-enabled items. Item prices 
can be included from sites other than this Portal Pricing Site, however, by default the portal 
retrieves an item’s price from the site identified in this field. In the Primary Site, open the 
Items form and specify the Portal Pricing Site for each item that is active for the portals.

Item pricing from additional sites also can be shown on the portal for selected items, which 
gives customers pricing options. In each site from which to display a different price for the 
item, open the Items form and select Portal Pricing Enabled. 

In order for expected ship dates to be calculated for portal users, you must also add to 
multi-site APS all sites within the Customer Portal site group that have portal-pricing-
enabled items. In the Primary Site, open the APS Sites and Alternative Management 
form and add all applicable sites.

Activating Prices for the Portals

Prices must be pre-activated, by site, for each site included in the Customer Portal site 
group. These proposed prices can be reviewed and updated, and when they are final, they 
must be activated from the Primary Site for use on the Customer and Reseller portals. 
Depending on your business processes, a different person may perform pre-activation for 
each site in your Customer Portal site group; however, price activation should be controlled 
by one person who logs in to SyteLine for the Primary Site. 

1. Log in to a site in the Customer Portal site group.

2. Make sure Active For Customer Portal is selected on the Items or Multi-Site Items 
form and Currency Codes form for each item and currency that should be available on 
the Customer Portal.

3. Open the Portal Pricing Pre-Activation form and specify a starting and ending item 
number for which to activate prices. 

NOTE: The first time you activate prices, you may prefer to leave the Starting Item and 
Ending Item fields blank, so prices are created for all items. Later, if you change 
pricing for a particular set of items, you can specify just that range of item numbers.
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4. Click Process. A message is displayed indicating how many portal prices were created 
and if any errors were detected during the process. 

5. Open the Portal Pricing Review form to review the pricing records and error messages 
if any problems occurred. It is recommended, but not required, that errors be corrected 
during pre-activation. Possible errors are described here:

6. If you had errors, you should run the Portal Pricing Pre-Activation utility again. Repeat 
until no more corrections are needed. 

7. When prices are ready for use on the Customer Portal, communicate to the person who 
activates prices that your site prices are ready. If you are that person, continue with the 
next step. 

8. Log in to the portal Primary Site and open the Portal Pricing Activation form. 

9. Do one of the following: 

 To activate prices for all sites at once, leave the Site field blank. 

 To activate prices for one site, select that site in the Site field.

10. Activation is prevented if any price configuration errors occur, so it is best to run the 
process in Preview mode first. Select Preview and then click Process. 

Errors are displayed in the grid and can include:

 Pricing is not enabled for default pricing site. This means the Portal Pricing 
Enabled field on the Items form has not been selected for the item in its default 
pricing site.

Error Message What To Do

Please review the tax in 
price errors found for (item 
number).

Check to make sure the Include Tax In Price field on the Customers 
form for a specific customer matches the Include Tax In Price field on 
the Customer Contract Prices form for that same customer and a 
specific item. Both must be selected or cleared.

Unable to determine List 
Price for (item number).

Evaluate the item and its price on the Item Pricing form. If there is no 
price for the item, create one, and then try running Portal Pricing Pre-
Activation again. If the error remains, it is most likely a software error, 
and you will need to contact us for help. 

Unable to determine 
Customer Price for (item 
number).

Verify the item on the Items form, the customer record on the 
Customers form, and that all needed conversion records exist on the 
Unit of Measure Conversions form between the customer's unit of 
measure for the item and the base unit of measure for the item.

Unable to determine Break 
Quantity and Break Prices 
for (item number).

Verify the break quantity pricing on the Item Pricing, Price Formulas, 
and Customer Contract Pricing forms for the given item.

List Price for (item number) 
could not be converted to 
customer currency.

Verify that valid rates exist on the Currency Rates form for all 
supported portal currencies and for the base currency of the current 
site.

Customer Price for (item 
number) could not be 
converted to base currency.

Verify that valid rates exist on the Currency Rates form for all 
supported portal currencies and for the base currency of the current 
site.
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 Default pricing is not defined. This means the Portal Pricing Site field on the Items 
form has not been selected for the item in the Primary Site. All items that are active 
for the Customer Portal must have a default pricing site.

11. Correct any errors found and run the preview again until no more corrections are 
needed. 

12. When prices are ready for activation, select Commit and then click Process. 

Prices are activated for use on Customer Portal and their status is changed from N 
(Next) to C (Current) on the Portal Pricing Review form. 

Activating Currencies

Open the Currency Codes form and select Active For Customer Portal for each 
currency that is supported on the portal.

For multi-site implementations, you must select this setting for the same supported 
currencies in all sites of the Customer Portal site group.

The domestic currency, which is the currency code specified on the General Parameters 
form, must be marked as active for Customer Portal in all sites as well.

Defining Tax Codes

Use the SyteLine Tax Codes form to define all tax codes in every site of the Customer 
Portal site group. For example, tax code OH must exist in every site in the Customer Portal 
site group and refer to the same taxing entity.

Adding Customer Tax Codes

Tax code defaults based on the customer’s ship-to address are used for Customer Portal 
orders. The codes must be set up using the Address Tax Code Defaults form in SyteLine. 
You can enter tax codes all at once or as needed to do business with customers in different 
locations. At least one address tax code for each country to which a sale or purchase can 
occur should be created for each site in the Customer Portal site group.

If someone registers online to use the Customer Portal, but a tax code is not available in 
SyteLine for their shipping address, their orders are automatically placed on hold. A Ship 
Hold field is selected automatically on the Customer Ship-Tos form for each ship-to 
record and on the Customer Orders form for all new orders created for that customer. This 
prevents orders from being shipped until the check box is manually cleared. An alert is 
published for subscribers to TaxCodeEvaluationAlert. When you receive the alert, you must 
enter a tax code for the customer on the Address Tax Code Defaults form and clear the 
Ship Hold check box in SyteLine.

For more information, review the form and field online help in SyteLine.
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Adding Country Codes to Province and State Records (Optional)

If you have set the portal parameter to Validate Portal Address, then you must add a 
country code for each province and state record in SyteLine. In the Primary Site, open the 
Prov/States form and specify codes in the Country field. 

Setting Up Credit Card Processing (Optional)

In order for your customers to pay for online orders using a credit card, you must complete 
the following tasks. More information about these tasks is provided in the Infor SyteLine - 
Credit Card Interface Implementation Guide.

 Install the Infor SyteLine Credit Card Interface (CCI) add-on product.

 Install the CCI gateway software. Currently, CCI supports two gateway providers: 
TGATE and Intrix.

 Configure the CCI parameters in SyteLine to connect to the gateway. 

 Establish a relationship with a credit card processor. 

 Test credit card authorizations. 

If you do not provide for credit card orders, your customers must call in to complete a 
Customer Portal order.

When customers do pay by credit card using the Customer Portal, a Paid By Credit Card 
field on the Customer Orders form is selected automatically for their orders. Also on this 
form and the Estimates form, the Portal Order field is selected automatically for any order 
or estimate received from the Customer Portal.
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5Setting Up SyteLine for the Reseller 
Portal

This chapter provides steps for setting up SyteLine for use with the Reseller Portal. 

NOTE: The Reseller Portal provides Web pages and functionality for your customers who 
are set up as resellers in SyteLine. This portal includes all of the pages from the 
Customer Portal, which the reseller can use as your customer or for reseller tasks. 
Therefore, the setup tasks required here are in addition to setup tasks performed for 
Customer Portal. 

NOTE: For multi-site implementations, the table shows whether to perform each step in the 
Primary Site, all sites, or only desired sites. If your implementation has only one site, 
then that is the Primary Site.

Step Description SyteLine Forms
For Multi-Site, 
Perform In...

1 Set up reseller records. Vendors

Salespersons

Commission Table Maintenance

Customers or Multi-Site Customers

Customer Ship-Tos or Multi-Site Customer 
Ship-Tos

Partners

All sites

2 Add portal-enabled user accounts. See Chapter 7, “Setting Up and Managing 
SyteLine User Accounts for the Portal(s)”

All sites

3 Add customers for the reseller. Customers

Customer Ship-Tos

All sites

4 Associate existing customers with a 
reseller.

Customer Ship-Tos All sites

5 Set up SyteLine Service portal 
parameters.

Service Parameters All sites

6 Set up event notifications. Workflow Event Handler Activation All sites
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Setting Up Resellers

In SyteLine, resellers are SyteLine customers that are also distributors. To make a 
SyteLine customer a reseller, the customer must be set up as the following: 

 A Vendor, to get paid for commissions earned when the reseller’s customers place 
orders.

 A Salesperson, to associate other existing SyteLine customers that belong to this 
reseller.

 A Customer Portal and Reseller Portal user, to log in to the Customer and/or Reseller 
portals.

 A SyteLine Service Partner, to submit and get paid for service request order (SRO) 
transactions from the portal.

Follow these steps:

1. In the Customer Portal site group’s Primary Site, which may be your only site, complete 
these tasks to create the reseller:

a. On the Vendors form, select an existing vendor record or create a record to 
represent this reseller. The reseller’s commission checks will be sent to the header 
address, or remit-to address if one exists, on this form.

b. On the Salespersons form, create a Salesperson record for this reseller. Select 
Outside and Portal Reseller, and specify the Ref Num of the vendor record from 
step 1.

c. On the Commission Table Maintenance form, specify the commission percentage 
for the reseller’s salesperson ID. You must enter an asterisk (*) in the Product Code 
field, so the commission percentage is the same for all product codes. Enter the 
percentage in only the first Commission field.

2. On the Customers or Multi-Site Customers form, create a customer record for this 
reseller. In the Reseller’s Salesperson field, specify the salesperson ID from step 1b. 
For multi-site implementations, this must be completed in every site of the Customer 
Portal site group, using the same customer number in each site.

3. Optionally, on the Customer Ship-Tos or Multi-Site Customer Ship-Tos form, select 
the customer record from step 2 and in the Salesperson field, specify the same 
salesperson ID. This allows the reseller to receive commissions for his or her own 
purchases. For multi-site implementations, this must be completed in every site of the 
Customer Portal site group, using the same salesperson ID in each site.

4. On the SyteLine Service Partners form, set up the reseller as a partner and be sure to 
specify this information:

 Type: Select Customer.

 Ref Num: Select the reseller’s customer number from step 2. 

 Active: Select this option to make the record active.

 Default Payment Type: Specify the default payment type to use when the reseller 
enters a new SRO Miscellaneous transaction on the portal.
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 User: If the partner needs to be associated with a specific SyteLine user account, 
select the user ID. Once the user ID is specified, then SRO transactions against this 
partner ID can be submitted from the portal by only this user account. No other 
SyteLine user account can submit SRO transactions against this partner, even if the 
user is associated with the reseller. If a partner record needs to be shared by 
multiple SyteLine user accounts, leave the User field blank so any SyteLine user 
associated with the reseller can submit SRO transactions against this partner. 

 Reimburse Material: Select this option so the reseller can be reimbursed for SRO 
material transactions.

 Reimburse Labor: Select this option so the reseller can be reimbursed for SRO 
labor transactions. 

NOTE: For resellers in a multi-site implementation, a Customer, Salesperson, Commission, 
and Vendor record must exist in each site of the Customer Portal site group and they 
must be kept in sync with each other between sites. The Reseller’s Salesperson must 
reference the same Salesperson. The Salesperson must reference the same Vendor. 
The Commission record must have the correct commission percentage for the 
Salesperson. 

The User Account Management Utility helps to put these tables in sync; however, the 
utility does not create customer records. All customer records must be created manually 
in SyteLine. The utility can create the Salesperson, Commission, and Vendor records 
when missing in sites where the customer record of the reseller exists. See “About the 
User Account Management Utility” on page 102.

Adding SyteLine User Accounts for Resellers

Although Reseller Portal users never see SyteLine forms, they do access SyteLine data 
through IDOs and so they must have a user account in SyteLine, with the appropriate 
licensing and permissions. The portal user logs in through SharePoint using this SyteLine 
user name and password.

Tasks for adding SyteLine user accounts are provided in Chapter 7, “Setting Up and 
Managing SyteLine User Accounts for the Portal(s)”. 
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Adding Customers for a Reseller

After a reseller has been set up correctly in all sites of the Customer Portal site group, new 
customers for that reseller can be added in these ways:

 You can create a Customer record and all of the customer’s Ship-To records in the 
Customer Portal Primary Site using SyteLine. Set the Salesperson on each Ship-To 
record to the salesperson that represents the reseller (this is the Reseller’s 
Salesperson on the reseller’s Customer record). 

Next, create the SyteLine user account and associate it to the new Customer 
record.This can be done manually or using the portal User Account Management Utility. 
See Chapter 7, “Setting Up and Managing SyteLine User Accounts for the Portal(s)”. If 
done manually, you will need to create these records in every site in the Customer Portal 
site group.

 The reseller can provide his or her portal redirect link to a potential customer, and that 
customer can go to the Customer Portal and register for an account. For more 
information, see “Customers” on page 153. Also, the reseller can use the Reseller Portal 
to register new customers.

In these cases, no additional SyteLine user setup is needed. The Customer, Customer 
Address, Customer Username, User, User E-mail, and User Group records are created 
automatically in every site in the Customer Portal site group. An alert is published for 
SyteLine and Reseller Portal subscribers to the NewCustomerCreatedAlert to let them 
know a customer record has been created.

Associating Existing Customers to a Reseller

To assign a reseller to an existing customer account:

On the Customer Ship-Tos form, select the existing customer and then set the 
Salesperson field to the salesperson that represents the reseller (this is the Reseller’s 
Salesperson on the reseller’s Customer record). Do this for each of the customer’s Ship-
To records across all sites in the Customer Portal site group.

Next, create the SyteLine user account and associate it to the existing Customer 
record.This can be done manually or using the portal User Account Management Utility. 
See Chapter 7, “Setting Up and Managing SyteLine User Accounts for the Portal(s)”. If 
done manually, you will need to create these records in every site in the Customer Portal 
site group.
Infor SyteLine Portals Setup and Administration Guide 
Copyright © 2014 Infor 



Setting Up SyteLine for the Reseller Portal         83
Setting Up SyteLine Service Portal Parameters

In addition to entering partner default settings in SyteLine Service, you must also specify 
service parameter defaults. On the SyteLine Service Service Parameters form, Portal tab, 
specify this information:

 Default SSR: The service support representative to be used by default for incidents 
created on the portal.

 Default Status Code: The status to be used by default for incidents created on the 
portal.

 Default Owner: The owner to be used by default for incidents created on the portal.

Also indicate if resellers should be allowed to set incident priority when submitting an 
incident from the portal.

Refer to form and field online help for more information.

Setting Up Reseller Event Notifications

In addition to the event notifications described in “Setting Up Customer Event Notifications” 
on page 64, these event notifications must be set up for the Reseller Portal:

For user to get notification of:
Activate this workflow 
event handler in all sites:

Subscribe user to this publication 
in all sites:

Subscription can be 
set for:

New customers created on the 
portal

N/A NewCustomerCreatedAlert* SyteLine users and 
Reseller Portal users

Orders placed on the portal N/A PortalOrderReceivedAlert* SyteLine users and 
Reseller Portal users

Portal orders placed with request 
date before due date

N/A PortalOrderRequestDateBeforeDue
DateAlert

SyteLine users

SRO labor transactions entered 
on the portal

Notify Portal SRO Labor 
Transaction Created

PortalSROLaborTransactionAlert SyteLine users**

SRO material transactions 
entered on the portal

Notify Portal SRO Matl 
Transaction Created

PortalSROMatlTransactionAlert SyteLine users**

SRO miscellaneous transactions 
entered on the portal

Notify Portal SRO Misc 
Transaction Created

PortalSROMiscTransactionAlert SyteLine users**

* If a reseller wants to receive e-mails for these alerts, the reseller users should be subscribed to this publication with Key Value set 
to their salesperson ID (for example, Key Value = JAR). When any customer with slsman = JAR is registered or places an order in 
the portal, the reseller is notified by e-mail. SyteLine users who want to receive these alerts should subscribe with Key Value set to 
Null, so they get e-mail when any customer is created or order is placed from the portal. 
** Portal users do not have to be subscribed to alerts for these events. They receive e-mail confirmation if Send External 
Notifications is set and an e-mail address is provided on the Users form.
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6Setting Up SyteLine for the Vendor Portal

This chapter provides steps for setting up SyteLine for use with the Vendor Portal. 

NOTE: For multi-site implementations, the table shows whether to perform each step in the 
Primary Site, all sites, or only desired sites. If your implementation has only one site, 
then that is the Primary Site.

Step Description SyteLine Forms
For Multi-Site, 
Perform In...

1 Create a site group for the Vendor Portal (optional). Site Groups Primary Site

2 Specify portal parameters. Portal Parameters Primary Site

3 Set up SyteLine to manage consigned inventory 
(optional).

Warehouses

Item/Warehouse

All sites

4 Set up documents. Groups

Document Types

Attached Documents

All sites

5 Set up item price requests. Items

Item Categories or Vendors

All sites

6 Set up planned orders. Purchasing Parameters

Vendor Contracts

Vendors

Multi-Site Vendors

Report Options

All sites

7 Add interaction topics. Interaction Topics All sites

8 Set up information about the vendor’s company. Vendors

Vendor Contracts

All sites

9 Set up contact information for your company. General Parameters

Vendors

All sites

10 Add portal-enabled user accounts. See Chapter 7, “Setting Up 
and Managing SyteLine User 
Accounts for the Portal(s)”

All sites

11 Set up a default bank code. Accounts Payable 
Parameters

All sites

12 Maintain ISO unit of measure codes. Unit of Measure Codes All sites

13 Set up event notifications. Workflow Event Handler 
Activation

Publication Subscriptions

All sites

14 Assign user to portal-related event global constants. Event Global Constants All sites
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Creating the Vendor Portal Site Group (Optional)

If you have an existing site group on the Site Groups form in SyteLine, which contains all 
sites specified for your PortalSiteGroup during data source configuration, then you do not 
need to create a Vendor Portal site group. You will simply select the existing site group 
when defining portal parameters in the next task.

If your PortalSiteGroup data source contains sites other than those in an existing site 
group, you must create a new site group for the Vendor Portal. 

If you have only one site that is exposed to the Vendor Portal and for which a site group 
does not exist, you still must create the Vendor Portal site group and assign that site.

Specifying Portal Parameters for Vendor Portal

In the Primary Site in the Vendor Portal site group, open the SyteLine Portal Parameters 
form and select the site group containing sites that should provided data on the Vendor 
Portal.

Setting Up Consigned Inventory (Optional)

SyteLine can track and process inventory consigned by a vendor, and the vendor can use 
the portal to review consigned inventory levels and evaluate past consumption. 

If you get consigned inventory from vendors, you should set up the consignment 
warehouse and upper and lower boundaries for managing inventory replenishment in the 
consignment warehouse.

1. On the Warehouses form, select the warehouse to be used for inventory consigned 
from the vendor, set the consignment type to Vendor, and specify the vendor and the 
location from which consignment inventory will be consumed. 

2. On the Item/Warehouse form, set the minimum and maximum consignment quantity for 
items in the consignment warehouse. These values are displayed on the portal’s 
Consigned Inventory page. Alerts can be sent to portal subscribers when consignment 
quantity goes below the minimum or above the maximum requirement.
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Setting Up Documents

The portal Documents function is used to provide controlled access to documents that are 
attached to specific records in SyteLine. Documents can be attached to purchase order 
and product price contract records and viewed on the portal by users associated with those 
records. Documents can be added for the portal by a SyteLine user or they can be 
uploaded by a portal user and then approved in SyteLine.

In order for portal users to access documents using the Vendor Portal, you must perform 
the tasks in this section in all applicable sites in SyteLine.

Verify Group Requirements

These requirements can be verified using the SyteLine Groups form:

 SyteLine users who will work with documents must belong to the Standard Forms group, 
which gives them access to these forms:

 Attached Documents

 Documents

 Document Objects Query

 SyteLine users must belong to groups that give them access to appropriate forms 
related to the documents used on the portal. For example, if SyteLine users are in a 
group that allows them to access the Purchase Orders form, then they will be able to 
add order documents in SyteLine and view and approve documents uploaded via the 
portal Purchase Orders page.

 Vendor Portal users must belong to the Vendor Portal group, which is assigned during 
user account creation.

Create Document Categories

Use the Document Types form to create categories for the documents that can be 
attached to records, and also to assign groups to each document type, based on who 
should be able to access documents in the category. 

The name you give a document type should be meaningful to portal users, because they 
must select the type when uploading a document. For example, you might want to have 
Word documents (*.doc) attached to POs. You can use the Document Types form to 
create a document type called "PO Docs" and associate the File Extension "doc" and 
Media Type "application/msword" with that type. This document type would then be used 
when attaching files to POs in SyteLine or on the portal.

NOTE: You must provide a default extension for each document type, but documents with 
other extensions can be uploaded and downloaded for the category. For example, if 
you specify "txt" as the default extension, portal users can still upload a .pdf or .doc file 
for the category.

When you assign the Vendor Portal group to this document type, you make documents in 
this category available to Vendor Portal users. If you also assign the Purchasing group to 
this document type, you make documents in this category available to users in the SyteLine 
Purchasing group. See “Additional Portal Document Guidelines” on page 88.
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Add Documents for Downloading

To add documents in SyteLine that can be downloaded on the portal:

1. Open the form that contains a collection for which to attach a document for downloading, 
such as Purchase Orders or Vendor Contracts. 

2. Select the record to which to attach a document and then select Actions > Documents 
for Current. This opens the Attached Documents form so you can attach the 
document. 

Specify the required information and then import the document. Do not select Internal, 
because then the document cannot be shared on the portal. Make sure to specify the 
Document Type. When you specify the Document Type, the groups assigned to this 
category are displayed in Shared Groups.

3. Save the record.

NOTE: Portal users must be subscribed to the VendorDocumentUploadAlert publication to 
receive notifications when documents are added for them in SyteLine. They can 
subscribe themselves using a setting on the portal My Profile page, or you can 
subscribe them in SyteLine. See “Setting Up Vendor Event Notifications” on page 93.

Approve Uploaded Documents

When a document is uploaded on the portal, its status must be changed from Pending to 
Approved in SyteLine, so it is accessible on the portal. This is an ongoing administrative 
task. See “Approving Uploaded Documents” on page 125.

Additional Portal Document Guidelines

Following are additional notes about documents and document types:

 Any document that is to be viewable on the Vendor Portal must be associated with the 
Vendor Portal group. As described above, this is accomplished by assigning the Vendor 
Portal group to the document type and then assigning the document type to the 
document.

 At least one document type must be associated with the Vendor Portal group, or no 
documents will be visible and no document can be uploaded via the portal. 

 Document types must allow for shared groups to be included in the collection of groups. 
For example, a purchase order document that is to be shared across the Vendor Portal 
requires that, in addition to the Vendor Portal group, the group maintaining the PO in 
SyteLine is assigned to the document type. The Vendor Portal group permissions would 
not allow a vendor to update or delete the document, but due to its document type 
(category), the vendor would be able to view the document.

 When adding a document, users cannot use a document type for which they are 
excluded from the group collection. The user must have insert permissions on a shared 
group.

 You can use the Document Group Management form to see documents associated by 
group and document type. This form displays only documents associated with the 
Customer Portal group or the Vendor Portal group, and it shows all the documents that 
customers or vendors can view on the portals.
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 For multi-site implementations, on the Document Upload form that vendors use to 
upload a document from the portal, the Upload Site field displays the site to which the 
document will be uploaded. The site is based on the document object, which is 
determined by the page from which the user uploads a document:

 From the Purchase Orders page header or line item, the document is uploaded to 
the site where the PO was created.

 From the Product Price Contracts page, the document is uploaded to the site where 
the contract was created.

Viewing Documents on the Portal

The portal Documents page displays documents associated with vendor records. Only 
documents for the logged-in vendor are visible. 

To view documents about other POs or pricing contracts, portal users must click the 
Documents icon displayed with an individual record on the related portal pages.

Setting Up Item Price Requests

To set up item price request functionality, you must add items to item categories using the 
SyteLine Items form and then associate vendors with the item categories using the 
SyteLine Item Categories form or Vendors form. This should be done in all sites in the 
Vendor Portal site group.

With this information set, users can enter an item price request using the SyteLine Item 
Price Requests form, or create the request from an existing planned order or PO 
requisition line.

When an item price request is made, only vendors tied to the same category or categories 
with which that item is associated will see the request on the portal.

Setting Up Planned Orders

On the Vendor Portal Planned Orders page, vendors can review planned orders generated 
during your latest planner run for the items they supply. 

You can also allow them to confirm planned orders online, which converts them to 
purchase orders or purchase order requisitions in your system. 

To set up this functionality:

1. On the SyteLine Purchasing Parameters form, specify a vendor-created PO and/or PO 
requisition prefix. These prefixes are used when a vendor creates a purchase order or 
purchase order requisition by firming a planned order using Vendor Portal.

2. Set the Allow to Firm PLNs option in SyteLine:

 Use the SyteLine Vendors or Multi-Site Vendors form to set this option by vendor. 
This allows the vendor to firm planned orders for all of their contracted items 
displayed on the portal.
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 Use the SyteLine Vendor Contracts form to set this option by item. This allows the 
vendor to firm planned orders for only the items you specify. 

3. After selecting the Allow to Firm PLNs option for the vendor or item, on the same form, 
specify this information:

 Firm PLN Target: Indicate whether planned orders should be firmed to purchase 
order requisition lines or purchase order lines. 

 Firmed PO Line Status: If you selected PO lines as the target, indicate whether the 
created PO line should be set to a status of “Planned” or “Ordered”.

 Replenishment PO: Optionally, you can select a replenishment PO, so that any 
firmed planned orders are attached to this replenishment PO. If you specify a 
replenishment PO at the vendor and/or item level, the planned order firming process 
may not use it if the pending planned order count would push the PO line numbers 
to exceed the limit for that PO. In this case, a new PO is created, and it uses the 
vendor-created PO prefix defined on the SyteLine Purchasing Parameters form.

4. In order for portal users to receive PO and PO requisition reports as attachments, a 
record for the portal user must be added to the Report Options form, with these fields 
specified and all other fields blank:

 User: The SyteLine user ID assigned to the portal user.

 Output Format: Acrobat Format

 E-mail Notification: Yes

 Attach Report: Yes

 Auto-View: No

You can add these records manually in SyteLine, or a record will be added automatically 
the first time a portal user confirms a planned order.

Adding Interaction Topics

Portal users can create interactions to send you about various records on the portal, and to 
do so, they must select a predefined topic. You must add these topics using the SyteLine 
Interaction Topics form.

When defining interaction topics for a multi-site implementation, the same topics should be 
defined in each site of the Vendor Portal site group. Also, the topics should be translated to 
the same languages in each site. For more information, see “Creating the Vendor Portal 
Site Group (Optional)” on page 86 and refer to the Multi-Site Planning Guide.
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Setting Up Information about the Vendor’s Company

The Vendor Portal user is an employee of your vendor’s company. You must have some 
basic information about the vendor’s company set up in SyteLine before the vendor user 
logs into your portal for the first time. This information is displayed on the My Company 
Profile page. The portal user can submit updates to some, but not all, of the information on 
the profile page.

Set Up a Vendor Record

On the Vendors form, make sure this information, which is displayed on the portal, is set 
up:

 Company Name

 Internet URL

 Language

 Currency

 FOB (free on board location)

 LCR (letter of credit required or not)

 Address (including County and Country)

 Remit To Address

 Vendor Contact Name, Phone, Fax, External E-mail and Internal E-mail

Set Up Vendor Items and Pricing (Optional)

If your vendor refers to your items with a different item number, you can cross-reference 
their item numbers to your items on the Vendor Contracts form. Then, when users from 
that vendor company log into the portal, they can view or look up their item numbers. 

Any special or contract pricing related to the vendor for specific items, as specified on the 
Vendor Contracts form, is displayed on the portal instead of the standard pricing for that 
item.

Setting Up Contact Information for Your Company

In order to support the Contact Us page of the portals, you must set up these areas in 
SyteLine.

Specify Company Address, Phone and E-Mail

On the General Parameters form, specify company contact information on the Address 
tab. All of this information except the site and the e-mail address is displayed on the 
Contact Us page of the portals.

The e-mail address you specify on the General Parameters form is used when vendors 
submit a question or comment from the Contact Us page. If no e-mail address is specified 
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on the General Parameters form, then the Send Questions or Comments button is not 
displayed on the portal.

Specify a Buyer 

When vendors log into the portal, the Contact Us page lists the name and e-mail address 
for the buyer who is assigned to that vendor.

On the Vendors form, specify the SyteLine user who is normally the buyer for each Vendor 
Portal user.

Adding Vendor Portal User Accounts

Although Vendor Portal users never see SyteLine forms, they do access SyteLine data 
through IDOs and so they must have a user account in SyteLine, with the appropriate 
licensing and permissions. The portal user logs in through SharePoint using this SyteLine 
user name and password. Tasks for adding user accounts are provided in Chapter 7, 
“Setting Up and Managing SyteLine User Accounts for the Portal(s)”. 

After adding user accounts, you can complete the remaining tasks in this chapter.

Setting Up a Default Bank Code

New vendor records added to SyteLine from the portals use the bank code specified on the 
SyteLine Accounts Payable Parameters form, so you must ensure that a default bank 
code is set on that form. Vendor records are created in SyteLine in these cases:

 When a portal administrator is logged in to the Vendor Portal and running the User 
Account Management Utility to copy vendor portal user accounts from the Primary Site 
to other sites.

 When a portal administrator is logged in to the Reseller Portal and running the User 
Account Management Utility to copy a reseller account from the Primary Site to other 
sites.

 When a portal administrator is logged in to the Customer Portal and running the User 
Account Management Utility to copy a reseller’s customer user account from the 
Primary Site to other sites.

Setting Up ISO Unit of Measure Codes

In order for item units of measure to be displayed on portal pages, you must maintain ISO 
unit of measure codes on the SyteLine Unit of Measure Codes form. See the online help 
for “Unit of Measure Codes” for information about how to do this.
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Setting Up Vendor Event Notifications

Most of the notifications, confirmations, and requests sent back and forth between the 
Vendor Portal and SyteLine are handled by the SyteLine Application Event System. Some 
events use workflow event handlers and require subscription to a publication. Other events 
fire automatically based on a trigger in the system. In order to fully use the event system, 
you must activate the necessary workflow event handlers and subscribe users to 
appropriate publications, as described in the following topics.

Activate Workflow Event Handlers

Default versions of the event handlers, with predefined subject lines and messages, are 
already set up and can be used as-is. You must activate the appropriate handlers in all 
sites. 

1. On the Workflow Event Handler Activation form, filter the form to show only event 
handlers where the Application field is set to SyteLine Vendor Portal. Currently, these 
event handlers are available:

 Alert on Item Price Request Creation

 Alert on Item Price Response Creation

 Alert SyteLine Users of Vendor Interaction

 Alert Users of a New Vendor Document

 Alert Users of a New Vendor Portal Document

 Alert Vendor Portal Users of New Interaction

 Alert When Price Response is Accepted

 Approve Vendor Portal Address Change

 Approve Vendor Portal Company General Change

 Approve Vendor Portal Contact Change

 Notify Portal Contract Price Created

 Notify Portal Contract Price Rejected

 Notify Portal PO Requisition Line Approval/Rejection

 Notify Vendor Portal PO Line Promise Date Change

2. For each of these event handlers, select the Active for This Site check box.

3. Optionally, you can also choose to customize the information that is sent in the 
notifications. Refer to the SyteLine online help about workflow event handlers.

Subscribe Users to Portal-Related Publications

In order for users to receive notifications for various portal events, they must be subscribed 
to the appropriate publications in all sites. These predefined Vendor Portal publications can 
send notifications to subscribed users:

 ItemPriceRequestAlert

 ItemPriceResponseAlert

 ItemPriceResponseAcceptedAlert
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 SLVendorInteractionAlert

 VendorDocumentUploadAlert

 VPConsignedInvConsumptionAlert

 VPConsignedInvLevelAlert

 VPCustomerInteractionAlert

Use the Publication Subscribers form to subscribe appropriate SyteLine or portal users 
to publications. Refer to the summary on the next page for more information.

NOTE: On the portal My Profile page, all portal users can select check boxes to subscribe 
to the VPConsignedInvConsumptionAlert, VPConsignedInvLevelAlert, 
VendorDocumentUploadAlert, VPCustomerInteractionAlert, and/or 
ItemPriceRequestAlert publications. When a portal user selects a check box on the 
Account Management page, that user is automatically added to the Publication 
Subscribers form as a subscriber to the publication in all relevant sites. No setup is 
needed on your part. If a portal user clears a check box on the Account Management 
page, that user is removed from the Publication Subscribers form. 
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Summary of Event Setup

For user to get notification of:
Activate this workflow 
event handler in all sites:

Subscribe user to this publication in 
all sites:

Subscription can 
be set for:

New item price requests Alert on Item Price 
Request Creation

ItemPriceRequestAlert Portal users*

New item price responses Alert on Item Price 
Response Creation

ItemPriceResponseAlert SyteLine users

Acceptance of item price 
responses

Alert When Price 
Response is Accepted

ItemPriceResponseAcceptedAlert Portal users

Interactions from the customer Alert Vendor Portal Users 
of New Interaction

VPCustomernteractionAlert Portal users*

Interactions from portal users Alert SyteLine Users of 
Vendor Interaction

SLVendorInteractionAlert SyteLine users

New vendor documents added in 
SyteLine

Alert Users of a New 
Vendor Document

VendorDocumentUploadAlert SyteLine and portal 
users*

New vendor documents added on 
the portal

Alert Users of a New 
Vendor Portal Document

VendorDocumentUploadAlert SyteLine users

Address change requests from 
the portal

Approve Vendor Portal 
Address Change

N/A** N/A

General information change 
requests from the portal

Approve Vendor Portal 
Company General Change

N/A** N/A

Contact change requests from the 
portal

Approve Vendor Portal 
Contact Change

N/A** N/A

Contract price requests from the 
portal. Also notifies portal users 
when their request is received.

Notify Portal Contract Price 
Created

N/A*** N/A

Rejected (deleted) contract price 
requests

Notify Portal Contract Price 
Rejected

N/A*** N/A

Approved or rejected PO 
requisition lines

Notify Portal PO 
Requisition Line 
Approval/Rejection

N/A*** N/A

Changes to PO line promise 
dates on the portal. Also notifies 
portal users when their change 
request is received and whether it 
is approved or rejected.

Notify Vendor Portal PO 
Line Promise Date Change

N/A*** N/A

Quantity on hand of a vendor 
consigned item has been reduced 
through consumption or return

N/A† VPConsignedInvConsumptionAlert Portal users*

Consigned inventory has gone 
above or below the limit

N/A† VPConsignedInvLevelAlert Portal users*

* Portal users can subscribe or unsubscribe using a check box on the portal Account Management page.
** No publication is associated with these event handlers. Stored procedures and/or global constants are used to send messages 
for some event handlers. Also, these event handlers prompt for a Yes/No response to approve the change. Based on the 
response, an approval or rejection notification is sent to portal users if Send External Notifications is set for them and an e-mail 
address is provided on the Users form.
*** No publication is associated with these event handlers. Notification is sent to portal users if Send External Notifications is set 
for them and an e-mail address is provided on the Users form.
† No event handler is associated with these publications. Stored procedures and/or global constants are used to send messages 
for some publications.
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Assigning Users to Event Global Constants

Several notifications sent from Vendor Portal to SyteLine are handled by SyteLine event 
global constants. You must add user IDs to these global constants for the users in SyteLine 
who should receive notifications from the portal.

1. On the Event Global Constants form, filter the form to show only portal-related global 
constants. For example, specify portal* in the Name field and then click the filter icon.

2. For each global constant, specify one or more user IDs in the Value field for each 
SyteLine user who should receive notifications from the portal. Separate user IDs with 
semi-colons (;) and no spaces.

These are the Vendor Portal global constants and the notifications they control:

 PortalPOLineCreatedManagerID: Sends notification to SyteLine users when a PO 
line is created using the Planned Orders page in Vendor Portal.

 PortalPOLinePromiseDateChanged: Sends notification to SyteLine users when a 
PO line promise date is changed using the Purchase Orders page in Vendor Portal.

 PortalPORequisitionCreatedManagerID: Sends notification to SyteLine users when 
a PO requisition is created using the Planned Orders page in Vendor Portal.

 PortalVendorContractPriceCreatedManagerID: Sends notification to SyteLine users 
when a price break request has been created using the Product Price Contracts 
page in Vendor Portal. 
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7Setting Up and Managing SyteLine User 
Accounts for the Portal(s)

Although portal users never see SyteLine forms, they do access SyteLine data through 
IDOs and so they must have a user account in SyteLine, with the appropriate licensing and 
permissions. The portal user logs in through SharePoint using this SyteLine user name and 
password.

In past versions of the portals, steps for setting up these user accounts were all manual 
and involved multiple SyteLine forms. Beginning with SyteLine 9.0, a User Account 
Management Utility is provided in each of the portals to streamline the process of creating 
SyteLine user accounts for portal users. The utility is especially helpful for multi-site 
implementations, because it automatically creates many of the records needed for user 
accounts across sites. 

You may still prefer to set up some user accounts manually, and steps for doing so are 
included in this chapter. However, we recommend that you use the User Account 
Management Utility for most user setup and management.

These topics are provided:

NOTE: The information in this chapter explains creating new portal logins for your external 
customers and vendors. It assumes that you have not already set up logins for them to 
another SharePoint site. If you do have existing logins to a SharePoint site, you may be 
able to use them with our portals, rather than creating all new ones. Contact Infor 
Professional Services for help.

Topic See Page

Setting Up SyteLine Accounts for Portal Users 98

Adding User Accounts Manually 99

About the User Account Management Utility 102

Creating Portal User Accounts with the User Account 
Management Utility

102

Analyzing Portal User Accounts with the User Account 
Management Utility

103

Copying Portal User Accounts with the User Account 
Management Utility

104
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Setting Up SyteLine Accounts for Portal Users

This section describes requirements for setting up SyteLine accounts for portal users.

Required SyteLine Records

In order to set up a SyteLine user account for a portal user, either manually or with the User 
Account Management Utility, certain records must already exist in SyteLine. 

 For creating Customer Portal user accounts, the Customer record (on the Customers 
form) with which the portal user’s account is to be associated must exist in all sites.

 For creating Vendor Portal user accounts, the Vendor record (on the Vendors form) with 
which the user account is to be associated must exist in the Primary Site. 

 For creating Reseller Portal user accounts, the Customer and Reseller’s Salesperson 
records (on the Customers form) must exist in all sites. The Salesperson (on the 
Salespersons form), Commissions (on the Commission Table form), and Vendor (on 
the Vendors form) records with which the user account is to be associated must exist in 
the Primary Site.

 For creating Customer Portal user accounts that reference a reseller, the Customer 
record (on the Customers form) must exist in all sites. Also, the associated reseller 
records must exist in all sites prior to creating new reseller customer accounts.

Tasks for creating these required records for each portal are explained in the “Setting Up 
SyteLine“chapters of this guide. 

Multi-Site Considerations

In multi-site implementations, you can use the User Account Management Utility to copy 
required records from the Primary Site to all other sites in your portal site groups. The 
process is described in “Copying Portal User Accounts with the User Account Management 
Utility” on page 104. The following rules apply:

Customer Portal

 A customer ID must represent the same customer across all sites in the Customer Portal 
site group.

Reseller Portal

 A customer can be associated with only one reseller across all sites in the Customer 
Portal site group.

 A customer is either associated or not associated with a reseller. This must be true 
across all sites and ship-to records.

 A reseller customer must use the same reseller salesperson ID across sites.

 Salesperson IDs used for reseller association must reference the same vendor ID 
across sites.

Vendor Portal

 A vendor ID must represent the same vendor across all sites in the Vendor Portal site 
group.
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Exceptions for Customer Portal User Accounts

For all three portals, you can set up user accounts manually or with the utility after required 
customer, reseller, and vendor records are created. For Customer Portal, there are 
additional ways for users to be added:

 Existing users for whom you have set the Can Create Users permission on the 
Customer Users form can add new users to their own customer account from the 
Customer Portal Account Management page. All the necessary records are created in 
SyteLine. 

 New business-to-consumer (B2C) customers can register their own user accounts from 
Customer Portal before submitting an order. All the necessary records are created in 
SyteLine. If these customers received a portal redirect link from a reseller, then when 
they register, their accounts are automatically associated with the reseller. An alert is 
published for SyteLine and Reseller Portal subscribers to NewCustomerCreatedAlert, to 
let them know a customer record has been created.

 Resellers for whom you have set the Can Create Users permission on the Customer 
Users form can register new customers from the Reseller Portal Account Management 
page and Customers page. All the necessary records are created in SyteLine, and these 
customers are automatically associated with the reseller who adds them. Again, the 
alert is published for SyteLine and Reseller Portal subscribers. 

For more information about adding customers for a reseller, see “Adding Customers for 
a Reseller” on page 82 and “Associating Existing Customers to a Reseller” on page 82.

Adding User Accounts Manually

In the event that you need to set up SyteLine user accounts manually for Customer, 
Reseller, or Vendor portal users, this section describes the required tasks. 

If you have a multi-site implementation, all user account records must be created in all 
sites.

Create SyteLine User Records

1. On the Users form, create a new user record. The record must include:

 User ID

 Password

 Super User: This option must not be selected. This user cannot be a super user.

 User Modules: Add the appropriate portal license module, either SyteLinePortals or 
SyteLinePortals_MS. Refer to the Infor SyteLine Licensing Guide for important 
details

 On the Groups tab, do one of the following:

 For a Customer Portal or Reseller Portal user, select the Customer Portal group 
from the drop-down list.

 For a Vendor Portal user, select the Vendor Portal group from the drop-down list.
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NOTE: If the portal user is both a vendor and customer, the user can be assigned 
to both groups. 

 On the E-Mail Address tab, specify the Primary E-mail Address and select Send 
External Notifications if you want the user to receive e-mail confirmation of their 
actions on the portal.

These settings also can be controlled by the E-mail Address and Confirmation 
settings the user makes on the portal Account Management page. However, if you 
do set the Primary E-mail Address here in SyteLine, you should also select Send 
External Notifications in SyteLine rather than waiting for it to be set on the portal.

Also, in order to support the use of Send External Notifications, the Forms 
Database Name field on the SyteLine Sites/Entities form must be set to a default 
forms database name from which to retrieve translated strings for messages sent 
from and within each application database. Refer to the SyteLine online help for 
more information.

Add the User to the Necessary User List

Row-level authorizations (IDO filters) are already set up that limit the access portal users 
have to SyteLine. The filters expect each Customer or Reseller Portal user to be 
associated with only one customer number and each Vendor Portal user to be associated 
with only one vendor number. 

Do one of the following:

 For a Customer Portal or Reseller Portal user, on the Customer Users form, specify 
the customer number associated with the portal user and the SyteLine user name 
(user ID) that you gave the portal user.

 For a Vendor Portal user, on the Vendor Users form, specify the vendor number 
associated with the portal user and the SyteLine user ID that you assigned to the 
portal user.

Set "Can Create Users" (Optional)

This task is for only Customer Portal or Reseller Portal user accounts.

On the Customer Users form, the Can Create Users setting controls an option for adding 
new users from the portal. This option can be provided to customer or reseller users; 
however, only customer users can be added from the portal. 

The Can Create Users setting also controls an option to register new customers from the 
portal. This option can be provided to only reseller users.

The difference between creating new users and registering new customers is that new 
users are associated with an existing customer record in SyteLine, and registering a new 
customer creates a new customer record in SyteLine.

To give customer users the ability to add users, select this option.

To give reseller users the ability to add users and register new customer, select this option.
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Adding Users: How it Works for Customers

If this setting is selected for a Customer Portal user, the Add a New User button and User 
drop-down list are displayed at all times on that user’s Account Management page in the 
portal. 

The customer can click the button to open the Create User Account form, where new user 
information is entered. Once submitted, new records are created in SyteLine, in all sites of 
the portal site group, on the Users and Customer Users forms. The new user is 
automatically associated with the customer record of the customer who created the user. 

An alert is published for subscribers to the NewCustomerCreatedAlert to let them know an 
account has been created in SyteLine. 

The customer who created the user must communicate the user ID, password, and portal 
URL to the new user, and then that user can access the portal. 

The customer can edit or inactivate any new user account he or she created by selecting it 
in the User list on the Account Management page and then using the options provided.

Adding Users: How it Works for Resellers

If this setting is selected for a Reseller Portal user, the reseller must first choose a company 
from the Customer list on the Account Management page and then click Filter. The Add a 
New User button and User list are displayed. 

When the reseller enters and submits new user information, new records are created in 
SyteLine, in all sites of the portal site group, on the Users and Customer Users forms. The 
new user is automatically associated with the active customer record. 

An alert is published for subscribers to the NewCustomerCreatedAlert to let them know an 
account has been created in SyteLine. 

The reseller must communicate the user ID, password, and portal URL to the new user, 
and then that user can access the portal. 

The reseller can edit or inactivate any new user account he or she created by first selecting 
the associated customer and then the user on the Account Management page.

Registering New Customers

When you select the Can Create Users setting for any Reseller Portal user, the Register a 
New Customer button is automatically included on that reseller’s Account Management 
page and Customers page in the portal. 

The reseller can click the button to open the Register a New Customer form, where new 
customer information is entered. Once submitted, new records are created in SyteLine, in 
all sites of the portal site group, on the Users and Customer Users forms.
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About the User Account Management Utility

The SyteLine Portals User Account Management Utility automates many parts of user 
account setup and management. This utility is displayed to only users set up as portal 
administrators (see “Set Up the Portal Administrator User Account” on page 29) and is 
available in all three portals. It can be used to:

 Create new portal-enabled SyteLine user accounts for one site or across all sites in the 
portal site group. 

 Analyze existing portal-enabled SyteLine user accounts to see if they are set up properly 
for one site or across all sites in the portal site group.

 Copy portal-enabled user accounts from the Primary Site to all other sites in the portal 
site group. This applies to only multi-site implementations. 

NOTE: The Copy function can be used to help with user account setup and for fixing 
problem accounts, across sites. It is not meant for copying a single valid account to use 
as a template for creating a new account.

For Customer Portal or Reseller Portal users, the utility assigns or validates accounts in the 
Customer Portal group. For Vendor Portal users, the utility assigns or validates accounts in 
the Vendor Portal group.

You must ensure that the utility is used by only one session per portal at a time.

Creating Portal User Accounts with the User Account 
Management Utility

Use the following procedure to create SyteLine portal-enabled user accounts using the 
User Account Management Utility. 

1. Log in to the appropriate portal with your portal administrator credentials. The User 
Account Management Utility page is displayed.

2. In the User Account Creation section, specify this information:

 Account Type: This field is enabled for use in only Customer and Reseller portals, 
so you can specify whether to create a customer or reseller portal user account. 

 User ID: Specify the user ID that the user must enter to log in to the portal.

 Password: Specify the password the user must enter to log in to the portal.

 Retype Password: Type the password again for confirmation.

 Name: Specify the user’s first and last name.

 E-mail: Specify the user’s primary e-mail address. Any messages coming from the 
portal will be sent to this address. 

 Customer or Vendor: Customer is enabled for use in only Customer and Reseller 
portals. Specify the customer ID to be associated with this portal user account. 
Vendor is enabled for use in only the Vendor Portal. Specify the vendor ID to be 
associated with this portal user account.
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 Salesperson: This field is enabled for use in only Customer and Reseller portals. 
When the account type is Customer, specify the Salesperson ID of the reseller who 
is to get credit for sales to this customer. When the account type is Reseller, specify 
the reseller’s Salesperson ID. 

 Vendor: This field is enabled for use in only Customer and Reseller portals when 
the account type is Reseller. Specify the reseller’s vendor ID. 

 Reseller Commission: This field is enabled for use in only Customer and Reseller 
portals when the account type is Reseller. Specify the commission percentage the 
reseller is to receive from purchases made by associated customers.

3. To automatically send the user an e-mail message containing their user ID, password, 
and portal URL, select Notify User. This step is optional.

4. Click Create. This portal user account is created in all sites in the portal site group.

Analyzing Portal User Accounts with the User Account 
Management Utility

This task describes analyzing portal-enabled user accounts after they have been added in 
SyteLine, either manually or using the utility.

In the User Account Analysis and Copy section, do one of the following:

 To analyze all user accounts, leave the User ID field blank and click Analyze.

 To analyze a specific user account, specify the user ID and then click Analyze.

Color-coded results are displayed.

Red means the issue must be fixed before the user can access the portal.

Yellow means the issue does not prevent the user from accessing the portal, but it may 
cause undesirable results.

Green means the account is set up properly and is ready for accessing the portal.

To fix a problem account, you may be able to copy an existing account from the Primary 
Site, as described in the next topic. If the problem is with an account in the Primary Site, 
you must fix that account manually.

NOTE: Once you analyze accounts, the results are stored and shown in the grid every time 
you log in to the utility. To purge old records, you must run Analyze again. 
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Copying Portal User Accounts with the User Account Management 
Utility

This task describes copying all valid portal user accounts from the Primary Site to all other 
sites in the portal site group. Accounts can be copied to help with user account setup or to 
fix a problem account in a site other than the Primary Site.

To copy portal user accounts, the following SyteLine conditions must be met:

 For Customer Portal user accounts, the Customer record (on the Customers form) must 
exist in all sites and the Customer User record (on the Customer Users form) must exist 
in the Primary Site.

 For Vendor Portal user accounts, the Vendor record (on the Vendors form) and Vendor 
User record (on the Vendor Users form) must exist in the Primary Site.

 For Reseller Portal user accounts, the Customer and Reseller’s Salesperson records 
(on the Customers form) must exist in all sites. The Customer User (on the Customer 
Users form), Salesperson (on the Salespersons form), Commissions (on the 
Commission Table form), and Vendor (on the Vendors form) records must exist in the 
Primary Site.

 For Customer Portal user accounts that reference a reseller, the Customer record (on 
the Customers form) must exist in all sites. Also, the associated reseller records must 
exist in all sites prior to creating new reseller customer accounts.

 For all portals, the User Name, User E-mail, and User Group records (on the Users 
form) must exist in the Primary Site.

To copy accounts, first run Analyze to make sure you have current records. Then in the 
User Account Analysis and Copy section, do one of the following:

 To copy all user accounts that have been set up in the Primary Site, click Copy all 
accounts from Primary Site to all sites. This option is next to the user account 
condition summary. This process can take some time if there are many accounts to copy.

 To copy a single user account, find the account in the user grid section and then click 
Copy Account from Primary Site to All Sites for that account.

If errors occur after copying an account, you will need to verify the original account and set 
up the new account manually. See “Adding User Accounts Manually” on page 99.
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The content management function of the Portal Manager provides an efficient method for 
backing up and transferring portal content. 

Backups are needed for simple content changes, such as the basic personalizations 
described in this guide, and also for advanced customizations like those explained in the 
Infor Portals Customization Guide. 

Backups are made by using Portal Manager to export SharePoint content to a target folder 
on your local hard drive. If you need to restore backup content, you can use Portal 
Manager to import it back into SharePoint.

You also can transfer reusable content from one SharePoint portal to another. For example, 
when you personalize the portal in a test environment, you can transfer the completed 
content to your production portal. Also, if you use both the Customer and Vendor portals, 
you could modify the login page in one portal and then transfer that page to also be used in 
the other, rather than making the same changes in both portals. If you add a new page, you 
can create the page in one portal and transfer it to the other. 

This chapter explains how to use the Portal Manager to export, import, and transfer 
content. These topics are provided:

Exporting Modified Portal Content

When you modify portal components, they are locked in Portal Manager and cannot be 
edited by other users. To unlock and back up the components, you must export them. 

NOTE: When you lock a component using Portal Manager, the corresponding file is also 
locked in SharePoint. When you export the component using Portal Manager, the file is 
unlocked in SharePoint. If you edit a file in SharePoint, then after saving your changes, 
the file is locked. You must export the component using Portal Manager in order to 
retain the latest version in your backup location. This applies to components in the IPF 

Topic See Page

Exporting Modified Portal Content 105

Generating a CRC File 106

Importing Portal Content 107

Transferring Portal Content 107

Clearing or Saving the Log Display 108
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Installed Site Pages, IPF Installed Site Assets, and IPF Installed Help Assets lists in 
SharePoint.

To export modified portal content:

1. Open the Portal Manager and connect to the site from which to export content.

2. Select Content Management > Enable Version Control to start version control. 

3. Select Content Management > Export. All folders are displayed, but only your locked 
components are included in them. 

To see components locked by all users, select Show All Locked Components. You can 
export these too, if you have the appropriate permissions in SharePoint.

4. Select the check box next to each type of content to back up. You can expand the folders 
to select individual components. 

5. Select Export files to Folder for check-in. 

6. Specify the target folder to which to export the content. This is the root folder of where 
you will store modified portal content, for example C:\SyteLine Portals. Even if you 
have selected only one component to export, you should specify the root folder. 
Otherwise the entire folder structure will be built again inside of any other folder you 
select.

7. Click Export. A summary form is displayed, showing the content you have chosen to 
export. You have these options:

 To save the summary information to a file, right-click the form and then select Save 
to File.

 To change your selections, click Cancel and make your selections again.

 To start the process, click Start. Your content is exported to the backup folder. You 
can see export progress on the progress bar and status in the log display at the 
bottom of the form. If you need to cancel the process, click Cancel on the progress 
bar.

8. If you use a version control system, you can check in the exported content.

Generating a CRC File

To make sure components have not been changed manually, you can have a CRC file 
generated each time you export content using Portal Manager. 

To generate the CRC file, select Content Management > Generate CRC File. Now, each 
time you export components, a CRC file is created for each one and added in the same 
location. When you import content, if a CRC file exists, it is checked to see if the 
component has been changed manually.
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Importing Portal Content

To import content using Portal Manager:

1. Open the Portal Manager and connect to the site to which to import content.

2. Select Content Management > Import.

3. Specify the folder from which to import (this is the root folder to which you exported portal 
content). You can also select to import a single component.

4. Select the check box next to each type of content to import. You can expand the folders 
to select individual components.

5. Click Import. A summary form is displayed, showing the content you have chosen to 
import. You have these options:

 To save the summary information to a file, right-click the form and then select Save 
to File.

 To change your selections, click Cancel and make your selections again.

 To start the process, click Start. Your content is imported into SharePoint. Existing 
content is overwritten, unless it is the same or an older version. Then it is skipped. 
You can see import progress on the progress bar and status in the log display at the 
bottom of the form. If you need to cancel the process, click Cancel on the progress 
bar.

Transferring Portal Content

To transfer content from one portal to another:

1. Open Portal Manager and connect to the site from which to transfer content.

2. Select Content Management > Transfer.

3. Select the check box next to each type of content to transfer. You can expand the folders 
to select individual components.

NOTE: If you select components that are locked in Portal Manager, the previous 
unlocked version is transferred, unless none is found. Then the component is skipped.

4. Specify and connect to the portal to which to transfer the content. 

5. Click Transfer. A summary form is displayed, showing the content you have chosen to 
transfer. You have these options:

 To save the summary information to a file, right-click the form and then select Save 
to File.

 To change your selections, click Cancel and make your selections again.

 To start the process, click Start. Your content is copied from the source portal to the 
target portal. Existing content is overwritten, unless it is the same or an older version. 
Then it is skipped. You can see transfer progress on the progress bar and status in 
the log display at the bottom of the form. If you need to cancel the process, click 
Cancel on the progress bar.
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Clearing or Saving the Log Display

The Portal Manager log display collects data continuously as you export, import, and 
transfer portal content. 

To save logged data to a file, right-click the log display area and select Save As. 

To locate the log file, right-click the log display area and select Locate Log File.

To clear the log display, right-click the log display area and select Clear.
Infor SyteLine Portals Setup and Administration Guide 
Copyright © 2014 Infor 



9Personalizing the Portal(s)

This chapter provides steps for personalizing the portal(s) with your own company logo, 
pictures, text, and more. 

You can perform basic personalizations as needed. Most changes are made in the Portal 
Manager and its Layout Editor. If you choose to set links to new content for existing menu 
options, you also will need a version of Microsoft Visual Studio. See Chapter 1, “System 
Requirements and Prerequisites”.

In order to make personalizations, your account must have Design level permissions in 
SharePoint. 

For information about making more complex changes, refer to the Infor Portals 
Customization Guide. 

NOTE: We generally recommend that you make personalizations in an internal test 
environment and then transfer those modified features to your external portal.

Setting SharePoint Design Permissions

During portal configuration, you set SharePoint Read permissions for all SyteLine user 
accounts belonging to the Customer Portal and/or Vendor Portal group, so they can see but 
not change content on your portal(s). Similarly, you must set Design permissions for any 
user who should be able to modify portal pages.

Step Description See Page

1 Set SharePoint design permissions for users who will personalize the portal. 109

2 Enable the portal for development. 110

3 Learn about the Home page layout. 111

4 Change the sample company logo. 112

5 Change the sample Home page pictures. 112

6 Change the sample Home page text. 113

7 Enable bottom menu links (optional). 114

8 Change the portal color scheme (optional). 115

9 Hide menu options (optional). 116

10 Update or hide online help topics (optional). 116

11 Back up personalized components. 120
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When users with Design permissions sign in to the external portal Web site, a maintenance 
(wrench) icon is displayed in the upper left corner of most portal pages. Users can click this 
icon to enable the SharePoint ribbon for working on portal content.

You can assign Design permissions to individual users in SharePoint, or you can create a 
special group of users and assign Design permissions to the group. See “Set User Group 
Permissions in SharePoint” on page 48.

NOTE: Some modal pages in the portal, or new pages added during portal customization, 
may not include the maintenance icon even if you have Design permissions. This can 
happen if the page doesn’t include the ToggleAdmin Web Part or field display format. In 
these cases, you can still access the SharePoint ribbon by adding this to your page 
URL: ?IPFDisplayRibbon=1. For example: <SharePoint Server 
Name>:8084/IPFSitePages/NewPage.aspx?IPFDisplayRibbon=1. Refer to the 
Infor Portals Customization Guide for more information.

Enabling a Portal for Development

Before you can make personalizations, you must enable the portal for development. Follow 
these steps:

1. Open Portal Manager and connect to the site to work with.

2. Select Configuration > General.

3. Click Enable Portal for Development.

4. On the dialog box that opens, specify this information:

 Originator: This originator indicates the organization, product, or project that created 
the component. In most cases, you will specify your company name as the originator 
for components you add or personalize in the portals.

 Feature Name: Select the feature to personalize. The Default feature is for content 
that is available to all portal users.

 Priority: The priority is set to 30 by default. Because the SL 9.00 and IPF 3.1 
originators were set to priorities of 20 and 10 during portal configuration, this new 
originator is now set at the highest priority, so only components of this originator are 
edited.

5. Click OK.

6. Back on the General tab, click Apply. The selected portal is ready for development and 
the specified feature and originator are automatically activated.

Additional information about activating custom portal content is provided in the Infor Portals 
Customization Guide.
Infor SyteLine Portals Setup and Administration Guide 
Copyright © 2014 Infor 



Personalizing the Portal(s)         111
Understanding the Home Page Layout

The Home page for SyteLine portals is made up of these editable parts:

 The header display layout, named MasterTopHeader_MenuBar. This display layout is 
included on a portal master page, so any changes you make are applied to all portal 
pages that use this master page.

 The footer display layout, named MasterBottomHeader_FooterMain. This display layout 
is also included on a portal master page, so any changes you make are applied to all 
pages that use this master page.

 The center display layout, named Main. This layout is used only on the Home page.

NOTE: It is helpful to have the Home page open while you make personalizations, because 
after you make a change in Portal Manager or the Layout Editor, you can refresh the 
Home page to see your change immediately.
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Changing the Company Logo

The portal is set up with a sample logo that you must replace with your own company logo. 
The logo file, which is used in the top left corner of the portals, is added to the 
MasterTopHeader_MenuBar layout and is contained in this SharePoint library: 
/IPFSiteAssets/Images. 

The simplest way to change the sample logo is to give your company logo the same file 
name, which is DemoTitleBarImg.png, and then add this new file to your portal using Portal 
Manager. 

A field display format of 'ImageSP165x60Click' has been used for the logo file. For best 
results, we recommend that your logo file be similar in size to 165 x 60 pixels. However the 
field display format does adequately constrain the proportions of any sized image while 
maintaining its aspect ratio. For information about images for retina-ready devices, see 
“Standards for Pictures Used on the Portal” on page 53.

To replace the sample company logo file:

1. Save your company logo file as a .png file to your workstation with the name 
DemoTitleBarImg. 

2. In Portal Manager, select Content Development > Components.

3. Expand IPF Installed Site Assets and then expand the Images folder.

4. Open the folder where your own company logo file is saved, and drag that file to the 
Images folder in Portal Manager. At the bottom of the list of image files, the new file is 
added in a locked state. (The file is unlocked after you export content, as described in 
“Exporting Modified Portal Content” on page 105.)

5. Open or refresh your external portal Web site to review the change.

Changing Pictures on the Home Page

The portal is set up with sample Home page marketing images that should be replaced with 
pictures appropriate for your company. These images files are added to the Main layout 
and are contained in this SharePoint library: /IPFSiteAssets/Images. 

The simplest way to change the sample Home page images is to give your images the 
same file names, which are HomePageMarketingImage1.png, 
HomePageMarketingImage2, and so on, up to Image6. Then add these new files to your 
portal using Portal Manager. 

A field display format of ImageSP1000x340 pixels has been used for the images 1, 2, and 
3, which are revealed one at a time in the center of the Home page. A field display format of 
ImageSP316x136 pixels has been used for images 4, 5, and 6, which are displayed below 
the center images. For best results, we recommend that your files be similar in size to 
these field display formats. 
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To replace the sample Home page pictures:

1. Save six Home page.png image files to your SharePoint server with the names 
HomePageMarketingImage1 through HomePageMarketingImage6. 

2. In Portal Manager, select Content Development > Components.

3. Expand IPF Installed Site Assets and then expand the Images folder.

4. Open the folder where your own images are saved, and drag those files to the Images 
folder in Portal Manager. At the bottom of the list, the new files are added in a locked 
state.

5. Open or refresh your external portal Web site to review changes.

Changing Text on the Home Page

To change text on the Home page, you must edit data in the Main layout. 

IMPORTANT: This topic explains how to change the current translatable text strings to 
literal text that cannot be translated. If you need to use translatable text on your 
portal(s), do not make the changes specified here. Instead, refer to the Infor Portals 
Customization Guide.

To change text on the Home page:

1. In Portal Manager, select Content Development > Layouts.

2. Scroll down and find the Main layout.

3. Right-click in the UI column for that row and select Edit Layout UI. This opens a new 
browser window for the portal Layout Editor and creates a new copy of the layout with 
your specified originator.

4. In the Layout Editor, you will need to do the following for each text string you want to 
change. The table below explains further:

a. In the right pane (layout tools), expand the Regions section and select the region the 
text is in.

b. Expand the Embedded Regions section and select the embedded region and card, 
if applicable. The center of the page shows the card design for the selected region.

c. In the active card design, click the specified text region. This highlights the region.

d. In layout tools, expand the Cell section and change the text in the Data field.
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e. Click the Save icon in the upper right corner to save your changes.

This table shows what to select and edit for all regular text on the Home page:

5. Open or refresh your external portal Web site to review changes. 

Enabling Links in the Bottom Menu (Optional)

In the bottom menu of all portal pages, there are links for Privacy Policy, Terms of Use, 
and Purchase Terms and Conditions. The links are included in the 
MasterBottomHeader_FooterMain layout.

When the portals are first installed, these links do not work, because they need to open 
content specific to your company. You can enable these options by linking to your own 
content, either new site pages or existing content. (Instructions for creating a new site page 
are provided in the Infor Portals Customization Guide.) 

You may also choose to hide the links, as explained in “Hiding Menu Options (Optional)” on 
page 116. 

To enable the links, you will need a version of Microsoft Visual Studio, so you can edit the 
script for these links. See Chapter 1, “System Requirements and Prerequisites”.

Home Page 
Sample Text Region

Embedded 
Region Card

Data String
to Change

Welcome CardTextBackground
Region

TitleER Card1 sWelcome

Fitness-X CardTextBackground
Region

TitleER Card2 sFitnessX

Cross Country CardTextBackground
Region

TitleER Card3 sCrossCountry

Progressive Cycles has 
been making...

CardTextBackground
Region

TextER Card1 sPortalHomePage
MarketingText

Our hybrid bicycle for 
fitness rides...

CardTextBackground
Region

TextER Card2 sPortalHomePage
MarketingText2

Designed for strong 
climbing...

CardTextBackground
Region

TextER Card3 sPortalHomePage
MarketingText3

Looking for a product... Main ContactUsMarketing
ER

N/A sPortalPromotion
ContactUs

Gifts for everyone... Main TopSellersMarketing
ER

N/A sPortalPromotion
TopSeller

Free shipping on all... Main ShopNowMarketing
ER

N/A sPortalPromotion
ShopNow
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To enable a menu link:

1. In Portal Manager, select Content Development > Layouts.

2. Scroll down and find the MasterBottomHeader_FooterMain layout.

3. Right-click in the UI column for that row and select Edit Layout UI. This opens a new 
browser window for the portal Layout Editor and creates a new copy of the layout with 
your specified originator.

4. In the active card design in the center of the page, click the cell for the link to enable. For 
example, click the TermsOfUseLabel cell.

5. In the right pane (layout tools), expand the Cell section.

6. Under Style, in the Field display format field, select TextClick and then save your 
change. This makes the link clickable.

7. In Portal Manager, right-click the Server Script column for this layout and select Edit 
Server Script. This opens the script in Visual Studio.

8. Locate the OnLayoutInitialized event and add a line at the end to associate the selected 
clickable link with your content. 

In the following example, we have associated the link with the Infor.com URL. You can 
add a URL or a new site page if one has been created. Review the existing entries to 
see how to complete your new entry.

9. Save your change in the script.

10. Open or refresh your external portal Web site to review the change. 

Changing the Portal Colors (Optional)

We provide five different style families you can choose from to change the background, 
menu icon, and page title colors in your portal. 

To change the style family:

1. In Portal Manager, select Configuration > General.

2. In the Default Style Family field, select a style family.

3. Click Apply. 

4. Open or refresh your external portal Web site to review the change.
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Hiding Menu Options (Optional)

The portal menu bars are included in the top and bottom layouts of the custom master 
page, so they are displayed on most pages in the portal. You can hide any menu option that 
you do not want to use in your portal. 

The top menu bar provides links in three regions of the MasterTopHeader_MenuBar layout: 
Menu1A, the Shop menu; Menu2A, the Activity menu; and Menu3A, the Account Menu. 
The bottom menu bar provides links in the MasterBottomHeader_FooterMain layout.

This example explains how to hide a menu option in the top menu bar. You can follow this 
example to hide any menu option in either the top or bottom menu bar; however, 
repositioning of cells may be necessary to hide some links, to avoid creating an empty 
space. Refer to the Infor Portals Customization Guide in these cases.

To hide a top menu option:

1. In Portal Manager, select Content Development > Layouts.

2. Scroll down and find the MasterTopHeader_MenuBar layout.

3. Right-click in the UI column for that row and select Edit Layout UI. This opens a new 
browser window for the portal Layout Editor and creates a new copy of the layout with 
your specified originator.

4. In the right pane (layout tools), expand the Regions section.

5. Select the menu region that contains the link to hide. For example, to hide the Contract 
Order link, click Menu1A. The center of the page shows the card design for the selected 
region.

6. In the active card design, click the cell that contains the link to hide.

7. In the layout tools, expand the Cell section. 

8. Clear the Rendered? check box.

9. Click the Save icon in the upper right corner to save your change.

10. Open or refresh your external portal Web site to review the change.

Updating or Hiding Online Help (Optional)

Help topics for portal pages and components on pages are optional. If there is a help file 
linked to a page or component, the help icon (?) is displayed on the page. If there is no help 
file linked to the page or component, the help icon is not displayed.
Infor SyteLine Portals Setup and Administration Guide 
Copyright © 2014 Infor 



Personalizing the Portal(s)         117
There is also a Help link in the bottom menu of each page, which displays a help contents 
page. If you choose not to provide online help, this link must be hidden. If you add topics to 
the help set, you can also update the help contents page.

Infor has provided help topics, in English with a 1033 locale value, that you can use as-is, 
remove, or personalize. You also may want to provide translated help topics for your 
portal’s supported locales. We suggest that you match our standard naming convention for 
your help files, and place the source topics in folders by locale, so they are easy to find and 
update.

Modifying Help Topics

In the event that you make a change to any of the existing portal pages, you may need to 
update the provided online help topic(s). For example, if you hide the Contract Orders link 
in the Shop menu, then you would need to change any help topics that refer to that page or 
that provide a hypertext cross-reference to the page topic.

You can use most HTML editors or Notepad to modify help topics. Do not use Microsoft 
Word to edit the files.

To modify an existing help topic:

1. In Portal Manager, select Content Development > Components.

2. In the components tree, find the help file to modify by expanding IPF Installed Help 
Assets > Portals30 > <help collection (custportaloverview, vendportaloverview, or 
resellerportaloverview)>. Click the desired topic from that collection and drag it to your 
desktop or another location on your workstation.

3. Right-click the file and select Open with. Choose your HTML editor or Notepad. Do not 
open with Microsoft Word.

4. Edit the topic as needed and save your changes. Do not change the file name.

5. Drag the file back to its collection in Portal Manager, and click Yes when prompted to 
overwrite the existing version. A copy of the file with your specified originator is added 
in a locked state. 
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6. Next you must add the Context Key, if applicable, and Feature name properties for this 
new file. The best way to determine what to add is to check the properties grid for the 
original help file. For example, if you have modified the Announcements.htm help topic 
in the custportaloverview help collection, then you should click the original file to see its 
properties.

In this example, the properties are:

 Context Key = Announcements.aspx. This maps the help topic to the appropriate 
portal page and causes the help (?) icon to be displayed on that page. Not all help 
topics are mapped to a portal page, so this field is not required.

 Feature = Customer Portal. This specifies the portal to which the help topic applies. 
This field is required.

To edit the properties for your new file:

a. Select your new file in the list.

b. Click the Edit (pencil) icon.

c. Specify the Context Key and/or Feature.

d. Click the Save icon.

7. To review the change, open or refresh your external portal Web site, go to the page for 
which you have added a modified help topic, and click the help icon in the upper right 
corner.

Hiding Help Topics

If you do not wish to provide help topics for certain pages of your portal, you can hide all 
links to the topics so users cannot access the content. This includes removing the Context 
Key, if one is provided, and removing hypertext links in any of the other help topics. You will 
need to carefully review all help topics in a collection to find hypertext links that may need 
to be removed. 

Follow the steps in “Modifying Help Topics” on page 117 to remove hypertext links and add 
your edited files.

To remove the Context Key from a help topic file:

1. In Portal Manager, select Content Development > Components.

2. Expand IPF Installed Help Assets and select the help file to work with.

3. Next to the properties grid, click the Edit icon.
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4. Remove the Context Key entry. 

5. Click the Save icon. A copy of the file with your specified originator is added in a locked 
state. 

6. To review the change, open or refresh your external portal Web site and go to the page 
whose topic no longer has a Context Key. Make sure there is no help icon in the upper 
right corner.

Adding a Help Collection for a Different Locale

If you do not provide a translated help collection for a locale, then when portal users click 
the help icon, they will see the help for the default locale (usually English). To add a help 
collection for a different locale, follow these steps:

1. Name the folder that contains your translated .htm files. Your folder name must match 
the existing help folder name:

2. In Portal Manager, select Content Development > Components.

3. In the components tree, expand IPF Installed Help Assets.

4. Click and drag your help collection folder and drop it under IPF Installed Help Assets. 
The New Help Assets window is displayed.

5. Specify this information:

a. Locale: Specify the locale for your help collection. (This locale must also be selected 
during portal configuration, so it can be provided as an option in the language field 
on your portal.) 

b. Product Name: Specify Portals30. This name must match the existing help product 
name.

c. Click OK. The new help collection is added. 

6. Next you must add the Context Key, if applicable, and Feature name properties for all 
help files in the collection. The best way to determine what to add is to check the 
properties grid for the help files in the original Portals30 help collections. Refer to step 6 
in “Modifying Help Topics” on page 117 for details.

7. Add a style sheet file to the Portals30 folder in your translated collection. You can copy 
the existing style sheet or add your own.

8. To test your new help collection, open or refresh your external portal Web site and in the 
bottom menu, select the applicable language. Next, click the help icon in the upper right 
corner to see the help topic in the selected language. 

Portal Folder Name

Customer Portal custportaloverview

Vendor Portal vendportaloverview

Reseller Portal resellerportaloverview
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Backing Up Your Personalized Components

At any point during the process of personalizing the portal(s), you can export your new 
components so they are backed up and also unlocked in Portal Manager. For more 
information, see Chapter 8, “Managing Portal Content”.
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This chapter provides information about SyteLine and SharePoint portal administration 
tasks that are performed either occasionally or on a regular basis.

Providing Login Information

You will need to provide this information to each new portal user that you create in 
SyteLine:

 The portal URL

 The browsers and versions that are supported

 The user’s login and initial password

Task Tool to Use See Page

Provide customers, resellers, and/or vendors with login 
information.

E-mail or phone 121

Add or update information on the portal (optional). SharePoint 122

Approve uploaded documents. SyteLine 125

Check for messages sent from the portal Contact Us page. E-mail

Clear the portal cache. Portal Manager 126

Clear the Portal Manager log. Portal Manager 126

Use the Communication Wizard to send promotions or 
announcements to portal subscribers.

SyteLine 126

Push portal configuration changes when you add another server to 
your SharePoint farm.

SharePoint 127

Reset pre-login permissions when you change authentication data 
sources or SharePoint user/group permissions.

Portal Manager 127

Change the authentication data source. Portal Manager 
and SharePoint

127

Change IIS Site Bindings. SharePoint 128
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Adding or Updating Information on the Portal(s) (Optional)

Using our provided SharePoint libraries and lists, you can add these types of information to 
the portal:

 Announcements

 FAQ

 Knowledge Base items

 Videos or White Papers

 Press Releases

If you later reinstall the portal over the existing Web application, this information is 
preserved. If you uninstall the Web application, this information is lost, so you should store 
backup copies on another computer. There are several ways to back up the data in lists. 
One simple way is to export the data to Microsoft Excel. You also can use the Portal 
Manager. See “Exporting Modified Portal Content” on page 105.

Translation

These page names and column headers are translated into different languages based on 
the portal user’s language selection.

You can translate and add content (the list or library items) in different languages. However, 
the portal does not mark entries for a particular language or display only items that match 
the portal user’s selected language. The portal users will see all items in all languages and 
must find the ones in their language, so we suggest that you specify the language as part 
of the filename or description.

Known Limitation for Customization

You can add custom data collections to your portal — similar to our White Papers, Videos, 
FAQs, etc. — using SharePoint lists and libraries. When you create a new list or library, 
SharePoint does not require that column display names are unique. However, the Infor 
Portal Foundation (IPF) architecture refers to each column by its display name, so if names 
are not unique, IPF cannot function correctly. To resolve this issue, you should use unique 
column display names when you add a new SharePoint list or library to your portal.

Add Announcements

Announcements are displayed on the portal’s Announcements page 
(/IPFSitePages/Announcements.aspx).

To add your announcements to the Announcements list in SharePoint:

1. Using the shortcut on your desktop, open the portal administration site and sign in using 
Windows authentication. The portal’s Default.aspx page is opened in SharePoint.

2. In the Lists menu, click Announcements.

3. Click Add new item.
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4. On the Announcements - New Item form, add the title and text of the announcement. 
Announcements can contain text, hyperlinks, HTML code, attachments, pictures, and 
tables.

5. Specify the date. On the portal Announcements page, the list of announcements is 
sorted by date, with the most recent announcement first. 

6. Click Save.

The default list layout has Date, Title, and Announcement columns. In SharePoint, you can 
add, remove, and modify the columns. 

If you do not want to use the Announcements page, hide the Announcements link on the 
Activity menu, as described in “Hiding Menu Options (Optional)” on page 116. 

NOTE: Remember to remove out-of-date announcements from the list on the portal 
administration site.

Add FAQs

To create or add to the list of frequently asked questions that portal users can access:

1. In the Lists menu, click FAQs.

2. Click Add new item.

3. On the FAQs - New Item form, add a title, the question, and the answer. You can format 
the answer text to include steps, bullets, bold, italics, and so on.

4. Click Save.

The questions and answers you add become part of the searchable Knowledge Base.

FAQs can contain text, hyperlinks, HTML code, attachments, pictures, and tables. The 
default layout has Question and Answer columns. You can add, remove, and modify the 
columns. The most recently added FAQ is shown at the bottom of the portal FAQs page.

If you do not want to include a link to FAQs, hide the link on the Knowledge Items menu, as 
described in “Hiding Menu Options (Optional)” on page 116.

Update the Knowledge Base

The portal’s Knowledge Base is a search built over the FAQs and White Papers. The 
landing page for the Knowledge Base (/IPFSitePages/Knowledgebase.aspx) by 
default contains a search box, a FAQs section, and a White Papers section.

The FAQs and White Papers sections contain the top five entries on the FAQs and White 
Papers pages. You can change this layout or add other pages to those being searched. Up 
to 10 results are shown per page.

If you do not want to link to a knowledge base, hide the Knowledge Base link on the 
Knowledge Items menu, as described in “Hiding Menu Options (Optional)” on page 116.
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Add to the Video or White Paper Libraries

To add videos or white papers to your portal site, add them to the appropriate libraries in 
SharePoint.

For example, when you add a white paper, you browse to the location of the file:

Then you specify information to describe it on the portal page:

Supported video types are:

 HTML5 Video: If the data value has a file extension of OGV, the video will be formatted 
as an Ogg Video. This requires that the client browser supports HTML5 video.

 QuickTime Video: If the data value has a file extension of MOV, the video will be 
formatted as a QuickTime Video. This requires that the client browser has the Apple 
QuickTime add-in.

 Flash Video: If the data value has a file extension of SWF, the video will be formatted as 
a Flash Video. This requires that the client browser has the Adobe Flash Player add-in.

 YouTube Video: If the data value has the extension .youtube, the video will be formatted 
as a YouTube video. In this case, the contents of the document must be either the 
YouTube video URL or ID as assigned by YouTube.

Video descriptions can contain text, hyperlinks, HTML code, attachments, pictures, and 
tables. The default list layout has Name and Description columns. In SharePoint, you can 
add, remove, and modify the columns. Videos are listed with the newest one first.
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White papers can include any file type that is supported by SharePoint. The default list 
layout has Type, Name, and Date columns. Through SharePoint, you can add, remove, 
and modify the columns. White papers are listed with the newest one first

If you do not want to include links to videos or white papers, hide the links on the 
Knowledge Items menu, as described in “Hiding Menu Options (Optional)” on page 116.

Add Press Releases

We created a portal page using a standard SharePoint library for press releases. Add items 
in the Press Releases page on the portal administration site the same way you add a white 
paper.

Press releases can contain text, hyperlinks, HTML code, attachments, pictures, and tables. 
The default list layout has Type, Date, Title, and Overview columns. In SharePoint, you can 
add, remove, and modify the columns. 

If you do not want to include a link to press releases, hide the link on the Knowledge Items 
menu, as described in “Hiding Menu Options (Optional)” on page 116.

Approving Uploaded Documents

When a document is uploaded on the portal, its status must be changed from Pending to 
Approved in SyteLine, so it is accessible on the portal. 

SyteLine users who are subscribed to the CustomerDocumentUploadAlert publication 
receive notifications when portal users upload documents, so they know when a document 
needs approval. 

To approve a document that a portal user has uploaded:

1. Open the Documents form and select the uploaded document record. 

2. Set the status to Approved. 

3. Save the record. 

Responding to "Contact Us” Requests

When a portal user sends a message from the portal Contact Us page, the message is sent 
to the company e-mail address listed on the SyteLine General Parameters form. You must 
ensure that someone is monitoring and promptly responding to e-mails sent to that 
address.

NOTE: For multi-site implementations, if no e-mail address is specified on the General 
Parameters form in the Primary Site, but it is entered on the General Parameters form 
in other sites, then the Send Questions or Comments button is not displayed on the 
Contact Us page; however, the e-mail address present in other sites is displayed on the 
page.
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Clearing the Portal Cache

For better performance, pictures and translated labels are cached in the Web application 
on the SharePoint server. The first time a label or picture is retrieved, it is added to the 
cache so that subsequent access to the picture or label is faster.

Cached objects remain on the server indefinitely. If you change a picture or update a label, 
you must force a reload of the cache so that the change takes effect immediately. 

To clear the cache, open Portal Manager, select Configuration, and on the General tab, 
click Clear Portal Server Farm Cache. 

If the portal Web application is restarted, the cache is cleared automatically. A low memory 
condition on the server can also cause objects to be cleared from the cache.

Clearing the Portal Manager Log

The Portal Manager log display collects data continuously as portal content is exported, 
imported, and transferred. You should clear the log occasionally, so it does not use up 
space unnecessarily. 

To clear the log display, open Portal Manager, right-click the log display area, and select 
Clear.

Using the Communication Wizard to Send 
Promotions/Announcements to Portal Users

To send out a promotion or announcement to all subscribed portal users, use the SyteLine 
Communication Wizard form to quickly set up and distribute the information.

1. On the first page of the wizard, select the Communication Type (New, Promotion or 
Other).

2. Select Portal Users so the communication will be sent to all portal users who have 
subscribed to this type of publication. This automatically sets the Communication 
Method to E-mail.

3. On the next page of the wizard, enter the subject and the message to send to portal 
users. Be aware that there is no special formatting (fonts, emphasis, etc.) allowed in this 
e-mail.

4. Click Finish to send the e-mail. 
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Pushing Portal Configuration Changes for a New Server in the 
Farm

If a new server is added to your SharePoint server farm, you must push the portal 
configuration changes to STS again. This applies the STS configuration to the new server 
in the farm. To do this manually: 

1. Log in to the SharePoint server using the SPFarm user account credentials. (For a 
SharePoint Standalone installation, see “Set Up User Accounts for SharePoint” on page 
25 for log in information.)

2. In SharePoint Central Administration, select Application Management > Infor Portal 
Foundation Configuration v3.0.0.0. 

3. Click Push Config to STS.

4. Click OK.

5. Close the browser window.

Resetting Pre-Login Permissions

When you install an Infor portal, a membership provider named 
SyteLineMembershipProvider v3.0.0.0 is added in SharePoint. When you configure data 
sources and push to STS to register the authentication data source, a suffix is added to the 
membership provider name; for example, v3.0.0.0s1. And when you set user or group 
permissions in SharePoint, they are assigned to the membership provider with the same 
suffix.

A unique membership provider entry is created in SharePoint for each portal configuration 
you set up, so for example, if you install and configure portals in a test environment and in 
a production environment, you will have two membership providers registered with STS.

If you change an authentication data source in Portal Manager and push to STS or if you 
make changes to user or group permissions assigned in SharePoint, you must then reset 
pre-login permissions, to keep the configuration’s membership providers in sync. 

To reset permissions, select Configuration > General in Portal Manager and click the 
Reset Pre-Login Permissions button. More steps for changing the authentication data 
source are provided in the next topic.

Changing the Authentication Data Source

In the event that you need to change your authentication data source, follow these steps:

1. In Portal Manager select Configuration > Data Sources.

2. Select Authenticator for the appropriate data source and then click Apply. A message 
to push the change to STS is displayed
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3. In the message, click the link to open SharePoint Central Administration, click Push 
Config to STS, click OK, and then close the browser window. Back in Portal Manager, 
click OK to close the message box.

4. In the portal administration site, remove and then reset all permissions. See “Set User 
Group Permissions in SharePoint” on page 48.

5. In Portal Manager, select Configuration > General. 

6. Click Reset Pre-Login Permissions.

Changing IIS Site Bindings

If you change protocol, host name, or port settings that were specified during portal 
installation, you must use the following procedure to change site bindings for digital 
certificates.

NOTE: Review the Explanation and Options sections of the following article for more 
information: http://blogs.msdn.com/b/russmax/archive/2013/02/27/how-
to-properly-change-the-host-header-url-of-a-web-application-in-
sharepoint-2010.aspx

1. In SharePoint Central Administration, select Application Management > Manage web 
applications.

2. Select the Web application to work with.

3. Select Authentication Providers and then select the Zone to change, either Default for 
the administration site or Internet for the production site.

4. Save off the values in:

 ASP.NET Membership provider name; for example, SyteLineMembershipProvider 
v3.0.0.0s1

 ASP.NET Role manager name; for example, SyteLineRoleProvider v3.0.0.0s1

If you are in the settings for the Internet Zone, also save off the value for Sign In Page 
URL; for example, /_layouts/IPF.Manager_v3.0.0.0/IPFLogin.aspx).

5. Close the Edit Authentication window.

6. With the correct Web application still selected, click the down arrow on the Delete button 
and select Remove SharePoint from IIS Web Site.

7. Select the correct zone from the drop-down list and save off the name; for example, Infor 
Portal - Internet or Infor Portal - Administration.

8. Select Yes to delete IIS Web sites and then click OK.

9. Back on the Web Applications tab, select the Web application again and then click 
Extend.

10. Select Create a new IIS web site and use the name saved in step 7.

11. Specify the new Port and Host Header information. This is the new binding information.

12. If this is the Internet Zone, clear the Enable Windows Authentication check box.

13. Select Enable Forms Based Authentication (FBA) and enter values saved in step 4.

14. For the Internet Zone, select Custom Sign In Page and enter the URL saved in step 4.
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15. Specify the Public URL.

16. Select the correct zone, matching the one that was removed.

17. Click OK.
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Overview

This chapter describes the different types of Customer Portal users and explains and 
shows examples of Customer Portal pages after the portal is set up. 

About Customer Portal Users

There can be three types of users of your Customer Portal after it is set up:

 Visitors: Customers who do not register or sign in to the portal can search or browse your 
catalog, see featured products and top seller lists, review your company contact 
information, and access announcements and knowledge item pages. They also can add 
items to the cart and see the Place Order page, but they cannot submit the order online 
or access any other portal pages. 

 Registered B2B users: Customers who have a pre-established account with you, who 
sign in to the portal after being registered by you, and whose method of payment is On 
Account are considered to be registered business-to-business users. They may also be 
able to pay by credit card, depending on how you set them up in SyteLine. They can 
access all standard Customer Portal pages and functions.

 Registered B2C users: Customers who are registered (either by you or by themselves 
using the portal), who sign in to the portal, and whose only method of payment is Credit 
Card are considered to be registered business-to-consumer users. They can access all 
standard Customer Portal pages and functions, with these exceptions:

 B2C users cannot add an item to an order on the Place Order page. This feature is 
referred to as Quick Order, and is provided for only B2B users.

 B2C users cannot specify a Requested Ship Date on the Place Order page. This 
feature is provided for only B2B users.

 B2C users cannot upload documents in the portal.

 B2C users can check for break prices on qualifying items, but they cannot select 
items from alternate sites or add items to an order using the Pricing Options form. 

 B2C users do not have access to these pages: Contract Order, Account Balance, 
Invoices, Estimates, Inventory, or Consigned Inventory.

NOTE: Information about setting up portal users is provided in Chapter 7, “Setting Up and 
Managing SyteLine User Accounts for the Portal(s)”.
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About Customer Portal Pages

The Web pages provided in the Customer Portal are listed in the following table and 
grouped by function when applicable. A column is provided to indicate which types of users 
can access each page.

Portal Page
Users Who 
Have Access

Described on 
Page

Pre-Login Home page All 133

Register All 134

Home page and portal menus All 134

Pages for Finding Items to Order

Products All 137

Top Sellers All 138

Featured Products All 138

Pages for Adding Items to an Order

Products All 137

Product Details (accessed from item links on other pages) All 139

Contract Order B2B 140

Place Order (only B2B users can add items using this page) All 140

Page for Reviewing and/or Placing the Order

Place Order All 140

Activity Pages

Estimates B2B and B2C 141

Order Status B2C and B2B 141

Returns B2C and B2B 142

Documents B2C and B2B 142

Interactions B2C and B2B 143

Announcements All 143

Account Balance B2B 144

Invoices B2B 144

Inventory B2B 145

Consigned Inventory B2B 145

Knowledge Item Pages (under Activity menu)

Press Releases B2C and B2B 145

Video Library B2C and B2B 145

Knowledge Base All 146

White Papers B2C and B2B 146

FAQ All 146

Service Pages (under Activity menu)

Unit Registration B2C and B2B 146
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The remaining sections in this chapter show and briefly describe each portal page. 
Instructions for using each page are provided as online help topics in the Customer Portal. 
You can click the help icon in the upper right corner of each portal page to review the 
instructions. If the content provided isn’t suitable for your portal, you can personalize your 
online help as described in “Updating or Hiding Online Help (Optional)” on page 116.

Accessing the Portal

To access the portal, users open their favorite supported browser and enter the portal URL. 
The portal pre-login Home page is displayed, where users can choose to sign in, register, 
or shop as a visitor.

Service Incidents B2C and B2B 147

Service Knowledge Base B2C and B2B 147

Account Pages

Inbox B2C and B2B 148

Contact Us All 148

Account Management B2C and B2B 149

Portal Page
Users Who 
Have Access

Described on 
Page
Infor SyteLine Portals Setup and Administration Guide 
Copyright © 2014 Infor 



134  Customer Portal Users and Pages Overview 
Register

This form is displayed if users choose Sign In > Register Here on the pre-login Home 
page.

Home Page and Menus

The menu bars at the top and bottom of the Home page are available on all pages of the 
Web site. Links provided in each menu are described below.

Top Menu Bar

On this menu bar, users can:

 Click the Web site logo to return to the Home page.

 Click the help icon to access a help topic about the current page. The icon is displayed 
only if help is available for the page.

 View shopping cart status and click the cart for additional options.

 Access the Shop, Activity, or Account menus. You must be signed in to see the 
Activity and Account menus.

Shop Menu

Options on this menu are used to browse or search the product catalog. A category 
browser menu may be displayed, so users can scroll through product categories and click 
a category or subcategory to see available products.
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Options include:

 All Products: To find items to order from the entire catalog.

 Top Sellers: To find items in a list of top selling products.

 Featured Products: To find items in a list of featured products.

 Place Order: For placing an order after adding products. Registered business-to-
business customers can also add items to the order on this page using “quick order” 
fields, if the item number is known.

 Contract Order: For registered business-to-business customers to add contracted items 
to an order.

Activity Menu

For customers who sign in, this menu is used to access these pages:

 Order Status: To view order status.

 Returns: To request to return an item.

 Documents: To download relevant documents. Registered business-to-business 
customers can also upload documents using this page.

 Interactions: To enter messages to send us and respond to messages we send you.

 Announcements: To view company announcements.

 Knowledge Items: For accessing additional pages, including Press Releases, Video 
Library, Knowledge Base, White Papers, and Frequently Asked Questions (FAQ).

 Service: For accessing Unit Registration, Service Incidents, and Service Knowledge 
Base pages.

If you are a registered business-to-business customer, you may have these additional 
options on the Activity menu:

 Account Balance: To get account balance information.

 Invoices: To request reprints of invoices.

 Estimates: To look up estimates.

 Inventory: To see contracted inventory items.

 Consigned Inventory: To check replenishment needs for consigned inventory items, and 
submit used quantity.

Account Menu

For customers who sign in, this menu is used to access these pages:

 Inbox: For receiving messages on the Inbox page.

 Contact Us: To contact our company.

 Account Management: For adding to or updating account information. Some users may 
also have the option to add new users to their account.

Click Sign Out to log out of the portal.
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Bottom Menu Bar

On this menu bar, users can:

 Select a language for Web site content.

 Click links to access the Home page, Products page, or Contact Us page.

 Click the Help link to access a list of help topics.

 Click links to access the Privacy Policy, Terms of Use, and Purchase Terms and 
Conditions pages.

 Search the product catalog.

Finding Items to Order

Click Shop to access pages for finding items to order. A category browser menu with a 
drop-down submenu may also be provided.

A keyword search bar is included at the top of the Products page. The search bar allows 
users to search for categories of items, if available, or individual items. 

Users also can find items to order using the Top Sellers and Featured Products pages.

When users find an item of interest, they can click the item number, picture, or name to see 
its Product Details page.
Infor SyteLine Portals Setup and Administration Guide 
Copyright © 2014 Infor 



Customer Portal Users and Pages Overview         137
Products

Click All Products on the Shop menu to display the Products page.

On this page, users can search for items to order, filter and sort items to refine their search, 
add items to an order, and check for pricing options.

For customers who register and sign in, your company’s discounted price and savings is 
displayed, if applicable.

When users open this page from the Shop menu, all products in the catalog are displayed. 
If users open this page by clicking a category in the browser menu or by clicking a category 
from a category search, all products in the selected category are displayed. 
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Top Sellers

Click Top Sellers on the Shop menu to display the Top Sellers page.

Top selling items are displayed on this page, along with the product picture, number, and 
name, and the discounted price for the product. 

Click a product picture, number, or name to go to the Product Details page. Users can see 
more information and add the product to an order from the Product Details page.

Featured Products

Click Featured Products on the Shop menu to display the Featured Products page.

Featured products are displayed on this page, along with the product picture, number, and 
name, and the discounted price for the product. 

Click a product picture, number, or name to go to the Product Details page. Users can see 
more information and add the product to an order from the Product Details page.
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Product Details

Access this page by clicking the product picture, number, or name on other pages.

This page is used to view details about an item in the online store. Users can also add the 
item to an order using this page.
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Contract Order

Click Contract Order on the Shop menu to display the Contract Order page.

This page is provided for only registered business-to-business customers who contract 
with you for certain items.

This page is used to add contracted items to an order. 

Place Order

Click Place Order on the Shop menu to display the Place Order page.

This page is used to submit an order for products added from other pages in the online 
store.
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Estimates

Click Estimates on the Activity menu to display the Estimates page, where customer 
Estimates are displayed.

This page is available for only registered business-to-business customers.

Order Status

Click Order Status on the Activity menu to display the Order Status page, where customer 
orders are displayed.
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Returns

Click Returns on the Activity menu to display the Returns page, where customer return 
material authorizations are displayed.

This page is used to:

 View existing return material authorizations (RMAs). 

 Create a request for an RMA so that you can return an item.

 Cancel a request for an existing RMA.

Documents

Documents are image, text, PDF, or other types of files that are attached to customer, 
order, item, and estimate records, to provide additional information. Documents can 
provide general information, such as material specifications and material safety data 
sheets, and be made available to all Web site users. Documents also can provide specific 
information, such as contractual requirements and shipping instructions, and be made 
available to individual customers. Registered business-to-business customers can attach 
documents by uploading them on the Web site. 

Click Documents on the Activity menu to display the Documents page.
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Interactions

Interactions are messages sent back and forth about a particular order, estimate, item, or 
consigned item. Interactions specific to these records can be accessed from the Order 
Status, Product Details, Estimates, and Consigned Inventory pages, respectively. Or users 
can search through all interactions, listed by date, on the Interactions page.

Click Interactions on the Activity menu to display the Interactions page.

Announcements

Click Announcements on the Activity menu to display the Announcements page, where 
company announcements are displayed for customers.
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Account Balance

Click Account Balance on the Activity menu to display the Account Balance page, where 
customer account balances are displayed. 

This page is provided for only registered business-to-business customers whose payment 
method is On Account.

Invoices

Click Invoices on the Activity menu to display the Invoices page, where customer invoices 
are displayed.

This page is available for only registered business-to-business customers.
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Inventory

Click Inventory on the Activity menu to display the Inventory page, where customer 
contracted inventory items from all sites and warehouses are displayed. 

This page is available for only registered business-to-business customers.

Consigned Inventory

Click Consigned Inventory on the Activity menu to display the Consigned Inventory 
page, where customer consigned items are displayed.

This page is available for only registered business-to-business customers.

Press Releases

Click Knowledge Items on the Activity menu and then click Press Releases to open the 
Press Releases page.

Video Library

Click Knowledge Items on the Activity menu and then click Video Library to display the 
Video Library page.
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Knowledge Base

Click Knowledge Items on the Activity menu and then click Knowledge Base to display 
a knowledge base where customers can search for information.

White Papers

Click Knowledge Items on the Activity menu and then click White Papers to display the 
White Papers page.

Frequently Asked Questions (FAQ)

Click Knowledge Items on the Activity menu and then click FAQ to display a list of 
questions and answers. 

Unit Registration

Click Service on the Activity menu and then click Unit Registration to display the Unit 
Registration page.

This page is used to register units under warranty.
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Service Incidents

Click Service on the Activity menu and then click Service Incidents to display the Service 
Incidents page.

This page is used to review existing incidents, add notes or attach documents to an 
incident, and enter new incidents.

Service Knowledge Base

Click Service on the Activity menu and then click Service Knowledge Base to display 
the Service Knowledge Base page. 

This page is used to find and review service information stored in the service knowledge 
base.
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Inbox

Click Inbox on the Account menu to open the Inbox page, where messages you have sent 
your customer are displayed.

Contact Us

Click Contact Us on the Account menu to open the Contact Us page, where your contact 
information is displayed. 
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Account Management

Click Account Management on the Account menu to open the Account Management 
page.
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The Reseller Portal provides new Web pages and functionality for your customers who are 
set up as resellers in SyteLine. This portal also includes all of the pages from the Customer 
Portal, which the reseller can use as your customer or for reseller tasks. For example, 
Reseller Portal users can:

 Place orders for themselves or for their customers

 Check order status for themselves or for their customers

 Look up estimates for themselves or for their customers

This chapter describes and shows examples of Reseller Portal features and pages after the 
portal is set up. 

Reseller-Only Features of Customer Portal Pages

On many of the Reseller Portal pages that are inherited from the Customer Portal, the 
reseller can select a customer to “pose as”, so the reseller can see information and perform 
tasks specific to that customer. 

Also, some of the portal pages inherited from the Customer Portal display commission 
amounts for the reseller.

This table shows which pages provide one or both of these reseller-only features:

Page Name Includes Customer Option Displays Commission Amount

Products X X

Product Details X X

Contract Order X X

Place Order X X

Featured Products X X

Top Sellers X X

Home Page X

Order Status X

Estimates X

Returns X

Account Management X
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Reseller-Only Portal Pages

These pages are provided for resellers only:

The remaining sections in this chapter show and briefly describe each Reseller Portal 
page. Additional instructions for using each page are provided as online help topics in the 
Reseller Portal. You can click the help icon in the upper right corner of each portal page to 
review the instructions. If the content provided isn’t suitable for your portal users, you can 
personalize the online help as described in “Updating or Hiding Online Help (Optional)” on 
page 116.

NOTE: For information about the pages in Reseller Portal that are inherited from the 
Customer Portal, see Chapter 11, “Customer Portal Users and Pages Overview” .

Service Orders

Click Service on the Activity menu and then click Service Orders to display the Service 
Orders page.

This page is used to review service request order (SRO) information. 

Portal Page See Page

Service Orders 152

Service Order Transactions 153

Customers 153

Commissions Due 154
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Service Order Transactions

Click Service on the Activity menu and then click Service Order Transactions to display 
the Service Order Transactions page. You can also access this page by clicking a service 
order number on the Service Orders page.

This page is used to:

 Review transactions recorded against a selected service request order (SRO)

 Post material, labor, and miscellaneous expenses to an SRO

 Change or delete SRO transactions that have a status of Submitted

Customers

Click Customers on the Account menu to display the Customers page.

This page is used to view information about existing customers and to register new 
customers. 
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Resellers will receive commission on all orders placed in our online store by these 
customers.

Users can also generate a redirect link to the portal using this page, which can be copied 
and displayed on their Web site or e-mailed directly to customers. In order for customers to 
be associated with the right reseller account, they must use this link to access the portal.

Commissions Due

Click Commissions Due on the Account menu to display the Commissions Due page. 

This page is used to review commission amounts due and statuses.
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This chapter describes and shows examples of Vendor Portal pages after the portal is set 
up. 

Instructions for using each page are provided as online help topics in the Vendor Portal. 
You can click the help icon in the upper right corner of each portal page to review the 
instructions. If the content provided isn’t suitable for your portal, you can personalize the 
online help as described in “Updating or Hiding Online Help (Optional)” on page 116.

Portal page
Described 
on page

Login 156

Home page and portal menus 156

Purchase Orders 157

Planned Orders 157

Consigned Inventory 158

Inventory Level Projection 158

On Time Delivery 158

Product Price Contracts 159

Item Price Requests 160

Documents 160

Interactions 161

Announcements 161

Press Releases 161

Video Library 161

Knowledge Base 162

White Papers 162

FAQ 162

Inbox 162

Contact Us 163

My Profile 163

My Company Profile 164
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Login Page

To access the portal, users open their favorite supported browser and enter the URL. The 
portal Login page is displayed.

Home Page and Menus

The menu bars at the top and bottom of the Home page are available on all pages of the 
Web site. Links provided in each menu are described below.

Top Menu Bar

On this menu bar, users can:

 Click the Web site logo to return to the home page

 Click the help icon to access a help topic about the page you’re on. The icon is displayed 
only if help is available for the page.

 Access the Activity and Account menus.

Activity Menu

On this menu bar, users can access these pages:

 Purchase Orders: To view purchase order status.
 Planned Orders: To review planned orders and convert them to purchase orders or 

purchase order requisitions.
 Consigned Inventory: For checking replenishment needs for consigned inventory items, 

and evaluating past consumption.
 Inventory Level Projection: For checking projected inventory for an item.
 On Time Delivery: For checking on-time delivery percentages for purchase order lines.
 Product Price Contracts: To review and update product price contracts.
 Item Price Requests: To review and respond to item price requests.

 Documents: To upload and download relevant documents. 

 Interactions: To enter messages to send and respond to messages received.

 Announcements: To view company announcements.

 Knowledge Items: For accessing additional pages, including Press Releases, Video 
Library, Knowledge Base, White Papers, and Frequently Asked Questions (FAQ).

Account Menu

On this menu bar, users can access these pages:

 Inbox: For receiving messages on the Inbox page.

 Contact Us: To contact your company.

 My Profile: For updating personal profile information.

 My Company Profile: For updating company profile information.
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Click Sign Out to log out of the portal.

Bottom Menu Bar

On this menu bar, users can:

 Select a language for Web site content.

 Click links to access the Home page or Contact Us page.

 Click the Help link to access a list of help topics. 

 Click links to access the Privacy Policy and Terms of Use pages.

Purchase Orders

Click Purchase Orders on the Activity menu to display the Purchase Orders page.

On this page, purchase orders with a status of “Ordered” or “Complete” are displayed. 
Orders are sorted first by status in descending order and then by order date in ascending 
order. For example, the oldest PO that is still in “Ordered” status is displayed first. 

Planned Orders

Click Planned Orders on the Activity menu to display the Planned Orders page.

This page is used to review planned orders generated during the latest planner run for the 
items vendors supply. Vendors may also be able to confirm planned orders online, to 
convert them to purchase orders or purchase order requisitions. 
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Consigned Inventory

Click Consigned Inventory on the Activity menu to display the Consigned Inventory 
page.

On this page, consigned items are listed, starting with items that have the greatest need for 
replenishment. Suggested Replenishment is calculated by subtracting On Hand Qty 
from the Min Qty. 

Inventory Level Projection

Click Inventory Level Projection on the Activity menu to display the Inventory Level 
Projection page. 

This page displays the projected inventory level in tabular format for a selected item and 
date range. It also shows a comparison between the safety stock level and inventory level 
in graph format for the given date range.

NOTE: Projected inventory levels displayed on the portal do not include planned orders. 

On Time Delivery

Click On Time Delivery on the Activity menu to display the On Time Delivery page. 

This page is used to review on-time delivery percentage for a given month range, and by 
shipped-to location if applicable. On-time delivery values are found by comparing the total 
number of purchase order lines due with the number of those lines received in full by the 
due date, or partially received with a status of “Filled” or “Complete”.
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Value calculations consider:

 Data from all sites that are part of a multi-site company

 Both regular and blanket purchase orders

 Purchase orders with a status of “Ordered” or “Complete”

 Purchase order lines or releases with a status of “Ordered”, Filled”, or “Complete” and a 
line or release due date that is less than the last day of the current month

Product Price Contracts

Click Product Price Contracts on the Activity menu to display the Product Price 
Contracts page. 

On this page, contracted items are listed in ascending order by item number. This page is 
used to:

 Review approved and pending price contracts for the items.

 Submit a new price break request for approval, for an existing contract.

 Update pricing information for pending requests.

 Delete pending requests that have not yet been approved.

 View and enter interactions for a selected product price contract.

 View and upload documents for a selected product price contract.
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Item Price Requests

Click Item Price Requests on the Activity menu to display the Item Price Requests page.

On this page, item price requests are displayed in descending order by response due date. 
This page is used to review price requests and respond to them. Vendors can also update 
or delete price responses that have not been accepted or closed.

Documents

Documents are image, text, PDF, or other types of files that are attached to purchase order 
and product price contract records, to provide additional information. Documents can 
provide general information, such as shipping terms and general contract specifications, 
and be made available to all portal users. Documents also can provide specific information, 
such as order requirements and material test results, and be made available to individual 
vendors. Vendors can attach documents by uploading them in Vendor Portal as described 
below.

Click Documents on the Activity menu to display the Documents page. 
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Interactions

Interactions are messages sent back and forth about a particular purchase order, item price 
request, product price contract, or consigned item. Interactions specific to these records 
can be accessed from the Purchase Orders, Item Price Requests, Product Price Contracts, 
and Consigned Inventory pages, respectively. Or vendors can search through all 
interactions, listed by date, on the Interactions page.

Click Interactions on the Activity menu to display the Interactions page. 

Announcements

Click Announcements on the Activity menu to display the Announcements page, where 
company announcements are displayed for vendors.

Press Releases

Click Knowledge Items on the Activity menu and then click Press Releases to open the 
Press Releases page.

Video Library

Click Knowledge Items on the Activity menu and then click Video Library to display the 
Video Library page.
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Knowledge Base

Click Knowledge Items on the Activity menu and then click Knowledge Base to display 
a knowledge base where users can search for information.

White Papers

Click Knowledge Items on the Activity menu and then click White Papers to display the 
White Papers page.

Frequently Asked Questions (FAQ)

Click Knowledge Items on the Activity menu and then click FAQ to display a list of 
questions and answers. 

Inbox

Click Inbox on the Account menu to open the Inbox page.
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Contact Us

Click Contact Us on the Account menu to open the Contact Us page.

This page displays contact information for your company. 

My Profile

Click My Profile on the Account menu to display the My Profile page.

This page displays the information you have about each user. Users can edit their full name 
e-mail address, and notification subscriptions. They can also change their password from 
this page.
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My Company Profile

Click My Company Profile on the Account menu to display the My Company Profile page.

This page displays the information you have about each user’s company. Users can edit 
most information on this page.
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The Portal Manager provides developers and administrators with diagnostic logging 
functionality and the Diagnostic Viewer, an advanced monitoring tool that shows real-time 
trace log and event activity. These features allow you to collect, filter, and view diagnostic 
log data from the SharePoint server(s). The log messages provide internal details about 
the progress or trace log of SharePoint portal applications and custom script.

This chapter covers these topics about portal diagnostics: 

Logging Diagnostic Messages

We recommend that you enable diagnostic logging only when you need information for 
troubleshooting, which minimizes performance impact on your system. When you have 
determined that certain portal events need to be monitored, you can enable logging on 
specified servers and events.

To configure diagnostic logging:

1. Open Portal Manager and connect to the portal for which to log events.

2. Select Diagnostics.

3. Select Start/Stop Logging.

4. Select the server(s) to log.

5. Select the event(s) to log. When you select a category, all events within the category are 
selected. You can expand the categories to select or clear individual events. As long as 
one event is selected within a category, the category remains selected.

Topic See Page

Logging Diagnostic Messages 165

Viewing Diagnostic Messages 166

Filtering Diagnostic Messages 168

Understanding Diagnostic Messages 169

Saving and Loading Diagnostic Log Files 178
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6. Click the Save icon on the right side of the screen.

You can update the configuration any time by changing your selections and clicking 
Save. The new configuration is saved and used each time you enable logging, until you 
change the configuration and save again.

To stop logging, clear the Start/Stop Logging check box.

NOTE: If multiple administrative users connect to the same portal to run diagnostics, they 
will all see the last server and event configuration saved by any user. To change 
servers and events logged without affecting all users, use the filtering options 
described in “Filtering Diagnostic Messages” on page 168. These setting apply to only 
your local Diagnostic Viewer.

Unexpected Errors

There are times when a message is logged in diagnostics even if you have not enabled 
logging in Portal Manager. An API has been added to the portal pages which forces a 
message into the log when an unexpected error occurs, including:

 The IDO collection load fails

 A custom load method fails

 A call to a backend stored procedure fails

 Saving changes to SyteLine fails

For these types of unexpected errors, the following message is displayed to the portal user: 
“The system encountered an unexpected error. Refresh the screen and try again. If the 
problem continues, please contact the Web site administrator. Error: <number>.”

A different error number is system-generated each time one of these types of error occurs. 
You can search for the error number in portal diagnostics to troubleshoot the problem.

Viewing Diagnostic Messages

After you have configured and enabled logging, diagnostic logs can be collected and 
viewed in real time using the Diagnostic Viewer. The Viewer is launched in a separate 
window, so you can use Portal Manager and the Viewer at the same time.

To view diagnostic messages:

1. Click Launch Viewer. 

2. Click the Start (traffic signal) icon.

NOTE: If you encounter problems at this stage, see “Diagnostics Viewer Error” on page 
184. 
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3. As the Viewer collects data, you can use these toolbar and Edit menu options:

Message Detail

Detail information for diagnostic messages can be reviewed at the bottom of the Viewer 
form, in grid or XML format.

Status Bar

The status bar shows the total number of diagnostic records collected and the position of a 
selected record in the grid. When the Viewer is connected to the server, it also displays 
icons for server and user status. 

Server Status: Click the icon (or select Edit > Server Status) to open the Server Statuses 
form. On this form, servers with a green icon are online and the Windows Service is 
available. Servers with a red icon are either offline or the Windows Service is not started or 
not responsive. You can right-click a server on the Server Status form to perform these 
actions:

 Restart the diagnostic service: The restart is performed on the selected server if the 
service is stopped.

 Erase the diagnostic log: This clears every diagnostic log from the server’s event log, 
without backing them up.

NOTE: To restart the diagnostic service or clear the diagnostic log, you must be an 
administrator or member of the administrators group on the server.

Option Description

Stop Stops the Viewer from collecting data. This does not stop events from being 
logged on the server.

Modify Filter Opens the Filter Configuration form, so you can set up a new filter or load an 
existing one. See “Filtering Diagnostic Messages” on page 168.

Clear Filter Clears modifications made to the filter.

Erase Grid Clears the collected events from the Viewer log.

Auto Scroll Positions the record pointer at the end of the log file, so you can see each new 
event as it is added.

Note Allows you to add a note to each diagnostic log record as it is saved to a file 
using the File menu command.

Highlight Highlights all events in a column with the same value when you hover over a 
particular field value.

Find Allows you to search all cells in all displayed diagnostic logs for specified text.

Column Chooser Opens the Choose Columns form, so you can select and position columns to 
display in the Viewer.

Server Status Opens the Server Statuses form, so you can see the status of specified 
servers and perform actions on them. See “Status Bar” on page 167.

User Status Opens the User Status form, so you can see which users are signed in to the 
Diagnostic Viewer.

Reset Log Order You can sort data log data by clicking column headers. To set data in the log 
back to its original order, click Reset Log Order.
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User Status: Click the icon (or select Edit > User Status) to open the User Status form. 
This form shows which users are signed in to the Diagnostic Viewer.

Filtering Diagnostic Messages

Using the Filter Configuration form, you can refine which logged message are displayed 
in the Portal Manager Diagnostics Viewer for yourself, without affecting other users. For 
example, you could specify: User - Contains - <yourportalusername>.

To filter the diagnostic viewer messages:

1. Open the Diagnostic Viewer and select Edit > Modify Filter.

2. Select servers and events to filter.

3. Specify dates in the past during which to show messages for the specified servers and 
events.

4. To further restrict collected events, you can specify additional criteria in the section near 
the bottom of the form. If necessary, you can group conditions in your custom filter 
criteria.

5. Click Apply.

Saving and Loading Filter Configurations

You can save and reuse filter configurations as needed. This can be helpful, for example, to 
find common characteristic between two sets of data or to show another portal 
administrator how to trim down a set of logs to find a particular trend. 

Filter configurations are saved to the server farm, where they can be accessed at any time 
by any Portal Manager instance connected to that farm. 

To save and later load a filter configuration:

1. After setting up and applying the filter on the Filter Configuration form, select File > 
Save Filter on that form.

2. Specify a name for the filter. You can choose to overwrite an existing filter.

3. Click Save Filter. The filter is saved to the farm.

4. To reuse that filter, simply open the Filter Configuration form, select File > Load Filter, 
select the filter to use, and then click OK. Click Apply to apply the filter to diagnostic 
messages.
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Understanding Diagnostic Messages

This section describes all diagnostic messages the architecture can log. All messages 
have a base set of parameters:

 Application: The name of the Web application logging the message.

 Url: The absolute URL logging the message.

 User: The user name currently signed in.

 Category: The type of message being logged.

 Event: The name or title of the diagnostic message. Some are predefined in the 
architecture; however, developers can create their own.

 Title: The name and location of the field display format or Web Part creating this 
diagnostic message. For example: 

 TopBarGrid in IPFDemo_TopMenu with IPFDemo_FDF_TopBarGrid. This is the 
name of the cell (TopBarGrid), the parent layout (IPFDemo_TopMenu), and the 
name of the field display format on the cell (IPFDemo_FDF_TopBarGrid).

 Grid Web Part on /IPFSitePages/IPFDemo_Barcodes.aspx. This is the name of the 
Web Part (Grid Web Part), the location of the page it’s on (IPFSitePages), and the 
page file name (IPFDemo_Barcodes.aspx). 

Administration Messages

Event Explanation Additional Parameters

PushToSTS The STS configuration file has 
been updated.

ContentChanges
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Authentication Messages

Translation Messages

Event Explanation Additional Parameters

SuccessfulLogin The login attempt is successful. User

Status

FailedLogin The login attempt is unsuccessful. User

Status

Failed Login

AccessDenied The user does not have the 
required credentials to access the 
given resource.

User

Status

MongooseCryptLogonKey An authentication request is made 
through Mongoose.

ServerSpec

Configuration

SessionID

MongooseCryptLogonKey
Response

The response to the authentication 
request made through Mongoose.

ServerSpec

Configuration

SessionID

MongooseOpenSession Opening a Mongoose session. ServerSpec

SessionID

LoginAttempt 

UserName

Configuration

ApplicationName

MachineName

DomainUserName

AllowCloseExitingSessions

Workstation

MongooseOpenSessionRe
sponse

The response to the opening of a 
Mongoose session.

ServerSpec

Configuration

SessionID

LoginSucceeded

ConnectedAs

Event Explanation Additional Parameters

MongooseLoadStrings A call is made to Mongoose to 
translate stringIDs.

ServerSpec

Configuration

SessionID

String Table

Default Group

LCID

String(s)

MongooseLoadStringsRes
ponse

The response to the 
MongooseLoadStrings call.

ServerSpec

Configuration

SessionID

String(s)
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Data Source Messages

Event Explanation Additional Parameters

DatasourceSharePointDetail
s

A data fetch has succeeded, and if 
logged, this event will contain the 
details of the fetch.

DataSourceType

DataSourceName

ViewFields

Query

ResultDetails

DatasourceFetchCall A data fetch has been attempted. DataSourceType

DataSourceName

Collection

MappedCollection

Identifying Values

Fetching

Read Only Record Flag Properties 
Fetched

DatasourceFetchSuccess The data has been fetched 
successfully.

DataSourceType

DataSourceName

Collection

MappedCollection

Result

DatasourceFetchFail The data fetch has failed. DataSourceType

DataSourceName

Collection

MappedCollection

Error

DatasourceFetchResults This event controls the 
ResultDataTable property of the 
DatasourceFetchSuccess event. If 
this event is not logged, the 
property is empty.

Result

NewBookmark

RowsReturned

ResultDataTable

DatasourceAddCall A record is being added to a 
collection.

Collection

MappedCollection

Modified Values

Modified Keys

Modified Read Only Properties

Refreshing

DatasourceAddCallSuccess A record has been added 
successfully.

Collection

MappedCollection

Result

DatasourceAddCallFail An attempt to add a record to a 
collection has failed.

Collection

MappedCollection

Error
Infor SyteLine Portals Setup and Administration Guide 
Copyright © 2014 Infor 



172  Using Portal Diagnostics 
DatasourceUpdateCall A data update has been 
attempted.

DataSourceType

DataSourceName

Collection

MappedCollection

Identifying Values

Modified Values

Modified Keys

Input Values

Refreshing

DatasourceUpdateSuccess A data update has succeeded. DataSourceType

DataSourceName

Collection

MappedCollection

Result

DatasourceUpdateFail A data update has failed. DataSourceType

DataSourceName

Collection

MappedCollection

Error

DatasourceDeleteCall A data delete has been attempted. DataSourceType

DataSourceName

Collection

MappedCollection

Deleting

DatasourceDeleteSuccess A data delete has succeeded. DataSourceType

DataSourceName

Collection

MappedCollection

Result

DatasourceDeleteFail A data delete has failed. DataSourceType

DataSourceName

Collection

MappedCollection

Error

DatasourceMethodCall A datasource method has been 
called.

DataSourceName

MethodClass

Method

Parameters

ReturnValue

DatasourceMethodSuccess A datasource method has 
completed successfully.

DataSourceName

MethodClass

Method

Parameters

ReturnValue

Event Explanation Additional Parameters
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DatasourceMethodFail A datasource method has failed. DataSourceName

MethodClass

Method

Parameters

ReturnValue

DatasourceTableMethodCall A datasource method which 
returns a dataset has been called.

DataSourceName

MethodClass

Schema

Parameters

Method

Record Cap

DataSourceTableMethodSuc
cess

A datasource method which 
returns a dataset has been 
completed successfully.

DataSourceName

MethodClass

Schema

Parameters

Method

Record Cap

RowsReturned

ReturnValue

DatasourceTableMethodFail A datasource method which 
returns a dataset has failed.

DataSourceName

MethodClass

Schema

Parameters

Method

Record Cap

Error

DatasourceCollectionDefiniti
onCall

A datasource collection definition 
is being retrieved.

Collection

DatasourceCollectionDefiniti
onSuccess

The collection definition has been 
successfully retrieved.

Collection

MappedCollection

DataSourceType

DataSourceName

Properties

Identifying Properties

Diagnostic

DatasourceCollectionDefiniti
onFail

The collection definition has failed. Collection

Error

Event Explanation Additional Parameters
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SyteLine Data Source Messages

These messages relate specifically to the SyteLine data source.

Event Explanation Additional Parameters

MongooseInvoke A SyteLine method is being 
invoked.

ServerSpec

Configuration

SessionID

XMLRequest

MongooseInvokeResponse ServerSpec

Configuration

SessionID

XMLResponse

MongooseLoad Records are being loaded from a 
SyteLine datasource.

ServerSpec

Configuration

SessionID

IDO Name

XMLRequest

MongooseLoadResponse ServerSpec

Configuration

SessionID

XMLResponse

MongooseUpdate Records are being updated in a 
SyteLine datasource.

ServerSpec

Configuration

SessionID

XMLRequest

MongooseUpdateResponse ServerSpec

Configuration

SessionID

XMLRequest

MongooseSaveDataTable Records are being added to a 
SyteLine datasource.

ServerSpec

Configuration

SessionID

MongooseSaveDataTableR
esponse

ServerSpec

Configuration

SessionID

MongooseGetPropertyInfo Information about a property on a 
SyteLine collection is being 
retrieved.

IDO Name

ServerSpec

Configuration

SessionID

MongooseGetPropertyInfoR
esponse

ServerSpec

Configuration

SessionID

IDO Name

Properties

XMLResponse
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SQL Data Source Messages

MongooseDelete Records in a SyteLine datasource 
are being deleted.

ServerSpec

Configuration

SessionID

MongooseDeleteResponse ServerSpec

Configuration

SessionID

MongooseGetIDONames The IDO names in a SyteLine 
datasource are being retrieved.

ServerSpec

Configuration

SessionID

MongooseGetIDONamesRe
sponse

ServerSpec

Configuration

SessionID

IDO Names

Event Explanation Additional Parameters

SQLDelete Records in a SQL datasource are 
being deleted.

DataSourceType

DataSourceName

CommandText

Timeout in Seconds

SQLInsert Records in a SQL datasource are 
being inserted.

DataSourceType

DataSourceName

CommandText

Timeout in Seconds

SQLSelect Records in a SQL datasource are 
being selected.

DataSourceType

DataSourceName

CommandText

Timeout in Seconds

SQLUpdate Records in a SQL datasource are 
being updated.

DataSourceType

DataSourceName

CommandText

Timeout in Seconds

Event Explanation Additional Parameters
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Server Processing Messages

These events indicate activity on the server side, often in response to client-side activity:

Client Scripting Messages

These events fire on the client. They typically happen before client-side handlers or as a 
result of a client scripting operation.

Event Explanation Additional Parameters

FileUploaded A file has been received by the 
server.

DatumRendered A field has been rendered. FDFName

FDFClass

FDF ID

IsHeader

Style

Input Value

HTML Tag

DatumRenderError A field has failed to render. FDFName

FDFClass

FDF ID

IsHeader

Style

Input Value

HTML Tag

Error

ImageRenderError An image has failed to render. Error

FilterReceived A filter has been received by the 
server.

FDFName

FDFClass

Received Filter

Processed Filter

Where Clause

Orderby Clause

Properties Not In Collection

Properties Not Filterable

Event Explanation Additional Parameters

ClientComponentClickedHan
dler

A component click is being processed.

ClientDataChangedHandler The data in a component has been 
changed on the client.

ClientScriptCompileError A client script failed to compile.

ClientScriptCompileWarning A client script has a compile warning.

ClientScriptExecuting A client script method is executing.

ClientScriptRuntimeError A client script failed to run.
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Server Scripting Messages

The following events pertain to server scripting:

ClientAlertSent An alert has been sent from a 
component.

ClientCookieSet A cookie has been set.

ClientSessionVariableSet A session variable has been set.

ClientLayoutVariableSet A layout variable has been set.

FillinEnteredHandler A fillin has been entered by the user.

FillinExitedHandler A fillin has been exited by the user.

Event Explanation Additional Parameters

ScriptExecuting A server-side script method is executing. Layout Name

Event Name

ServerScriptRuntimeError Server-side code throws an exception 
during execution.

LayoutName

Event Name

Runtime Error

ServerScriptCompileError Server-side code has a compile error. Layout Name

Event Name

Compile Error

ServerScriptCompileWarni
ng

Server-side code has a compile warning.

NotLicensed The developer is not licensed to run custom 
code from the given layout.

Layout Name

Event Name

Not Licensed

FilterChangedHandler A filter-changed event is being processed 
on the server side.

FDFName

FDF ID

IsHeader

FDFClass

Style

Input Value

ComponentClickedHandler A component-click event is being processed 
on the server side.

FDFName

FDF ID

IsHeader

FDFClass

Style

Input Value

ModalClosedHandler A modal-window-closed-event is being 
processed on the server side.

FDFName

FDF ID

IsHeader

FDFClass

Style

Input Value

Event Explanation Additional Parameters
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Custom Metrics

This category is used for all diagnostic messages triggered by the developer’s scripting 
code. 

Saving and Loading Diagnostic Log Files

When you are not collecting messages in real-time mode, either because you have 
stopped logging or you are viewing results after applying a filter, you can save the current 
collection of messages to a local log file on your hard drive. Select File > Save and save 
the log file in XML or CSV format.

To review that file later in the Diagnostic Viewer, select File > Open and then locate and 
load the file.

TableMethodPutBack A table method (custom load) is being 
processed on the server side.

DataSourceName

MethodClass

Method

PropertiesReceivedFromM
ethod

PropertiesInCollection

PropertiesPopulated

CookieSet A cookie was set on the server side. Cookie

Value

Expiration

SessionVariableSet A session variable was set on the server 
side.

Name

Value

LayoutVariableSet A layout variable was set on the server side. Name

Value

AlertSent An alert was sent from the server-side. Target

Component

Item Index

Alert

Variables

Event Explanation Additional Parameters

CustomMessage A message defined by the 
developer.

ClientOrServerScript

Message

CustomError A custom message meant to be 
thrown during unexpected 
conditions.

ClientOrServerScript

Message

Event Explanation Additional Parameters
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This chapter provides troubleshooting information for issues you may encounter with the 
portal(s).

Portal Installation

“Server Not Found” Error

During the portal installation, when you specify the user name and password of the 
application pool logon account, you might see this message: “Server not found. Verify that 
the specified server exists. The server name cannot be empty.”

If you see this message, start the Computer Browser service before trying again to specify 
the user name and password. This service can be started from the command line (when 
using CMD with administrator privileges) by running the following: sc start browser.

For more information about this message, search the Microsoft Knowledge Base for article 
875362.

Can’t Complete Installation

If the portal installation fails, it may be because your Internet Information Services (IIS) 
options for enabling 32-bit applications are set to True. For portal installations, these 
options must be set to False. For more information, see the note at the beginning of 
“Installing the Portal(s) and Portal Manager” on page 35.

Also, if the portal installation wizard fails to finish and no option is provided for opening the 
installation log file, then in order for Infor support to diagnose other problems, you will need 
to force creation of the log file. From the command line, run the following: SL 9.00 
Portal Install IPF 3.1 Build 70.exe /v"/l*v c:\test.log"

Update Conflict Error

If the portal installation fails on SharePoint 2.13, check the log file for an error message 
similar to this: "An update conflict has occurred and you must re-try this action. The object 
SPWebApplication Name=<name> is being updated by DomainName\UserName1, in the 
OWSTimer.exe process, on machine <servername>. View the tracing log for more 
information about the conflict."

If you see such a message, refer to Microsoft KB article 939308.
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Cleaning Up After Portal Installation Failure

If the SL 9.00 Portal Install IPF 3.1 Build 70.exe installation wizard fails to 
complete successfully and there is no entry for Infor Portal Foundation in the Control 
Panel, Programs and Features area, use these steps to manually uninstall any 
components that might have been installed:

1. In SharePoint Central Administration, select System Settings.

2. Select Manage servers in this farm.

3. Retract and remove each of the following solutions. Select one of the solutions, which 
takes you to the Solution Properties screen. In that screen, select Retract. After the 
retraction is complete, select the solution again. On the Solution Properties screen, 
select Remove Solution.

 ipf.centraladminconfig_v3.0.0.0.wsp

 ipf.manager_v3.0.0.0.wsp

 ipf.webparts_v3.0.0.0.wsp

4. In SharePoint Central Administration, select Application Management.

5. Select Manage web applications.

6. Delete the portal Web applications. When you delete the Web application:

 Select Yes to delete the content databases.

 Select Yes to delete the IIS Web sites.

7. Remove the following DLLs from the Global Assembly Cache (GAC). If you have 
installed multiple versions of the SyteLine Portals, be careful to remove files for only the 
portal version you are uninstalling. To access the GAC, click Start > Run and enter 
C:\windows\assembly\gac_msil.

 compiler

 FusionCharts

 IKVM.OpenJDK.Core

 IKVM.OpenJDK.Text

 IKVM.OpenJDK.Util

 IKVM.Runtime

 IPF.CentralAdminConfig

 IPF.CustomCodeLib

 IPF.InternalCustomCodeLib

 IPF.LoggingLib

 IPF.Manager

 IPF.Oracle

 IPF.SharedCode

 IPF.WebParts

 Mongoose

 Newtonsoft.Json

 zxing

NOTE: If any of the files are locked, stop SharePoint services, delete the files, and then 
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restart the services.

8. Delete the portal and links from the desktop.

9. Delete the installation files, which by default are copied to C:\Program Files\Infor.

10. Restart the SharePoint Administration and SharePoint Timer services.

11. To restart IIS, run the iisreset command.

Portal Configuration

Can’t Connect to SyteLine for Data Source Configuration

This problem may occur if you have installed SharePoint and SyteLine on the same utility 
server. By default, both applications will have a binding on port 80. To resolve this conflict, 
you must delete the default SharePoint Web application. Follow these steps:

1. Log in to the SharePoint server using the account you used for installing SharePoint. 

2. In SharePoint Central Administration, select Application Management > Manage web 
applications. 

3. In the list of Web applications, select SharePoint - 80 and then click Delete.

Access Denied During Push to STS

During portal configuration, when you push the configuration changes to the Security Token 
Server (STS), there may be an “Access Denied” message at the top of the page, if your 
browser is running on the SharePoint server. 

If you see this message, close the browser and re-open it with administrator privileges 
(Run as administrator). Perform the push to STS again.

The problem may also occur if you are not logged in to the machine as the same account 
user that SharePoint Central Administration is running under. See “Set Up User Accounts 
for SharePoint” on page 25 for log in information.

Error Processing an IDO Request

“Error processing an IDO request... (Status:TrustFailure The remote certificate is invalid 
according to the validation procedure.)”

This message is displayed during portal configuration if you attempt to connect to the 
configuration server using a URL that starts with https, but a valid digital certificate is not 
installed and bound to the portal Web application.

In a test environment, you might use an SSL certificate that is self-signed or that is signed 
using the internal or private key. You can temporarily configure the system to ignore the 
lack of a valid certificate and trust relationship for the SSL/TLS secure channel by selecting 
the Ignore Invalid Security Certificate check box during portal configuration. See 
“Configure Data Sources” on page 42.
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Pre-Login Account Errors

During configuration of the pre-login account, if you receive an error saying that the pre-
login account does not exist or can’t authenticate, even though it is configured correctly in 
SyteLine, it may be that SSL is not successfully authenticating its certificates. 

To verify this issue, open the Portal Manager and select Configuration > Data Sources. 
Select the Ignore Invalid Security Certificate option. Apply this setting, push to STS, and 
then try configuring the pre-login account again. If it now succeeds, there is a problem with 
the SSL certificates.

Portal Login

Can’t Log In Using the SharePoint Server Machine

If you are trying to log in to the portal using Windows authentication on the SharePoint 
server machine, and the Public URL for the portal is not the server machine name, you 
may encounter a problem with SharePoint that prevents you from logging in. You will need 
to specify the host names that are mapped to the loop back address and that can connect 
to Web sites on the local computer. Follow these steps:

1. Click Start > Run, type regedit, and then click OK.

2. In the Registry Editor, locate the following registry key:

    HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Lsa\MSV1_0

3. Right-click MSV1_0 and select New > Multi-String Value.

4. For the new value, type BackConnectionHostNames, and then press Enter.

5. Right-click BackConnectionHostNames and select Modify.

6. In the Value data field, specify the host name(s) used in the request URL for the sites 
that are on the local computer, and then click OK. For example, 
PortalAdmin.MyCompany.com.

7. Close the Registry Editor and then reset IIS.

Can’t Log In Using Forms Authentication

If you try to log in to the portal using Forms Authentication but receive an error that the 
v2.1.0.0 IPF Manager.dll could not be loaded, you need to remove old entries from the STS 
web.config file. Follow these steps:

1. Using Notepad, open the web.config file stored in this location: C:\Program 
Files\Common Files\Microsoft Shared\Web Server 
Extensions\14\WebServices\SecurityToken.

2. In the <configuration><connectionStrings> section, remove all of the <add> tags 
with a name attribute that begins with SyteLineMembershipProvider v2.1.0.0 (for 
example, to SyteLineMembershipProvider v2.1.0.0s1, to SyteLineMembershipProvider 
v2.1.0.0s2, and so on).
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3. In the <configuration><system.web><membership><providers> section, 
remove all of the <add> tags with a name attribute that begins with 
SyteLineMembershipProvider v2.1.0.0.

4. In the <configuration><system.web><membership><roleManager> section, 
remove all of the <add> tags with a name attribute that begins with 
SyteLineRoleProvider v2.1.0.0.

5. Save the file.

Temporary Profile Error

If account profiles were not created for the SharePoint user accounts (SPInstall, SPFarm, 
and SPServices) before portal installation, then this message may appear in portal 
diagnostics when you try to access the portal: "The profile for the user is a temporary 
profile."

To fix this issue, you must first remove the temporary profile that was created. Do this by 
deleting the TEMP directory from C:\Users. Then create the account profiles as explained 
in “Create Account Profiles” on page 27. After the profiles are created, you can log in to the 
portal without getting this error.

User Login Errors

Portal users may receive the following login error message: “Login Error. Try again”.

For some login errors, the event can be seen in portal diagnostics if diagnostics is running 
when the error occurs. If a user reports this problem, you may need to start diagnostics and 
then log in to the portal with that user’s credentials to troubleshoot the issue. These errors 
occur when:

 The user is a super user

 The user is not associated with a customer or vendor

 The user is associated with more than one customer or vendor

 The user is not associated with the Customer Portal or Vendor Portal group

For unexpected errors, an event is logged in portal diagnostics even if diagnostics is not 
running. The portal user gets the same message. These errors occur when:

 A stored procedure call fails

 A stored procedure call returns an error message

 A collection load fails

See Chapter 14, “Using Portal Diagnostics” for more information.
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Access Denied Errors for Logged In Users

If users report “Access Denied” errors on various portal pages after they have successfully 
logged in, follow these steps in the order shown:

1. Re-run the Push to STS. See “Pushing Portal Configuration Changes for a New Server 
in the Farm” on page 127.

2. Re-apply all portal group permissions. See “Set User Group Permissions in SharePoint” 
on page 48.

3. In Portal Manager, select Configuration > General and then click the Reset Pre-Login 
Permissions button.

Diagnostics Viewer Error

If you try to start the portal Diagnostics Viewer, but you receive server connection errors, it 
may be that your current Windows login ID needs administrator rights on the SharePoint 
server(s). 

Updates in SyteLine Not Displayed on the Portal

If you have made changes in SyteLine that should affect images or text displayed on the 
portal, but those changes are not showing up on the portal, you may need to clear the 
cache, as described in “Clearing the Portal Cache” on page 126.

Also, if you have more than one server in a SharePoint farm, and you have made changes 
to an IPF Display Layout or IPF Field Display Format, the cache is automatically cleared on 
only the machine to which the updated component was loaded. You will need to clear the 
cache for the other machines in the SharePoint farm.

Category Name Displayed Multiple Times on Products Page

If you see the same category name displayed more than one time on the Products page, 
you may have an issue with Language IDs in SyteLine. 

Each language record in SyteLine should have only one LocaleID. If there is more than one 
LocaleID for a language, and during portal configuration you specified that language to be 
supported on the portal(s), then category names on the Products page will be displayed for 
each LocaleID in the SyteLine record.

Top Sellers Are Not Displayed on Portals

If you have set up items to be active for the portal and also to be displayed as top sellers, 
but they do not appear as top sellers on the Home page or Top Sellers page, make sure 
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you have set all applicable currencies to be active for the portal (on the Currency Codes 
form) and that you have activated portal pricing for those currencies. See “Activating Prices 
for the Portals” on page 74.

Maintenance Icon Not Displayed for User with SharePoint Design 
Permissions

Some modal pages in the portal, or new pages added during portal customization, may not 
include the maintenance icon even if you have Design permissions. This can happen if the 
page doesn’t include the ToggleAdmin Web Part or field display format. In these cases, you 
can still access the SharePoint ribbon by adding this to your page URL: 
?IPFDisplayRibbon=1. For example: <SharePoint Server 
Name>:8084/IPFSitePages/NewPage.aspx?IPFDisplayRibbon=1. 

Verifying Log Files

You can use portal diagnostics to verify log files. See Chapter 14, “Using Portal 
Diagnostics” for more information.

Optionally, you can use the Windows event log. The portal writes application messages to 
the Windows event log. The message source is either Infor Portal Foundation v3.0.0.0 or 
IPF Portal Application v3.0.0.0, depending on the message. Event messages with a 
severity of Error or Error Critical are written to the log when one of these conditions is 
encountered:

 Coding error

 Incorrect configuration

 System down condition

Event messages with a severity of Informational are written to the log when one of these 
conditions is encountered:

 Deployment

 Clear Cache

 Update STS Web Config 

If you suspect that logging is not working correctly, verify that the logging configuration is 
set up properly by following these steps:

1. In SharePoint Central Administration, select Monitoring > Reporting > Configure 
diagnostic logging.

2. Verify that the Infor Portal Foundation and IPF Portal Application categories are not 
displayed in bold. 

3. Expand these categories and verify that the Event Level is Information and the Trace 
Level is Medium. 
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4. If the categories are in bold or the subcategories do not have the Event Level or Trace 
Level listed above, follow these steps to correct the problem:

a. Check the Infor Portal Foundation and IPF Portal Application categories:

 In Least critical event to report to the event log, select Reset to default.

 In Least critical event to report to the trace log, select Reset to default.

b. Click OK at the bottom of the page to save these changes

NOTE: If you change the Trace Level to Verbose, more information is logged in the 
SharePoint log file, which is typically located in C:\Program Files\Common 
Files\Microsoft Shared\Web Server Extensions\14. This verbose information is 
for Infor debugging use only and is not meant to be understood by customers.
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This appendix describes how the parts of the portal interact with SyteLine. It is divided into 
these sections:

 System architecture

 Login process and security

 Internationalization

 Displaying pages of information

 Using pictures

System Architecture

The portal architecture is a combination of SharePoint and SyteLine elements.

On the SharePoint side:

 The SyteLine portal user interface is in SharePoint. The user interface uses ASPX 
pages, Web Part, and ASP.NET controls. 

 SharePoint internal and third-party Web Parts are used to present lists, and to get 
current signed in user, authentication methods, and so on.
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 The interface also takes advantage of SharePoint portal libraries to connect SyteLine to 
the SharePoint ASP .NET pages, and to implement single sign on, access to SyteLine 
data through IDOs, and to ensure that inserts, updates, and deletes are restricted to the 
correct customer.

On the SyteLine side:

 Account-specific data, also known as IDO filtering, restricts the data that is retrieved 
from collections by the customer.

 The SyteLine architecture used by the portal includes the IDO server and the SQL 
database.

SharePoint Login Process and Security

Your external customers sign in to the portal using a SyteLine user ID and password. The 
portal services use claims-based authentication for user logins. The portal site uses a 
custom implementation of forms-based authentication built on SyteLine user names.

This approach uses the SharePoint Forms Based Authentication method. The 
SyteLineMembershipProvider that is delivered and installed with the portal validates the 
portal login against the user ID and password in the SyteLine application. 

The portal administration site can use either Windows or Forms-based authentication; 
however, we recommend that you use Windows authentication to access this site.

How the Login Works

During the installation process, the external/Internet SharePoint Web application is 
configured to use /_layouts/IPF.Manager_v3.0.0.0/IPFLogin.aspx as the login 
page. This page uses the pre-login account, created in SyteLine and specified during portal 
configuration, to log in to SyteLine. When the user arrives at this page, they are 
automatically authenticated into the SharePoint Web application using this pre-login 
account and then redirected to a custom login page with a user interface appropriate for the 
portal. The custom login page must be named /IPFSitePages/Login.aspx and needs 
to use the <Authenticate/> tag on a button to complete the login process. (Refer to the 
IPFButton formatter in the Infor Portals Customization Guide for a description of how to 
create a login button.)

When a user clicks the Login button on the /IPFSitePages/Login.aspx page, 
authentication processing is executed using the information configured by the button. If 
authentication is successful, the currently signed in user is changed from the pre-login 
account to the newly authenticated account.

The pre-login account should be limited by having permissions to only those pages that can 
be accessed prior to login. The Web Parts on these pages, however, run with elevated 
permissions and have full access to any resource on the portal.

Page sets that should be accessible to the pre-login account are defined using the Page 
Sets feature in Portal Manager. Refer to the Infor Portals Customization Guide for more 
information.
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If a user is not signed in to the portal but tries to access a portal page directly, for example, 
from a bookmark or a link received by e-mail, the following occurs:

A. A redirect is done by SharePoint to the login page 
http://portal.com/_layouts/IPF.Manager_v3.0.0.0/IPFLogin.aspx.

B. The IPFLogin.aspx page performs an “auto login” using the pre-login account and 
then redirects to the custom login page 
http://portal.com/IPFSitePages/Login.aspx.

C. The Login.aspx page processes the custom login and then redirects on to the 
originally requested URL

D. In the Click() handler, when using the field display format for IPFButton with the 
<Authenticate/> tag, the custom code can override that last redirection, if desired, by 
using the NavigateTo() and NavigateToSitePage() methods.

Login processing is performed using the SyteLineMembershipProvider delivered with the 
portal installation. The Microsoft SecurityTokenService (STS) validates:

 The user ID and password against the default SyteLine data source using the delivered 
SyteLineMembershipProvider.

 SyteLine licensing against the default data source.

 The UserAuthenticated event handler. If the custom UserAuthenticated event handler 
returns false, the login fails.

Alternative login methods

When there is a custom MembershipProvider configured on the Web application, STS 
validates the user ID and password as specified in the custom MembershipProvider.

When a user that has authenticated with either the custom MembershipProvider or with 
Windows authentication attempts to access a portal page, the following validation is 
required before accessing the page:

 The user ID and password as specified in the custom MembershipProvider.

 There exists a user in SyteLine with a Domain/WorkstationID for this user ID.

 SyteLine licensing.

 The UserAuthenticated event handler. If the custom UserAuthenticated event handler 
returns false, the login fails.

NOTE: Infor does not supply or provide coding support for custom MembershipProviders.

When NOT using the provided IPFLogin.aspx page followed by an <Authenticate/> tag 
on the custom log in page, the following occurs:

A. Windows Authentication:

 Windows/STS performs the User ID and password validation

 At the first attempt to access a page that contains an Infor Portal Foundation Web 
Part, the following additional steps are performed:

 Validates SyteLine licensing against the default data source.

 Calls the UserAuthenticated event handler. If the custom UserAuthenticated 
event handler returns false, access to the Web Part is denied.
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B. Forms Authentication:

 STS does validation using the specified MembershipProvider. This will be the 
SyteLineMembershipProvider if the delivered MembershipProvider is used.

 At the first attempt to access a page that contains an Infor Portal Foundation Web 
Part, the following additional steps are performed:

 Validates SyteLine licensing against the default data source.

 Calls the UserAuthenticated event handler. If the custom UserAuthenticated 
event handler returns false, access to the Web Part is denied.

Filtering Data by Login

The SyteLine data that the portal user can see is limited to information for the SyteLine 
customer to which the portal user is linked. This is handled by:

 Linking the user to a customer on the Customer Users form in SyteLine.

 Predefined filters that are set on the Row Authorizations form in SyteLine. These filters 
limit the data that a customer user can view. See the help topic “Using IDO Filters to Limit 
User Access” if you want to better understand how this works.

WARNING!  By default, the Active check box is selected for all Infor-provided filters that 
are defined on the Row Authorizations form. If you turn off the Active check box for a 
filter, then any user who was previously restricted by the filter is no longer restricted. For 
example, if you turn off the Infor-provided filters that are set on the Interactions IDO, then 
any portal user can see ALL interactions in the system, not just the ones related to that 
customer or vendor. 

Internationalization

This section covers translations and the formatting of currency, dates, and numbers for 
different languages, locales, or regions.

Supported Languages and Regions

When you configure the portal site, you choose from a list of locales (cultures with regions), 
that the SyteLine installation supports. A culture with region is a culture that specifies both 
a language and a region; for example, en-US is English for the United States. A culture 
without region specifies only a language; for example, fr is French. In order to use a culture 
to control the formatting of numbers, currency, and dates, it must include a region, as in our 
en-US example. For translations of labels, a culture can omit the region, as in our fr 
example.

The Web Part lists cultures with regions that SyteLine can support. The portal administrator 
selects all the cultures with regions that your portal site will support. The portal 
administrator also chooses one of the culture/regions as the default for the site. If no 
configuration is performed, the site defaults to the en-US culture/region. The configuration 
of the portal languages is described in “Set General Configuration Options” on page 45.
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Using Browser Language Preferences

When a portal user first visits the site, the portal looks at the language preferences 
contained in the user’s Web browser. The portal selects the best match against the list of 
culture/regions that the portal site is configured to support.

If no exact match is found, look for the first match on the language (that is, the first two 
characters of the culture name). For example, if the browser has en-NZ as its only entry, 
and the portal supports en-US, then select en-US as the culture/region for the portal.

If no language match is found, then select the default locale (culture/region) that was 
specified by the portal administrator during portal configuration.

The portal uses this culture/region name for text translations and for the formatting of 
numbers, dates, and currency.

Overriding Browser Preferences

On the portal login page, the user can select a different culture/region from a drop-down 
list. The list includes all cultures with regions that you configure the portal site to support.

If a portal user makes a selection from this menu, a cookie is created to remember this 
selection. The value in this cookie overrides the browser selections.

The portal uses this culture/region name for text translations and for the formatting of 
numbers, dates, and currency.

Currency Symbol

As described above, the selected culture controls the formatting of numbers, dates, and 
currency. The culture also controls the currency symbol. However, the currency values 
returned from SyteLine are in the currency that is defined for the customer record.

To resolve this, after the culture has been set based on the rules defined above, the 
currency symbol is overridden to be the symbol for the currency defined on the SyteLine 
customer record. (This must be an ISO currency.)
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BCustomer Portal Page Architecture and 
Mapping to SyteLine

This appendix describes how Customer Portal pages are mapped to SyteLine forms to 
display SyteLine data online.

Account Balance Page

This page contains information similar to that on the SyteLine A/R Posted Transactions 
Summary form. The account balance information for your customer includes balances for 
the customer’s subordinate customers, if any. 

The page includes these calculated fields:

 Current Balance is the customer’s On-order Balance plus Posted Balance.

 Available Credit is the customer’s Credit Limit minus the Current Balance.

The “aging bucket” text labels that display over the first five fields on the portal Account 
Balance page are set from the values entered on the SyteLine Accounts Receivable 
Parameters form. These text values are not tied to a specific language and must be 
language-independent, as described in “Setting Up Language-Independent Aging Bucket 
Labels” on page 63.

The portal page displays all A/R transactions (such as invoices and payments) for this 
customer where the Active field is selected on the A/R Posted Transactions Detail form.

NOTE: In multi-site implementations, if the Customer Portal site group contains different 
sites than the Accounts Receivable site group, data on the Account Balance page will 
not equal that shown in SyteLine and may not represent accurate customer aging 
information. For more information, refer to the Multi-Site Planning Guide.

Account Management Page

My Company Information

The fields in the Company Information section are mapped to fields on the SyteLine 
Customers and Customer Ship-Tos forms.
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Billing Information

This information is taken from the Customers form.

Shipping Information

This information is taken from the Customers and Customer Ship-Tos forms.

Payment Information

This information is taken from the Customers form.

User Profile Information

The portal user can edit information in this section, other than the user ID, and the changes 
take effect immediately. Fields are mapped as follows:

 The User ID, Name, and E-mail Address fields on this page are mapped to fields on 
the SyteLine Users form. 

 If the portal user selects Confirmations, the Send External Notifications field on the 
SyteLine Users form is selected for this user. The system will send event notifications 
to the specified e-mail address as well as to the portal Inbox page.

 If a portal user chooses to receive e-mails for any other option listed, SyteLine adds that 
user to the SyteLine Publication Subscribers form with the appropriate publications.

 If the portal user is added as a subscriber to the SpecialPromotionsAnnoucements 
publication, then when a SyteLine user uses the Communication Wizard form to send 
a communication with the Portal Users field selected, this user will receive the 
communication as an e-mail.

 If the portal user is added as a subscriber to the OrderShippingAlert publication, a stored 
procedure in SyteLine periodically checks for orders that have shipped. (You can set this 
test interval as described in “Configuring Order Shipping Alerts” on page 67.) If an order 
has shipped for a customer whose portal user has subscribed to the OrderShippingAlert 
publication, then another stored procedure triggers the Alert on Order Shipping workflow 
event handler, which sends an e-mail to the portal user. 

Change Password

The Password field is mapped to the Password field on the SyteLine Users form.

Announcements Page

Announcements are added in SharePoint. See “Add Announcements” on page 122.
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Consigned Inventory Page

If no search parameter is selected, the Consigned Inventory page displays all of the 
logged-in customer’s consigned items. The details grid on the Consigned Inventory page 
contains data from the following SyteLine forms:

 Item: The customer item number from the SyteLine Customer Contracts form, or the 
SyteLine item number from the Items form for the signed in customer.

 Description: The item description from the SyteLine Items form.

 Facility: The customer ship-to name from the SyteLine Warehouses form.

 Min Qty: The lower boundary set for managing inventory quantities at a consignment 
warehouse for a specific item, from the SyteLine Item/Warehouse form.

 Max Qty: The upper boundary set for managing inventory quantities at a consignment 
warehouse for a specific item, from the Item/Warehouse form.

 On Hand Qty: Inventory on hand at a consignment warehouse for a specific item, from 
the Item/Warehouse form.

 Pending Qty: Quantity required minus quantity received for consignment transfer order 
lines for this consignment warehouse and item combination, from the Inventory 
Consigned To Customer form.

Contact Us Page

The Contact Information section on this page (name, address, phone, and e-mail) is 
mapped to information on the SyteLine General Parameters form. 

In the Salesperson Contacts section, the customer Ship To addresses (city, state, country) 
and salesperson contact information (contact name, phone, e-mail) are mapped to fields on 
the SyteLine Customer Ship-Tos form.

Signed in portal users see information in both of these sections. Users who have not 
signed in see information in only the Contact Information section.

If an e-mail address is provided on the General Parameters form, all users can click Send 
Questions or Comments on this page, which opens a default e-mail client so they can 
send their messages.

Contract Order Page

If no search parameter is selected, this page displays all contracted items for the signed in 
customer. Information on this page is taken from the SyteLine Items, Multi-Lingual Items, 
Customer Contracts and Customer Contract Prices forms. 
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Documents Page

If no search parameter is selected, the Documents page displays all customer documents 
uploaded by a SyteLine customer service representative that are accessible to the logged-
in portal user, and all documents uploaded by the portal user and approved in SyteLine by 
a customer service representative.

The details grid on the Documents page contains information from the SyteLine 
Documents form for documents added in SyteLine, and from the Document Upload form 
for documents added via the portal.

NOTE: To view documents related to other types of SyteLine records, portal users must 
click the Documents icon displayed with an individual record on the related portal 
pages.

Estimates Page

The summary information on this page (estimate, quote date, status, total price, and 
Expiration Date) is mapped to fields on the SyteLine Estimates form.

The detail information for each estimate is mapped to fields on the SyteLine Estimate 
Lines form.

Featured Products Page

This page displays any products that have been set up on the SyteLine Items form as 
featured items and active for Customer Portal.

Home Page and Menus

The logo, text and pictures on the Home page are configurable and should be changed to 
personalize your portal. See Chapter 9, “Personalizing the Portal(s)”. 

The language box displays only those languages that you enabled in the Supported 
Locales area during portal configuration. See “Set General Configuration Options” on page 
45.

There are no fields mapped to SyteLine forms. There are a few menu text strings that are 
stored in SyteLine, and there is one text object and several images that are stored in 
SharePoint. You can hide links to menu options for which you are not providing pages. 
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Inbox Page

The Inbox page contains messages generated by the SyteLine event system, as described 
in “Setting Up Customer Event Notifications” on page 64. Portal users can view these 
messages using the Inbox page, similar to the way SyteLine users can view their event-
driven messages using the SyteLine Inbox form. 

Interactions Page

If no search parameter is selected, the Interactions page displays all interaction records for 
the customer. The records may have been created by a customer service representative 
using SyteLine or by the customer using the portal. 

The details grid on the Interactions page contains information from the SyteLine Customer 
Interactions form for records added in SyteLine, and from the Interactions page for 
interactions added via the portal. In multi-site implementations, the Interaction ID in the grid 
includes a site code to identify which site the interaction relates to.

Inventory Page

This page displays items from the SyteLine Items form that are active for the portal and 
that have an associated customer contract.

Invoices Page

If no search parameters are specified, the page displays all invoices for the customer. 
Invoices are sorted by the due date, in descending order (latest first). The fields on the 
Invoices page are mapped to fields from SyteLine reports.

A portal user can select one or more invoices by selecting the check box. After selecting 
invoices, the portal user may be able to click Request to request a reprint of the selected 
invoices to be e-mailed. See “Allowing Customer Portal Users to Reprint Invoices” on page 
63.

Each selected invoice is sent as a separate request. The task to be initiated is based on the 
bill type of the invoice and is handled by the ReprintInvoiceSp stored procedure:

Bill Type Code Background Task used

Invoices, credit memos, and 
progressive billing invoices

N, P, or R OrderInvoicingCreditMemoReportLaser

Project invoices J ReprintProjectInvoicesReportLaser

Invoices or credit memos posted 
from Accounts Receivable

A ARInvoiceCreditDebitMemoLaser
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Knowledge Items

Press Releases, Videos, White Papers, Knowledge Base, and FAQ

The maintenance of these pages, which are accessed by selecting Activity > Knowledge 
Items, is handled entirely through the SharePoint portal administration site. See the 
appropriate section in Chapter 10, “Administration Tasks”.

Login Page

The User ID and Password must belong to a user who is set up in SyteLine according to 
the instructions in Chapter 7, “Setting Up and Managing SyteLine User Accounts for the 
Portal(s)”.

If the user clicks on the Forgot User ID or Password link, a pop-up message tells them to 
contact your company for assistance. It provides a link to the Contact Us page.

Order Status Page

Most fields on the Order Status page are mapped to fields on the SyteLine Customer 
Orders and Customer Order Lines forms.

The order status shown on the portal is either Ordered or Shipped. There is no equivalent 
“Shipped” status in SyteLine; the “Shipped” status is displayed on the portal when the 
SyteLine order status is “Complete” or when all order lines for the order have a status of 
“Filled.” Orders with a status of “History,” “Stopped,” or “Planned” are not shown on the 
portal.

Tracking information that can be accessed on this page is taken from the SyteLine 
Shipment Master form.

Portal users can enter either your company’s item number or their customer item number, if 
applicable, in the Item search box on the portal Order Status page. The drop-down list for 
the Item displays the item number and the item description. If an description is available in 
the chosen portal language, the description from the SyteLine Multi-Lingual Item form is 
displayed in the drop-down list. Otherwise the description text is displayed in the default 
language of the site to which the portal is connected.

RMA credit memos M RMACreditMemoLaser

Consolidated invoices C ConsolidatedInvoicingLaser

Bill Type Code Background Task used
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Place Order Page

Quick Order 

The Item field in this section displays items in the Primary Site that are defined using the 
SyteLine Items form. Only items that have a price are displayed in the Quick Order Item 
field.

Order 

When items are initially added to an order, an order estimate is created in SyteLine. When 
a shipping address is entered on this page, the estimate is converted to an order with a 
status of Planned in SyteLine.

The order section of the page displays the items that have been placed on the estimate or 
order by the customer. The item picture, number, and name are taken from the SyteLine 
Items form. The item price is taken from the Portal Pricing Review form. Quantity ordered 
is displayed in the customers unit of measure, which is taken from the Customer 
Contracts form. 

If the Credit Card Interface (CCI) is installed and active, the tax amount is displayed. It is a 
calculated value, from the Estimates or Customer Orders form. 

Sign In/Register 

For returning customers, the login user ID and password are validated against the users 
information on the SyteLine Users form.

For new customers, their registration information is added to the SyteLine Users, 
Customers, and Customer Users forms.

Shipping Information 

This information is taken from the Customer Ship-Tos form.

Order Information

Order Contact and Phone are taken from the Customers form.

Ship Method information can come from different sources. When orders are paid on 
account, the ship methods are taken from the SyteLine Ship Via Codes form, if on that 
form they have been activated for use on the portal. The ship code can be tied to a carrier 
coming from the Carriers form. 

When orders are paid by credit card, the ship methods are taken from the ship method 
group assigned to the customer on the Customers form. If no group was assigned, then 
the default ship method group from the Portal Parameters form is used. The following 
forms are all involved when a ship method is created in SyteLine for credit card orders: 
Ship Method Groups, Ship Methods, Multi-Lingual Ship Methods, Freight Charge 
Methods, Customer, Items, and Portal Parameters.
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Finalize Order 

When a customer opens the Place Orders page, validation of the SyteLineinstallation is 
made to see if SyteLine Credit Card Interface (CCI) is being used to allow for credit card 
ordering. If so, for B2C users and for B2B users who pay by credit card, the Credit Card 
Information section is enabled and CCI parameters are taken from the SyteLine Credit 
Card Interface Parameters form. 

For customers who have credit card information already saved in SyteLine, that information 
is taken from the Customer Credit Cards form and displayed on the portal. For customers 
who enter their credit card information on the portal, that information is added to the 
Customer Credit Cards form, and the Portal User field displays the name of the portal 
user who entered the data. 

If CCI is not being used, then Credit Card Information is not enabled.

Billing Address comes from the Customers and Customer Ship-Tos forms.

Order Total comes from the Orders form.

The e-mail address that a copy of the order is sent to comes from the Primary E-mail 
Address on the Users form.

Product Details Page

The portal Product Details page displays the item number, description, and pictures from 
the SyteLine Items form. The customer’s item number is shown, if available. If there is no 
customer item associated with this customer and item, then your standard item number is 
displayed. Also, if a multi-lingual item overview does not exist in the SyteLine Multi-
Lingual Item form for the selected item, then the standard item overview from the Items 
form is returned instead. 

Pricing information comes from the SyteLine Customer Contract Prices form and is 
displayed only if Portal Pricing Enabled and Pricing Site are set on the Items form.

Products Page

The initial Products page displays all items that are marked as active for the portal on the 
SyteLine Items form. Users can filter by category or item. 

The page also displays the item number, description, and pictures from the SyteLine Items 
form. Pricing information comes from the SyteLine Customer Contract Prices form and is 
displayed only if Portal Pricing Enabled and Pricing Site are set on the Items form.

The category hierarchy shown on the left side of the page is taken from the Item Category 
Workbench form. Category names and pictures are from the Item Categories form.
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Returns Page

The fields on the Returns page map to fields on the SyteLine RMAs and RMA Lines forms. 
Only RMAs with a status of Opened or Requested are displayed on the portal page.

A request to submit a new RMA request takes these steps:

1. The submitted RMA request causes a stored procedure to run. The stored procedure 
uses the information it was given by the portal (customer number, username, item, 
customer item, quantity, customer order number, line number, release number, invoice 
number, and reason) to create an RMA and RMA line in SyteLine with a Requested 
status.

2. The submitted request triggers the workflow event handler Notify Portal RMA Request 
Created, which sends a message to the SyteLine user specified in the Notify Users field 
of the workflow event handler.

3. The SyteLine user must go to the RMAs form to approve or reject the RMA, by changing 
the status to Opened or Stopped.

4. The change to the status triggers one of these workflow event handlers:

 Notify Portal RMA Approved, which sends a notice to the portal user that the request 
was approved, or 

 Notify Portal RMA Rejected, which sends a notice to the portal user that the request 
was rejected.

If the portal user selects an existing RMA with a status of Requested and clicks Cancel 
Request, the RMA in SyteLine has its status set to Stopped.

If an item in an RMA does not have a multi-lingual item description set up, then the 
description from the RMA Lines form is displayed instead. The RMA Lines description is 
likely to be in the default language of the site to which the Customer Portal is connected.

Service Incidents Page

Information displayed on the Service Incidents page comes from the Incidents form.

Service Knowledge Base Page

Information displayed on the Service Knowledge Base page comes from the Knowledge 
Base form.

Top Sellers Page

This page displays any items that have been set up on the SyteLine Items form as top 
sellers and active for Customer Portal.
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Unit Registration Page

On the Unit Registration page, Unit, Item, and Description are taken from the Units form. 
Prov/State codes are taken from the Prov/State form, and Country codes are taken from 
the Countries form.
Infor SyteLine Portals Setup and Administration Guide 
Copyright © 2014 Infor 



CReseller Portal Page Architecture and 
Mapping to SyteLine

This appendix describes how Reseller-only portal pages are mapped to SyteLine forms to 
display SyteLine data online.

Commissions Due Page

The information displayed on this page is taken from the SyteLine Commissions Due 
form. In the Status field on this page, Unpaid maps to the SyteLine Pay status, Hold maps 
to the SyteLine Hold status, and Paid maps to the SyteLine Complete status.

Customers Page

If no search parameter is selected, this page displays all customers associated with the 
logged in reseller. This association is taken from the SyteLine Customer Ship-Tos form, 
Salesperson field. Customer information is taken from the SyteLine Customers form.

Service Order Transactions Page

Information displayed on the Service Order Transactions page comes from the Service 
Order Transactions form.

Service Orders Page

Information displayed on the Service Orders page comes from the Service Orders form.
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Mapping to SyteLine

This appendix describes how Vendor Portal pages are mapped to SyteLine forms to 
display SyteLine data online.

Announcements Page

Announcements are added in SharePoint. See “Add Announcements” on page 122.

Consigned Inventory Page

If no search parameter is selected, the Consigned Inventory page displays all consigned 
items from the logged-in vendor. The details grid on the Consigned Inventory page contains 
data from the following SyteLine forms:

 Item: The vendor item number from the SyteLine Vendor Contracts form, or the 
SyteLine item number from the Items form for the signed in vendor.

 Description: The item description from the SyteLine Items form.

 Min Qty: The lower boundary set for managing inventory quantities at a consignment 
warehouse for a specific item, from the SyteLine Item/Warehouse form.

 Max Qty: The upper boundary set for managing inventory quantities at a consignment 
warehouse for a specific item, from the SyteLine Item/Warehouse form.

 On Hand Qty: Inventory on hand at a consignment warehouse for a specific item, from 
the SyteLine Item/Warehouse form.

Values for calculating past consumption are also taken from the SyteLine Item/Warehouse 
form and based on the start and end dates specified by the user.

Contact Us Page

The Contact Information section on this page (name, address, phone, and e-mail) is 
mapped to information on the SyteLine General Parameters form. 

When the portal user submits text in the Questions or Comments box, a stored procedure 
reads the text in the box and passes it as a parameter in a “Send e-mail” event message 
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that is sent to the e-mail address defined on the General Parameters form. This process 
uses the “Send Portal Question/Comment E-mail” workflow event handler. If no e-mail 
address is entered on the General Parameters form, then the Questions or Comments 
box on the portal page is not displayed, because there is no way to send a message.

Documents Page

If no search parameter is selected, the Documents page displays all vendor documents 
uploaded by a SyteLine vendor service representative that are accessible to the logged-in 
portal user, and all documents uploaded by the portal user and approved in SyteLine by a 
vendor service representative.

The details grid on the Documents page contains information from the SyteLine 
Documents form for documents added in SyteLine, and from the Document Upload form 
for documents added via the portal.

Home Page and Menus

The logo, text and pictures on the Home page are configurable and should be changed to 
personalize your portal. See Chapter 9, “Personalizing the Portal(s)”. 

The language box displays only those languages that you enabled in the Locale Settings 
area during portal configuration. See “Set General Configuration Options” on page 45.

There are no fields mapped to SyteLine forms. There are a few menu text strings that are 
stored in SyteLine, and there is one text object and several images that are stored in 
SharePoint. You can hide links to menu options for which you are not providing pages. 

Inbox Page

The Inbox page contains messages generated by the SyteLine event system, as described 
in “Setting Up Vendor Event Notifications” on page 93. Portal users can view these 
messages using the Inbox page, similar to the way SyteLine users can view their event-
driven messages using the SyteLine Inbox form. 

Interactions Page

If no search parameter is selected, the Interactions page displays all interaction records for 
the vendor. The records may have been created by a vendor service representative using 
SyteLine or by the vendor using the portal. 

The details grid on the Interactions page contains information from the SyteLine Vendor 
Interactions form for records added in SyteLine, and from the Interactions page for 
interactions added via the portal.
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Inventory Level Projection Page

This page displays data from the SyteLine Inventory Levels form for the logged-in 
vendor’s contracted items. It also uses Plan Horizon (days) from the SyteLine Planning 
Parameters form for the default start and end dates.

This form uses an item category filter, which displays data only if an item, category, and 
vendor association is made using the SyteLine Item Categories form.

Item Price Requests Page

This page displays item price requests data from the SyteLine Item Price Requests form 
for the logged-in vendor.

Only items that have a category assigned and are associated with the logged-in vendor are 
displayed.

Knowledge Items

Press Releases, Videos, White Papers, Knowledge Base, and FAQ

The maintenance of these pages, which are accessed by selecting Activity > Knowledge 
Items, is handled entirely through the SharePoint portal administration site. See the 
appropriate section in Chapter 10, “Administration Tasks”.

Login Page

The Company Name and Logo are configurable. See Chapter 9, “Personalizing the 
Portal(s)”.

The language box displays only those languages that you enabled in the Locale Settings 
area during portal configuration. See “Set General Configuration Options” on page 45.

The User and Password must belong to a user who is set up in SyteLine according to the 
instructions in Chapter 7, “Setting Up and Managing SyteLine User Accounts for the 
Portal(s)”.

If the user clicks on the Forgot User or Password link, a pop-up message tells them to 
contact your company for assistance. It provides a link to the Contact Us page.

My Company Profile Page

The fields on the My Company Profile page are mapped to fields on the SyteLine Vendors 
form.
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My Profile Page

The portal user can edit information on this page, other than the user ID, and the changes 
take effect immediately. Fields are mapped as follows:

 The User ID, Name, and E-mail Address fields on this page are mapped to fields on 
the SyteLine Users form. 

 The Password field (displayed with the Change Password link) is mapped to the 
Password field on the SyteLine Users form.

 If a portal user selects Confirmations on the My Profile page, the Send External 
Notifications field on the SyteLine Users form is selected for this user. The system will 
send event notifications to the specified e-mail address as well as to the portal Inbox 
page.

 If a portal user chooses to receive e-mails for any other option listed on the My Profile 
page, SyteLine adds that user to the SyteLine Publication Subscribers form with the 
appropriate publications.

On Time Delivery Page

The fields on the On Time Delivery page are mapped to fields on the SyteLine Vendors or 
Multi-Site Vendors forms. 

When the page is first opened, the Start Date is set to three months prior to the current 
month/year and the End Date is set to the end of the current month/year. If these fields are 
left blank on the Vendor Portal, then data from the month/year of the first PO Line due date 
available in SyteLine, excluding history purchase orders, is shown for the logged-in vendor. 
History purchase orders are not considered for on-time delivery percentages.

If the number of order lines received in full by the due date in SyteLine does not match 
what the logged-in vendor expects to see on the portal, the discrepancy may be due to one 
of these events:

 The vendor shipment may not have made it to you by the PO line due date, even though 
it was shipped on time.

 You did not receive the material into the SyteLine system the day it was received at the 
dock.

 You received the material into the SyteLine system with a date prior to or later than the 
actual receipt date. This can occur by overwriting the Transaction Date on the Purchase 
Order Receiving form.

 Although the vendor shipped the line in full and you received it in full by the PO line due 
date, there may have been subsequent quantity returns to the line that were not re-
shipped by the vendor (and re-received into SyteLine) before the PO line due date.
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Planned Orders Page

The data fields on the Planned Orders page are mapped to fields on the SyteLine 
Planning Detail form. 

If dock-to-stock days exist for an item on the Planning Detail form, then the planned due 
date displayed on the portal will be different from the due date on the Planning Detail form, 
because the due date on the portal is reduced by dock-to-stock days before it is displayed 
to portal users. The portal planned order firming process does not reduce the date any 
further. 

The Confirm check box for firming planned orders is available for use by vendors if the 
Allow to Firm PLNs option is selected on the SyteLine Vendor Contracts, Vendors, or 
Multi-Site Vendors forms. For information about setting up this option in SyteLine, see 
“Setting Up Planned Orders” on page 89.

Product Price Contracts

This page displays summary data from the SyteLine Vendor Contracts form and detail 
data from the SyteLine Vendor Contract Prices form.

Purchase Orders Page

This page displays data from the SyteLine Purchase Orders and Purchase Order Lines 
forms. The picture displayed with each item is taken from the SyteLine Items form.
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EUninstalling the Portal(s)

This section describes how to uninstall the portal(s) and remove the portal Web 
applications from SharePoint. You can install all portals at once or selected portals. 

Uninstalling All Portal Programs

To uninstall all portals, Portal Manager, and Portal Diagnostics, use the Windows Uninstall 
a program tool and uninstall Infor Portal Foundation. This retracts and removes the portal 
solutions, removes the files that were copied to the server, and removes the Portal 
Manager shortcut link created on the desktop. List content, such as Help or 
Announcements, is not removed unless you remove the Web applications in SharePoint.

Removing Web Applications

Use SharePoint Central Administration to remove the portal Web application(s). When you 
delete a Web application:

 Select Yes to delete the content databases. 

 Select Yes to delete the IIS Web sites.

This deletes all portal content, including announcements that were added after installation.

Manually delete the portal shortcuts from the desktop.

NOTE: If you uninstall the portals and then plan to re-install immediately, you may need to 
restart your SharePoint services first.

Clearing GAC DLL Files

If you are uninstalling all portals and want to completely clean your machine, as a best 
practice you should also clear out any remaining GAC .dll files for the portal version you are 
uninstalling. See “Cleaning Up After Portal Installation Failure” on page 180 for a list of files 
that may need to be removed. Also see “Can’t Log In Using Forms Authentication” on page 
182 for information about removing entries from the STS web.config file.
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Uninstalling Selected Portals

If you have installed one or more portals and you want to choose which ones to remove, 
follow these steps:

1. Double-click the SL 9.00 Portal Install IPF 3.1 Build 70.exe file.

2. On the Welcome screen, click Next.

3. Do one of the following:

 If you have installed only one portal, and you want to remove just that solution:

a.On the Program Maintenance screen, make sure Add or Remove Features is 
selected and then click Next.

b.On the Select Features screen, clear Portal Architecture and then click Next.

c.Complete the wizard steps.

 If you have installed two or more portals, and you want to remove one or more of 
them:

a.On the Program Maintenance screen, make sure Add or Remove Features is 
selected and then click Next.

b.On the Select Features screen make sure Portal Architecture and Portal 
Content are selected and then click Next.

c.On the Web Applications screen, make sure Use existing Web Application is 
selected and then click Next. 

d.On the Select Web Applications screen, in the box on the right select the Web 
applications to remove, move them to the box on the left, and then click Next.

e.Complete the wizard steps.

4. Remove the Web applications for the uninstalled portal(s) as described in “Removing 
Web Applications” on page 211.
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aging buckets, Customer Portal 63, 193
Allow to Firm PLNs option 89
alternate views of items, adding for Customer Portal 54
announcements

adding 122
Syteline setup 126

Announcements page
adding announcements 122
using in Customer Portal 143
using in Vendor Portal 161

application pool user name 26, 38, 40
APS, requirements 19
architecture of the system 187
available credit

relationship to SyteLine, Customer Portal 193

B
B2B and B2C

definition 131
page options 132
setting up ship methods 72

bill type of invoice 197
browsers

language preferences 191
overriding default language 191
supported 21

C
cache, clearing 126
calling in Customer Portal orders 73

Can Create Users option 100
categories

displaying in Customer Portal 55
SyteLine setup, Customer Portal 53
troubleshooting 184

Category Banner field 55
category browsing, enabling for Customer Portal 56
Category Picture field 55
certificates, see also digital certificates 39
Charge Per Item option 72
Claims Based Authentication 36
colors, changing 115
Commission field 80
Commissions Due page

relationship to SyteLine, Reseller Portal 203
using in Reseller Portal 154

Common Name in IIS 27
company logo, changing 112
configuration accounts, SyteLine setup 28
configuration name, in data source configuration 43
configuration server URL, in data source configuration

42
Consigned Inventory page

relationship to SyteLine, Customer Portal 195
relationship to SyteLine, Vendor Portal 205
SyteLine setup, Customer Portal 57
SyteLine setup, Vendor Portal 86
using in Customer Portal 145
using in Vendor Portal 158

Contact Us page
relationship to SyteLine, Customer Portal 195
relationship to SyteLine, Vendor Portal 205
SyteLine setup, Customer Portal 61
SyteLine setup, Vendor Portal 91
using in Customer Portal 148
using in Vendor Portal 163

contacting Infor 14
Contract Order page

relationship to SyteLine, Customer Portal 195
using in Customer Portal 140

contract pricing, displaying in Customer Portal 61
country codes, adding for Customer Portal 77
Credit Card Interface (CCI) 77, 200
Credit Card Interface (CCI), requirements 19
credit card processing, setting up for Customer Portal 77
cultures, supported 190
currencies, activating for Customer Portal 76
currency

selection of 191
SyteLine setup, Customer Portal 64

Current Balance, Customer Portal 193
customer item number 198
Customer Portal site group 52
Customer Portal, accessing 133
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customer ship-to address
SyteLine setup, Customer Portal 61

customer’s company
SyteLine setup, Customer Portal 60

Customers page
relationship to SyteLine, Reseller Portal 203
using in Reseller Portal 153

customer-specific item numbers and pricing
SyteLine setup, Customer Portal 61

D
data source

default 43
for authentication 44
for translation 43

data sources requirements
Oracle 20
SQL Server 20

data sources, in portal configuration 42
default pricing site 74
Default Ship Method Group field 73
default style family, in portal configuration 46
deleting records in Portal Manager 45
Design permissions in SharePoint 109
diagnostic logging

configuring 165
filtering messages 168
message descriptions 169
saving log files 178
stopping 166
updating the configuration 166
viewing messages 166
when to enable 165

Diagnostics Viewer error 184
digital certificates 20

binding to Web applications 39
importing in IIS 27

Display Current Search option 55
documents

about, Customer Portal 142
about, Vendor Portal 160

Documents page
relationship to SyteLine, Customer Portal 196
relationship to SyteLine, Vendor Portal 206
SyteLine setup, Customer Portal 57
SyteLine setup, Vendor Portal 87
using in Customer Portal 142
using in Vendor Portal 160

E
e-mail address

SyteLine setup, Customer Portal 61
SyteLine setup, Vendor Portal 91

Enable 32-Bit Applications, IIS Manager 35, 179
Enable Category Browsing option 56, 73
enable portal for development

about 46
steps 110

error messages, pricing 75
Error Processing an IDO Request, in portal configuration

181
Estimates page

relationship to SyteLine, Customer Portal 196
using in Customer Portal 141

event activity, monitoring 165
event global constants

Customer Portal 67
Vendor Portal 96

event handlers
Customer Portal 64
Reseller Portal 83
Vendor Portal 93

event setup
Customer Portal 66
Reseller Portal 83
Vendor Portal 95

F
FAQs, adding 123
farm account privileges, setting up 27
Featured Item option 54
Featured Products page

relationship to SyteLine, Customer Portal 196
SyteLine setup, Customer Portal 54
using in Customer Portal 138

file cleanup after installation failure 180
filtering data by login 190
Forms Based Authentication 36, 40, 188
Frequently Asked Questions page

adding FAQs 123
using in Customer Portal 146
using in Vendor Portal 162

G
global constants

Customer Portal 67
Vendor Portal 96

H
help link, adding or hiding 116
help topics

adding 116
changing 116
for different languages 116
hiding 116

Home page
changing 111
relationship to SyteLine, Customer Portal 196
relationship to SyteLine, Vendor Portal 206
using in Customer Portal 134
using in Vendor Portal 156

HTTPS 20
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I
IDO filters 188, 190

Customer Portal 100
IDO Web service, requirements 19
ignore invalid security certificate, in data source

configuration 43
IIS Manager, Enable 32-Bit Applications 35, 179
IIS, importing digital certificates 27
image standards, Customer Portal 53
Inbox page

relationship to SyteLine, Customer Portal 197
relationship to SyteLine, Vendor Portal 206
using in Customer Portal 148
using in Vendor Portal 162

Incidents page
relationship to SyteLine, Reseller Portal 203

Include Tax In Price field 75
installation checklist 24
installation failure

cleanup of files 180
create log file 179

installing Portal Manager, steps 35
installing the portal

about the wizard 35
checklist 24
guidelines 30
steps 36

interaction topics
SyteLine setup, Customer Portal 60

interactions
about, Customer Portal 143
about, Vendor Portal 161

Interactions page
relationship to SyteLine, Customer Portal 197
relationship to SyteLine, Vendor Portal 206
using in Customer Portal 143
using in Vendor Portal 161

interactions topic
SyteLine setup, Vendor Portal 90

internal host header, in portal installation 38
internal IIS Web site port, in portal installation 38
international shipments, setting up codes in Customer

Portal 72
international shipments, setting up ship methods in

Customer Portal 72
internationalization 190
Inventory Level Projection page

relationship to SyteLine, Vendor Portal 207
using in Vendor Portal 158

Inventory page
relationship to SyteLine, Customer Portal 197
using in Customer Portal 145

invoice
bill type 197
reprint 63

Invoices page
relationship to SyteLine, Customer Portal 197

using in Customer Portal 144
Is Category Heading option 55
ISO currency

architecture 191
SyteLine setup, Customer Portal 64

ISO unit of measure
SyteLine setup, Customer Portal 64
SyteLine setup, Vendor Portal 92

Issue To name in IIS 27
item category tree (hierarchy)

SyteLine setup, Customer Portal 55
Item Picture field 54
item pictures

SyteLine setup, Customer Portal 54
Item Price Requests page

relationship to SyteLine, Vendor Portal 207
using in Vendor Portal 160

items
finding in Customer Portal 136
SyteLine setup, Customer Portal 53

K
Knowledge Base page

updating 123
using in Customer Portal 146
using in Vendor Portal 162

L
languages, supported 190
language-specific item descriptions and overview

Customer Portal 56
libraries for videos or white papers 124
license

assigning to Customer Portal users 99
requirements 19

links on Home page
enabling 114
hiding 116

Local SharePoint Portal data source, in data source
configuration 45

locale settings
for online help 119

locale settings, in portal configuration 46
log file, installation failure 179
login error, users 183
login failure 182
Login page

relationship to SyteLine, Customer Portal 198
relationship to SyteLine, Vendor Portal 207

login process, architecture 188
Login/Register page

relationship to SyteLine, Customer Portal 198
logins, existing in SharePoint 23

M
maintenance icon

displaying 110
troubleshooting 185
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menus
hiding options 116
using in Customer Portal 134
using in Vendor Portal 156

modifying the portal
enable for development 110

multi-site
about 16
and the User Account Management Utility 98
Customer Portal set up requirements 51
online ordering set up requirements 69
Reseller Portal set up requirements 79
Vendor Portal set up requirements 85

My Company Information
Customer Portal 193

My Company Profile page
relationship to SyteLine, Vendor Portal 207
using in Vendor Portal 164

My Profile page
relationship to SyteLine, Vendor Portal 208
using in Vendor Portal 163

O
On Time Delivery page

relationship to SyteLine 208
relationship to SyteLine, Vendor Portal 208
using in Vendor Portal 158

opening the portal 133
Oracle data source requirements 20
order shipping alerts

SyteLine setup, Customer Portal 67
Order Status page

relationship to SyteLine, Customer Portal 198
using in Customer Portal 141

order status, Customer Portal 198
Outside option 80

P
Paid By Credit Card option 77
paired MSSQL data source, in data source configuration

43
password, in data source configuration 43
permissions for portal site, setting 48, 109
personalizing the portal

enable for development 110
phone number for placing orders 73
picture standards, Customer Portal 53
pictures

changing on the Home page 112
Place Order page

relationship to SyteLine, Customer Portal 199
using in Customer Portal 140

planned orders
projected inventory levels 158

Planned Orders page
relationship to SyteLine, Vendor Portal 209
using in Vendor Portal 157

port number on public URL, in portal installation 38
portal

configuring 127, 190
installing 35
uninstalling 211

portal administrator user account
SyteLine setup 29

portal colors, changing 115
portal configuration

data sources 42
general settings 45

portal configuration errors 181
portal content

backing up 106
exporting 106
importing 107
transferring 107

Portal Manager
connecting to a site 40
installing 35

Portal Order option 77
portal parameters

setting up for Customer Portal 73
setting up for Vendor Portal 86

Portal Pricing Enabled option 74, 75
portal pricing site 61
Portal Pricing Site field 74, 76
Portal Reseller option 80
portal site group

creating for Customer Portal 52
creating for Vendor Portal 86

portal user accounts, required SyteLine records 98
portal users

SharePoint permissions 48, 109
SyteLine setup, Customer Portal 62
SyteLine setup, Vendor Portal 92

PortalSiteGroup data source, in data source
configuration 44

pre-login functionlity, about 70
pre-login Home page, using in Customer Portal 133
pre-login user account

error during portal configuration 182
how it is used 188
in portal configuration 45
limited permissions 188
SyteLine setup 28

Press Releases page
using in Customer Portal 145
using in Vendor Portal 161

press releases, adding 125
prices

about 70
activating for Customer Portal 74

pricing sites, setting up for Customer Portal 74
pricing, contract 91
Primary E-mail Address field
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Customer Portal 100
PrimarySite data source, in data source configuration 44
privacy policy, enabling link 114
Product Code field 80
Product Details page

relationship to SyteLine, Customer Portal 200
Product Price Contracts page

relationship to SyteLine, Vendor Portal 209
using in Vendor Portal 159

Products page
relationship to SyteLine, Customer Portal 200
using in Customer Portal 137

promotions
setting up 126

public URL
described 23
determining 30
in portal installation 38
troubleshooting 182

publications
Customer Portal 65
Reseller Portal 83
Vendor Portal 93

Purchase Orders page
relationship to SyteLine, Vendor Portal 209
using in Vendor Portal 157

purchase terms and conditions, enabling link 114
Push Config to STS

error 181
in data source configuration 44, 128
manually 127

R
Read permissions in SharePoint 48
reason codes, adding for Customer Portal 56
Recommended Items

SyteLine setup, Customer Portal 56
Ref Num field 80
regions, supported 190
Register form, in Customer Portal 134
registration, about 71
removing the Web applications 211
reprint invoices

SyteLine setup, Customer Portal 63
ReprintInvoiceSp 197
required SyteLine records for portal user accounts 98
Reseller Portal, about 151
Reseller’s Salesperson field 80
resellers

SyteLine setup, Reseller Portal 80
Reset Pre-Login Permissions button 46
Returns page

relationship to SyteLine, Customer Portal 201
using in Customer Portal 142

RMA
viewing or requesting in Customer Portal 142

row-level authorizations

Customer Portal 100

S
saving changes to portals 120
Secure Sockets Layer (SSL)

about 20
import digital certificates for 27
in portal installation 38

Send External Notifications field
Customer Portal 100, 194
Vendor Portal 208

Sequence field 54
Server Not Found Error 179
Service Incidents page

relationship to SyteLine, Customer Portal 201
using in Customer Portal 147

Service Knowledge Base page
relationship to SyteLine, Customer Portal 201
using in Customer Portal 147

Service license, requirements 19
Service Order Transactions page

relationship to SyteLine, Reseller Portal 203
using in Reseller Portal 153

Service Orders page
relationship to SyteLine, Reseller Portal 203
using in Reseller Portal 152

service portal parameters
SyteLine setup, Reseller Portal 83

SharePoint
adding a server 127
requirements 19
user accounts 25

SharePoint account profiles, creating 27
SharePoint lists, backing up 122
SharePoint permissions

Design 109
Read 48

SharePoint Standalone installation 27, 36, 38, 40, 127
Ship Hold option 76
shipping charges, setting up for Customer Portal 72
Shop menu

using in Customer Portal 134
shortcuts, added during installation 39
site group

creating for Customer Portal 52
creating for Vendor Portal 86

Site Group field 73
site name, in portal installation 38
SL_Internal

SyteLine setup 28
using in data source configuration 43

slide-out browser menu, Customer Portal 56
SMTP settings 63
SpecialPromotionsAnnouncements publication 194
SPFarm user account 26
SPInstall user account 26, 36
SPServices user account 26, 38, 40
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SQL Server data source requirements 20
SSL 20
standalone installation 25
Super User option 28
SyteLine

initial setup for Customer Portal 51
initial setup for online ordering in Customer Portal 69
initial setup for Reseller Portal 79
initial setup for Vendor Portal 85
requirements 19

SyteLine data sources, adding 42
SyteLineMembershipProvider 36
SyteLinePortals license, requirements 19
SyteLinePortals_MS license, requirements 19
SyteLineRoleProvider 36

T
tax codes, defining in SyteLine 76
tax codes, setting up for Customer Portal 76
terms of use, enabling link 114
text strings, translation 196, 206
text, changing on the Home page 113
Top Seller option 54
top sellers

troubleshooting 184
Top Sellers page

relationship to SyteLine, Customer Portal 201
SyteLine setup, Customer Portal 54
using in Customer Portal 138

trace log activity, monitoring 165
translation 122, 190

U
uninstalling the portal 211
unit of measure

SyteLine setup, Customer Portal 64
SyteLine setup, Vendor Portal 92

Unit Registration page
relationship to SyteLine, Customer Portal 202
using in Customer Portal 146

units
registering in Customer Portal 146

updates failure 184
Upload Site field

Customer Portal 59
Vendor Portal 89

Use Preprinted Forms option 63
User Account Management Utility 97, 102

user accounts
alternate ways to create for Customer Portal 99
for SharePoint Farm, setting up in Active Directory 25
for SharePoint Standalone 25

user accounts in SyteLine
configuration accounts 28
create with utility 102
for testing the portals 29
portal administrator 29
portal user accounts 97

user authenticated event handler, in portal configuration
46

user ID, in data source configuration 43
User Profile Information

relationship to SyteLine, Customer Portal 194
user rights, administrator 20

V
v2.1.0.0 IPF Manager.dll login error 182
Validate Portal Address 73
Validate Portal Address option 77
Vendor Portal site group 86
vendor, SyteLine setup 91
Video Library page

adding to 124
using in Customer Portal 145
using in Vendor Portal 161

viewable page set, in portal configuration 45
Visitor portal users 131
visitors, accessing the portal 133

W
Web applications

creating 36
removing 211

White Papers page
adding to 124
using in Customer Portal 146
using in Vendor Portal 162

Windows Authentication 188
Windows event log 185
workflow event handlers

Customer Portal 64
Notify Portal RMA Approved 201
Notify Portal RMA Rejected 201
Notify Portal RMA Request Created 201
Reseller Portal 83
Vendor Portal 93
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